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How to read this manual
Symbols��

The following symbols are used in this manual.

	B840dn ••  B840
	B820n ••  B820
	Multipurpose tray ••  MPT, MP tray
	Second tray unit ••  tray 2
	Third tray unit ••  tray 3
	PostScript3 Emulation ••  PSE, POSTSCRIPT3 EMULATION, POSTSCRIPT3 
EMULATION
Microsoft•• ® Windows® 8.1 64 - bit Edition operating system  Windows 8.1 
(64bit version)*
Microsoft•• ® Windows® 8 64 - bit Edition operating system  Windows 8 
(64bit version)*
Microsoft•• ® Windows® Server 2012 64 - bit Edition operating system  
Windows Server 2012 (64bit version)*
Microsoft•• ® Windows® Server 2012 R2 64 - bit Edition operating system  
Windows Server 2012 R2 (64bit version)*
	•• Microsoft® Windows® 7 64 - bit Edition operating system  Windows 7 (64bit 
version)*
	Microsoft•• ® Windows Vista™64 - bit Edition operating system  Windows 
Vista (64bit version)*
	Microsoft•• ® Windows Server® 2008 R2 64 - bit Edition operating system  
Windows Server 2008 R2*
	Microsoft•• ® Windows Server® 2008 64 - bit Edition operating system  
Windows Server 2008 (64bit version)*
	Microsoft•• ® Windows® XP x64 Edition operating system  Windows XP (x64 
version)*
	Microsoft•• ® Windows Server™ 2003 x64 Edition operating system   
Windows Server 2003 (x64 version) *
	Microsoft•• ® Windows® 7 operating system  Windows 7*
	Microsoft•• ® Windows Vista™ operating system  Windows Vista*
	Microsoft•• ® Windows Server® 2008 operating system  Windows Server 
2008*
	•• Microsoft® Windows® XP operating system  Windows XP*
	Microsoft•• ® Windows Server™ 2003 operating system  Windows Server 
2003*
	Windows•• ®, general name for Windows 8.1, Windows Server 2012 R2,  
Windows 8, Windows Server 2012, Windows 7, Windows Vista, Windows Server 
2008 R2, Windows Server 2008, Windows XP, Windows Server 2003   
Windows

* �If there is no special description, 64bit version is included in Windows 7,  
Windows Vista, Windows Server 2008, Windows XP, and Windows Server 2003.

This product complies with the requirements of the Council 
Directives 2004/108/EC (EMC), 2006/95/EC (LVD) and 
2009/125/EC(EuP), as amended where applicable, on the 
approximation of the laws of the
member states relating to Electromagnetic Compatibility, Low 
Voltage and Energy Using Products.

The following cables were used to evaluate this product to achieve EMC direc-
tive 2004/108/EC compliance and configurations other than this may affect 
that compliance.

CABLE TYPE LENGTH (METRE) CORE SHIELD

Power 1.8

USB 5

Parallel 1.8

LAN 15

As an ENERGY STAR Program Participant, the manufacturer has 
determined that this product meets the ENERGY STAR guidelines 
for energy efficiency.

Symbol��

Note! •	 printer work properly. 
It is strongly recommended that you read these in order to avoid operating 
the machine incorrectly.

Memo •	 Items that are useful to know or which are reference items for 
when using the printer. 
Recommended to read. 

The descriptions in this manual, unless particularly specified, refer to the op-
eration procedures of B840dn . The screen or operating procedure may differ 
depending on the model.
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Caution

This equipment uses CR2032 lithium batteries on the main control board. 
The machine has a life of 10 years with normal use.
Please seal the batteries with a tape or similar material upon disposal. 
Mixing with other metals or batteries may result in fires or explosions. 
Please dispose of batteries in accordance with rules and regulations of 
the local government.
Please do not dispose of them in a landfill site amongst already processed 
garbage. 

Regarding the software on the printer��

Regarding trademarks ��

OKI is a registered trademark of Oki Electric Industry Co., Ltd. 
Microsoft, Windows, Windows Server and Windows Vista are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and in 
other countries.
Apple, Macintosh, MacOS, AppleTalk, EtherTalk, LaserWriter, Bonjour and 
TrueType are either registered trademarks or trademarks of Apple Inc. USA, 
in the USA and in other countries.
Adobe, PostScript and Reader are either registered trademarks or trademarks 
of Adobe Systems Incorporated in the USA and in other countries.
Other product names and brand names are registered trademarks or 
trademarks of their proprietors.

About this manual��

The reprinting of part or all of this manual without permission is strictly 111
prohibited.  
The contents of this manual are subject to change in the future without 222
prior notice.
This manual has been created with due care, however, in the unlikely event 333
that you notice something that is unclear, incorrect, or omitted, please con-
tact the store at which you purchased the product. 
Please understand that notwithstanding point 3, Oki Data accepts no re-444
sponsibility for the contents of this manual in terms of the effect on the 
operation of the machine. 

Regarding the copyright of this manual��

All copyrights are reserved by Oki Data Corporation.  This manual cannot be 
reproduced, transmitted, or translated without permission.  You must obtain 
permission from Oki Data Corporation before doing so. 

© 2011 Oki Data Corporation

This product has RSA Security Inc.'s RSA® BSAFE™ 
software installed on it. 

B820n/B840dn has passed the IPv6 Ready Logo Phase 1 
test.
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MANUFACTURER
Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,
Japan

ENVIRONMENTAL INFORMATION

EMERGENCY FIRST AID
Take care with toner powder

If swallowed, give small amounts of cold water and seek medical attention. 
DO NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical at-
tention.

If it gets into the eyes, flush with large amounts of water for at least 15 
minutes keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of 
staining skin or clothing.
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Chapter 1  �Printing with various kinds of paper

Note! •	 In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X.

•	 The screen or procedure may vary depending on the application you use.

•	 Please refer to Online Help for detailed explanations of each setting item for printer drivers and utilities.

•	 The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.
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Chapter 1  Printing with various kinds of paper

1

Print on envelope

Print on envelope
Publication of Functions��

Print on envelopes from the multipurpose tray (MP Tray).

Note! •	 The printing speed will be slow.

•	� If printing and treating the multipurpose tray as a manual feed, 
and if the time until setting the paper exceeds the manual time 
out in the system configuration menu (the default value is set at 
1 minute), the print data will be automatically destroyed.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

1	 Set the paper.

Set the paper in the multipurpose tray and align it with the left ①①
and right manual guides.

manual guides

Mark

Press the set button.②②

set button
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1

Print on envelope

Paper set direction

Com-9, Com-10, 
DL, C4, C5, C6,

 Monarch

2	 Open the face up stacker.

The paper will be output on the face up stacker, stacked in the 
reverse order in which it was printed.

Note! •	 Do not open the face up stacker during printing. This may re-
sult in a paper jam.

Open the rear printer side of the face up cover.①①

face up cover

Open the face up stacker.②②

face up stacker

Open the paper supporter.③③

paper supporter

3 Set the paper size and paper thickness.

Here the procedure for setting COM-9 envelope is explained.

Press the ①①  or the  button several times. The [MEDIA 

MENU] will be displayed, and press the  ENTER button.

Press the ②②  or the  button several times. [MPT PAPER-

SIZE/A3] will be displayed. Press the  ENTER button. 



12

Chapter 1  Printing with various kinds of paper

1

Print on envelope

Press the ③③  or the  button, and [COM-9 ENVELOPE] 

will be displayed.

Press the ④④  ENTER button, and a [*] will appear on the 

right side of the set value. 

Press the ⑤⑤  Back button, then press the  or the  

button several times. [MPT MEDIAWEIGHT/M LIGHT] will be 

displayed. Press the  ENTER button. 

Press the ⑥⑥  or the  button, and [HEAVY] will be dis-

played.

Press the ⑦⑦  ENTER button, and a [*] will appear on the 

right side of the set value. 

Press the ⑧⑧  Online button, and [ONLINE] will be displayed.

4 	 Open the file you want to print.

5 	 Select paper [Size] and [Source],then print.

Those using a Windows PS printer driver

Select [Page Setup] from the [File] menu.①①

Select [A4] in [Size], and [Portrait] or [Landscape] in ②②
[Orientation], and click [OK].

Select [Print] from the [File] menu.③③

Click on [Preferences].④④

Select [Automatically Select] in [Paper Source] in the [Paper/ ⑤⑤
Quality] tab, and click [OK]. 

Click [Print] in order to print.⑥⑥
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1

Print on envelope

Those using a Windows PCL printer driver
Select [Page Setup] from the [File] menu. ①①

Select [Com-9] in [Size], and [Portrait] or [Landscape] in ②②
[Orientation], and click [OK].

Select [Print] from the [File] menu.③③

Click on [Preferences].④④

Select [Multi Purpose Tray] from [Source] in the [Setup] tab.⑤⑤

Click [OK].⑥⑥

Click [Print] in order to print.⑦⑦

For those using a Mac OS X

Select [Page Settings] from the [File] menu. ①①

Select the printer model name in [Format For], [Envelope #9] ②②
in [Paper Size], and the appropriate orientation in [Orientation], 
and click [OK].
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Chapter 1  Printing with various kinds of paper

1

Print on envelope

Select [Print] from the [File] menu. ③③

If you are using a PS printer driver, select [Multi-Purpose Tray] ④④
on the [Paper Feed] panel. 

If you are using a PCL printer driver, select [Multipurpose Tray] ⑤⑤
on the [Setup] panel, select [Heavy] in [Media Weight] on the 
[Setup] panel.

 Memo •	If you are using a PCL printer driver, and if you are printing 
with a portrait orientation (a long - type one with the flap 
towards the top) on an envelope, it will be printed 180˚ the 
other way.

	 •	If you are using a PCL printer driver, and if you are printing in 
a landscape orientation (a long - type one with the flap on the 
right side) on an envelope, select landscape (central icon) in 
[Orientation] on the Page Setup screen.

 	  •	�If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	  •	If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

Click [Print] in order to print.⑥⑥
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1

Print on labels and Transparency

Print on labels and Transparency
Publication of Functions��

Print labels and Transparency from the multipurpose tray (MP 
Tray).

Note! •	 The printing speed will be slow.

•	� If printing and treating the multipurpose tray as a manual feed, 
and if the time until setting the paper exceeds the [MANUAL TIM-
EOUT Out] in the [SYS CONFIG MENU] (the default value is set at 
1 minute), the print data will be automatically destroyed.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer 
driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

�� Method of operation 

1 	 Set the paper.

Set the paper in the multipurpose tray and align it with the left ①①
and right manual guides.

manual guides

Mark

②②Press the set button.

set button

    
Orientation of Setting Paper

ABC

2 	 Open the face up stacker.

The paper will be output on the face up stacker, stacked in the 
reverse order in which it was printed.

Open the rear printer side of the face up cover.①①

face up cover
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Chapter 1  Printing with various kinds of paper

1

Print on labels and Transparency

Open the face up stacker.②②

face up stacker

Pull out the paper supporter.③③

paper supporter

Note! •	 Do not open the face up stacker during printing. This may re-
sult in a paper jam.

3	 Set the paper size and paper thickness.

Here the procedure for setting labels is explained.

Press the ①①  button several times. The [MEDIA MENU] will 

be displayed,and press the  ENTER button.

Press the ②②  or the  button several times. [MPT MEDIA-

TYPE/PLAIN] will be displayed. Press the  ENTER button. 

Press the ③③  or the  button, and [LABELS] will be dis-

played.

Press the ④④  ENTER button, and a [*] will appear on the right 

side of the set value. 

Press the ⑤⑤  Back button, then press the  or the  

button several times. [MPT MEDIAWEIGHT/M LIGHT] will be dis-

played. Press the  ENTER button. 

Press the ⑥⑥  or the  button, and [HEAVY] will be dis-

played.

Press the ⑦⑦  ENTER button, and a [*] will appear on the right 

side of the set value. 

Press the ⑧⑧  Online button, and [ONLINE] will be displayed.

4 	 Open the file you want to print.

5 	 Select [Paper Size] and [Paper Feed Method] and print.
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1

Print on labels and Transparency

Those using a Windows PS printer driver

Select [Page Setup] from the [File] menu.①①

Select [A4] or [Envelope] in [Size], and [Portrait] or [Landscape] ②②
in [Orientation], and click [OK].

Select [Print] on the [File] menu.③③

Click on [Preferences].④④

Select [Multi-Purpose Tray] in [Paper Source] in the [Paper/ ⑤⑤
Quality] tab, and click [OK].

Click [Print] in order to print.⑥⑥

Those using a Windows PCL printer driver

Select [Page Setup] from the [File] menu.①①

Select [A4] or [Envelope] in [Size], and [Portrait] or [Land-②②
scape] in [Orientation], and click [OK].

Select [Print] from the [File] menu.③③

Click on [Preferences].④④
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Chapter 1  Printing with various kinds of paper

1

Print on labels and Transparency

Select [Multi Purpose Tray] from [Source] in the [Setup] tab.⑤⑤

Click [OK].⑥⑥

Click [OK] or [Print] on the Print screen, in order to print. ⑦⑦

For those using a Mac OS X

Select [Page Settings] from the [File] menu. ①①

Select the printer model name in [Format For]; [A4] or [Envelope] ②②
in [Paper Size], and the appropriate orientation in [Orientation], 
and click [OK].

Select [Print] from the [File] menu. ③③

Select [Multi-Purpose Tray] on the [Paper Feed] panel.④④

If you are using a PS driver, select [Medium-Heavy] in [Media ⑤⑤
Type] within [Insert Option] function settings on the [Printer 
Features] panel.

	 	If you are using a PCL printer driver, select [Multipurpose Tray] 
on the [Setup] panel, select [Heavy] in [Media Weight] on the 
[Setup] panel.
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1

 Memo •	�If setting details are not displayed in the print dialog box for Mac OS 
X 10.7 to 10.9, click [Show Details] at the bottom of the dialog box.

	  • If the print option is not displayed in the print dialog box for Mac 
OS X 10.6.8, click the disclosure triangle next to the [Printer] 
drop-down list.

Click [Print] in order to print.⑥⑥

Print on labels and Transparency
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Chapter 1  Printing with various kinds of paper

1

Print on any kind of sized paper you w
ant (custom

 page)

Print on any kind of sized paper you want (custom page)
Publication of Functions��

You can independently set paper size and use it in the same way as normal paper size.

Note! •	 You must set the paper size to portrait.
•	� If large sized paper does not print correctly with a PS printer driver, you 

may be able to print correctly by selecting Normal in [Print Quality].

Sizes that can be set Trays 1 - 3 * Multipurpose tray  
(MP Tray)

   Width 148 - 297 mm 76 - 297 mm
   Length (Height) 182 - 432 mm 148 - 432 mm

* Tray 3 is only B840dn

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

�� Method of operation 

Those using a Windows PS printer driver

For Windows 8/8.1/Server 2012/2012 R2, ①① select [Control 
Panel] - [Devices and Printers].

For Windows 7/Windows Server 2008 R2, select [Start] -  
[Devices and Printers].

For Windows Vista/Windows Server 2008, select [Start] - 
[Control Panel], and then click on [Printers].

For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

	 	For Windows Server 2003, select [Start] - [Printers & Faxes].

Right - click on the [OKI B840(PS)] icon, and select [Printing Prefer-②②
ences].
Click [Advanced] in the [Layout] tab.③③

Select [PostScript Custom Page Size Definition] in [Paper Size].④④

Enter [Width] and [Height].⑤⑤

Click on [OK].⑥⑥
Note! • You cannot set the [Offsets Relative to Paper Feed Direction].

Those using a Windows PCL printer driver

For Windows 8/8.1/Server 2012/2012 R2, select [Control ①①
Panel] - [Devices and Printers].

For Windows 7/Windows Server 2008 R2, select [Start] - 
[Devices and Printers].

	 	For Windows Vista/Windows Server 2008, select [Start] - 
[Control Panel], and then click on [Printers].

	 	For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

	 	For Windows Server 2003, select [Start] - [Printers & Faxes].



21

1

Print on any kind of sized paper you w
ant (custom

 page)

Right - click on the [OKI B840(PCL)], (for B820n this is [OKI ②②
B820]), and select [Printing Preferences].
Click [Paper Feed Options] in the [Setup] tab.③③

Click [Custom Size].④④

Select [Paper Type] and enter [Name], [Width], and [Length].⑤⑤

Click [Add].⑥⑥

Click on [OK].⑦⑦
 Memo •	�The created paper will be displayed at the bottom of the [Size] 

list in the [Setup] tab. You can define up to a total of 32.

Select the custom page added in [Size], and click [OK].⑧⑧

For those using a Mac OS X printer driver

Open the file you want to print.①①

Select [Page setup] from the [File] menu.②②

Click [Paper Size] - [Manage Custom Sizes]. (For Mac OS X ③③
10.3, click on [Custom Paper Sizes] in [Settings].)
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Chapter 1  Printing with various kinds of paper

1

Click [+] on the [Custom Paper Sizes] screen, and enter the ④④
[Name], [Width] and [Height] of the custom paper. 

Click [OK]. ⑤⑤
The created paper will be displayed at the bottom of the [Paper 
Size] list on the [Page Attributes] panel.

Note! • In Mac OS X, you can enter paper sizes outside of the range, 
however, these will not be printed correctly, so please enter 
values within the range.

Print on any kind of sized paper you w
ant (custom

 page)



Note! •	 In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X. 

•	 The screen or procedure may vary depending on the application you use.

•	 Please refer to Online Help for detailed explanations of each setting item for utilities and printer drivers. 

•	 The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.
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Chapter 2  Convenient Printing Functions

Basic printing method
Those using Windows��

Configure various settings on the printer driver and print.
There are two ways to configure the settings, depending on the 
item to be configured.
Here, an explanation will be given with WordPad as an example.

If configuring settings for a function at the time you are printing••

Open the file you want to print.①①
Select [Print] from the [File] menu.②②

Select the printer and click [Preferences].③③

Configure the function you want to use and print. ④④
Setup Instructions - Chapter 2 Basic Operation��

�•• If printing with settings for often - used functions configured in 
advance

Select [Start] - [Devices and Printers].①①

Select the printer icon, right click on it and select the printer ②②
driver in [Printing preferences].

	 If there is only one printer driver installed, select [Printing 
preferences].

2

B
asic printing m

ethod
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	 If there are two printer drivers installed, select [Printer Proper-
ties].

Configure the function you want to use and click [OK].③③
Setup Instructions - Chapter 2 Basic Operation��

Open the file you want to print, and print it.④④

For those using a Mac OS X��

Configure various settings on the printer driver and print.
TextEditor is used here as an example.

If setting the paper size, etc.••

Open the file you want to print.①①
Select [Page Setup] from the [File] menu.②②

Select the printer from [Format For].③③

Configure the paper size and other items and click [OK].④④

2

B
asic printing m

ethod
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If configuring various function settings••

Open the file you want to print.①①

Select [Print] from the [File] menu.②②

Select the panel, and configure the settings for the function ③③
you want to use. 

Setup Instructions - Chapter 2 Basic Operation��

Start a print job.④④

2

B
asic printing m

ethod
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2

Print m
ultiple pages on a single sheet

Print multiple pages on a single sheet

1

1 2

3 4
2
3
4

�� Explanation of Functions

Shrink data from multiple pages onto a single sheet of paper and print.

Note! •	 This function shrinks data and prints it, so the printing may not 
be correctly centered or the print may be thin.

•	� If you change the binding margin value, the other side margin 
will increase due to the shrinkage of the overall page with the 
combined width of the binding margins.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using a Windows PS printer driver 

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences]. ③③

Select [Pages per Sheet] on the [Layout] tab. ④④
 
If necessary, set [Draw Borders]. Also, you can change the 
page layout in [Advanced] - [Pages Per Sheet Layout].

Note! • [Draw Borders] and [Pages Per Sheet Layout] cannot be used 
in Windows XP/Windows Server 2003.

Those using a Windows PCL printer driver

①① Open the file you want to print.

Select [Print] from the [File] menu.②②
Click on [Preferences].③③
Select [n-up] (n is the number of pages to print on one sheet) ④④
in the [Setup] tab.
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2

Print m
ultiple pages on a single sheet

Click on [Options].⑤⑤

⑥⑥ If required, set [Page Borders], [Page layout], and [Bind Margin].

 Memo •	�You can set the binding margin on the top, bottom, left and 
right to be 0 - 30 mm.

For those using a Mac OS X

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Select [Pages per Sheet], [Layout Direction] and [Border] in ③③
the [Layout] panel.

 Memo •	If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	 •	�If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.
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2

Automatically print on both sides

1 12

2

Explanation of Functions��

You can automatically print on both sides of the paper. 

Note! •	 You may be not able to use this, depending on the application you are using.

The paper sizes you can use for double - sided printing are A3, A4, 
A5, B4, Letter, Legal14, Legal13.5, Legal13, 8K,16K, B5, Executive 
and custom size (width 148 - 297mm, length 182 - 420mm).
The thickness of the paper that can be used for automatic double 
- sided printing is a basic weight of 60 - 105g/m2 (ream weight 
of 52 - 90kg) Other thicknesses of paper cannot be used as they 
may result in a paper jam.

 Memo • Paper sizes other than the above can be manually double - 
side printed.

• �Manually do double sided printing (Manual Double - Sided Printing) (P 57)

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using a Windows PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preference].③③

④④ Select [Flip on Long Edge] or [Flip on Short Edge] in [Print on 
Both Sides] on the [Layout] tab.

Those using a Windows PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③

A
utom

atically print on both sides
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2

A
utom

atically print on both sides

④④ Select [Long Edge (Auto)] or [Short Edge (Auto)] in [2-Sided 
Printing] in the [Setup] tab.

For those using a Mac OS X PS printer driver

①① Open the file you want to print.

Select [Print] from the [File] menu.②②
Select [Long-Edge binding] or [Short-Edge binding] from [Two-③③
Sided] on the [Layout] panel. 

 Memo •	If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	 •	 If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

For those using a Mac OS X PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Select [Long-Edge Binding] or [Short-Edge Binding] in [Duplex] ③③
on the [Setup] panel.

 Memo •	If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	 •	�If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.
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2

C
hange the paper size

Change the paper size
Explanation of Functions��

You can print on different sized paper without changing the print data.

Note! •	 This operation may not work correctly, depending on the application. 

•	� The [Expand/Shrink] tab in [Job Options] in Properties in  
Windows shrink the data, and so they do not change the paper 
size.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using a Windows PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②

Click on [Preferences].③③
Select the paper size to edit from [Size] in the [Setup] tab.④④
Click on [Paper Feed Options].⑤⑤

Put a check in [Resize document to fit printer page], select the ⑥⑥
size of paper you want to print on in [Conversion] and click 
[OK].
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2

S
ave toner and print

Save toner and print
Explanation of Functions��

Print in order to reduce the amount of toner used.

Note! •	 If you configure toner - saving, the print quality cannot be guar-
anteed.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using Windows

Open the file you want to print.①①
Select [Print] from the [File menu].②②
Click on [Preferences].③③

Put a check in [Toner Saving] in the [Job Options] tab.④④

 (The Windows PCL printer driver screen) 

For those using a Mac OS X PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
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Put a check in [Toner Saving] in the [Job Option] function set ③③
on the [Printer Features] panel.

 Memo •	If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	  •	If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

For those using a Mac OS X PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Put a check in ③③ [Toner save] on the [Job Options] panel. 

Memo •	 If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	 •	 If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

S
ave toner and print
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2

Print a w
aterm

ark (stam
p print) 

Print a watermark (stamp print) 

Sample

Explanation of Functions��

You can print an overlay with words such as "Sample" or "Internal and 
Confidential", independently of the contents printed from applications.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using Windows

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③

④④ Click on [Watermark] in the [Job Options] tab.

 (The Windows PCL printer driver screen) 

Click [New].⑤⑤
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Enter [Text] on the Edit Watermark screen, and select [Font] ⑥⑥
and [Size].

Click on [OK].⑦⑦
Check that the watermark to be printed is selected and click ⑧⑧
[OK].

Print a w
aterm

ark (stam
p print) 
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2

M
ake a pam

phlet (B
ook - B

inding Print) 

Make a pamphlet (Book - Binding Print) 

8

10

5

3

12

7

9

11

1
6

4

2

Back

Back

folded into a two-fold

12Back

1
3

5

7
9

11

Specify the book - binding print
Start printing

12

4

1
2

3

Print the document Results of printing

Explanation of Functions��

You can make small books, such as pamphlets.

Method of operation ��

Those using a Windows PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③
Select [Page Format] on the [Layout] tab. (In Windows XP/④④
Windows Server 2003, select [Booklet] in [Pages Per Sheet] in 
the [Layout] tab.) 

If necessary, set [Draw Borders].⑤⑤
Note! •	 [Draw Borders] cannot be used in Windows XP/Windows 

Server 2003.

Click [Advanced] and select the size of paper you are actually ⑥⑥
using in [Paper Size]. 

Memo •	 (E.g.) If using A4 size paper to make an A5 size small book. 
Select [A4] in [Paper Size] within [Advanced].

•	� If making a small book that folds on the right (a book with bind-
ing on the right side when the first page is facing up) , select [On 
Right Edge] in [Booklet Binding Edge] within [Advanced].

Note! •	 This operation may not work correctly, depending on the application. 

•	� If the application itself creates PostScript data, the small - book bind-
ing settings may not work correctly. Methods to avoid this rely on the 
application. Check the manual for the application you are using. For 
example, by checking [Print As Image] in the detailed settings with 
the printing dialog in Adobe Acrobat or Adobe Reader, small books 
will print normally.

•	� [Draw Borders] cannot be used in Windows XP or Windows Server 
2003.

•	� If you cannot print a [Booklet], right click on the [OKI B840 (PS)] 
icon in the [Printers and Faxes] or [Printers] folder and put a 
check in [Enable Detailed Print Functions] in the [Properties] - 
[Advanced] tab. 

•	 Watermarks cannot be correctly printed on [Booklet].

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use
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Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer 
driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

C
ollate Print

Collate Print
Explanation of Functions��

You can print in units of multiple page data sections.

Note! •	 Turn the application's print in parts function off.

1
2

3

1
2

3

1
2

3

×2 copies

When the collated printing is specified

1
2

3

3

2
3

1
1

2

×2 copies

When the collated printing is not specified

Method of operation ��

Those using Windows 

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Click on [Preferences].③③
Enter the number of sections to print with in [Copies] in the [Job  ④④
Options] tab and put a check in [Collate].
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2

For those using a Mac OS X PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Select [Paper Handling] on the panel menu or clear the [Collate ③③
pages] check box on the [Print] screen, and then enter the 
number of copies in [Copies].

 Memo •	If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

•	If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

Select [Printer Features] on the panel menu, and then select ④④
the [Collate] check box in the [Job Option] feature set.

 Memo •	Printing is performed without using the printer’s memory when 
[Paper Handling] is selected on the panel menu and the [Collate 
pages] check box is selected.

For those using a Mac OS X PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Enter the number of copies in [Copies].③③
Select [Paper Handling] from the panel menu.④④

C
ollate Print

Select the [Collate pages] check box.⑤⑤

 Memo •	Choose [Job Options] from the panel menu, and click [Ad-
vanced], then by un-clicking [The Printer Collate is always 
used], you can print without using the printer memory.
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A
utom

atically select tray 

Automatically select tray 
Explanation of Functions��

It is possible to have either tray 1, tray 2 (optional) , tray 3 (op-
tional, B840dn only) or the multi - purpose tray automatically 
selected to match the paper size set on the printer driver.

Note! •	 You must set the paper size and paper thickness for trays 1 - 3 
and the multi - purpose tray on the operating panel.

•	� The initial value for the [MP TRAY USAGE] in the menu settings 
is [DO NOT USE]. In this case the multi - purpose tray cannot be 
subject to automatic selection.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer 
driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

�� Method of operation 

1 	 Set the method of MP tray use on the operating panel. 

Press the ①①  button several times and the [PRINT MENU] 

will be displayed. 

Press the ②②  ENTER button.

Press the ③③  or the  button several times, and [MP 

TRAY USAGE] will be displayed.

press the ④④  ENTER button.

Press the ⑤⑤  or the  button several times and [WHEN 

MISMATCH] will be displayed.

Press the ⑥⑥  ENTER button, and a [*] will appear on the 

right side of the set value. 

Press the ⑦⑦  Online button, and [ONLINE] will be displayed.

2	 Set [Paper Source] on the printer driver. 

Those using a Windows PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③
Select [Automatically Select] from [Paper Source] in the [Pa-④④
per/Quality] tab.



40

Chapter 2  Convenient Printing Functions

2

Those using a Windows PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Click on [Preferences]. ③③
Select [Automatically Select] from [Source] in the [Setup] tab.④④

For those using a Mac OS X PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Select [All pages From] or [Auto Select] from the [Paper Feed] ③③
panel.

Memo •	 If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	 •	 If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

A
utom

atically select tray 
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Print a large volum
e w

ith the sam
e paper size 

Print a large volume with the same paper size 
Explanation of Functions��

If you set the same paper size and thickness for tray 1, tray 2 (op-
tional) , tray 3 (optional, B840dn only) , and the multi - purpose 
tray, you can print from another tray when the paper runs out.

Note! •	 You must set the paper size and paper thickness for trays 1 - 3 
and the multi - purpose tray on the operating panel to be the 
same. If the paper size and thickness is different between trays, 
you will not be able to automatically change between trays.

•	� The initial value for the [Method of MP Tray Use] in the menu is [Do 
Not Use]. In this case the multi - purpose tray cannot be subject 
to automatic selection.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer 
driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

�� Method of operation 

1 	 Set the method of MP tray use on the operating panel. 

Automatically Select Tray��  (P 39) 

2 	� Set the paper size and thickness to be the same for tray 1, 
tray 2, tray 3, and for the multi - purpose tray.

�If using the operating panel, refer to Setup Instructions - ��
Chapter 2 Basic Operation

3 	 Set [Automatically Switch Trays] on the printer driver.

Those using a Windows PS printer driver 

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③
Click [Advanced] in the [Layout] tab.④④
Select [On] for [Tray Switch].⑤⑤
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2

Print a large volum
e w

ith the sam
e paper size 

Those using a Windows PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Click on [Preferences].③③
Click [Paper Feed Options] in the [Setup] tab.④④

Put a check in [Auto Tray Change].⑤⑤

If you are using a Mac OS X PS printer driver  

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Put a check in [Tray Switch] in the [Insert Option] function ③③
panel on the [Printer Features] panel.

Memo •	 If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	 • If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.
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For those using a Mac OS X PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Select [Setup] from the panel menu.③③
Click [Printer Options].④④
Check the [Auto Tray Switch] check box.⑤⑤

Memo •	 If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	 •	 If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

Print a large volum
e w

ith the sam
e paper size 
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S
ave the printer driver settings and use them

 again

Save the printer driver settings and use them again
Explanation of Functions��

You can save the details you set on the printer driver. 
If you save details of settings changed in several places, the printer 
driver details will be automatically changed in several places to the 
saved details from the next time, just by specifying the driver settings.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Save settings••

Those using a Windows PCL printer driver

For Windows 8/8.1/Server 2012/2012 R2, select [Control ①①
Panel] - [Devices and Printers].

	 For Windows 7/Windows Server 2008 R2, select [Start] - 
[Devices and Printers].

	 	For Windows Vista/Windows Server 2008, select [Start] - 
[Control Panel], and then click on [Printers].

	 	For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

	 	For Windows Server 2003, select [Start] - [Printers & Faxes].

Right - click on the icon of the printer you want to use, and se-②②
lect [Printing Preferences].

Change each setting.③③
④④ Select [Add] on [Driver Settings] in the [Setup] tab.

Enter the name of the settings in [The input of the setup name] ⑤⑤
and then click [OK].

 Memo •	Save paper information
Put a check in it in order to save the [Media] settings in the 
[Setup] tab.
You can save up to a maximum of 14 of them.
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Use saved settings••

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Select the settings to use from [Driver Settings] and click [OK].③③

S
ave the printer driver settings and use them

 again
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Change the printer driver initial settings

C
hange the printer driver initial settings

Explanation of Functions��

It is convenient to change frequently changed functions in initial 
settings.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using a Windows printer driver

For Windows 8/8.1/Server 2012/2012 R2, select [Control  ①①
Panel] - [Devices and Printers]

	 For Windows 7/Windows Server 2008 R2, select [Start] -  
[Devices and Printers].

	 	For Windows Vista/Windows Server 2008, select [Start] - 
[Control Panel], and then click on [Printers].

	 	For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

	 	For Windows Server 2003, select [Start] - [Printers & Faxes].

Right click the icon of the printer you are using.  ②②
Select [Printing Preferences].

Change each setting and click [OK].③③

 (The Windows PCL printer driver screen) 

For those using a Mac OS X

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Change each setting.③③

 Memo •	If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	 •	 If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.
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Select [Save Current Settings as Preset] in [Presets], enter an ④④
appropriate setting name and click [OK].

Note! •	 [Page Setup] dialog initial settings cannot be changed.

•	 Select a setting name saved in [Preset] at the time of printing.

•	� The operations with settings saved on other drivers cannot be 
guaranteed. Save the settings with a name so that you can tell 
the model name.

C
hange the printer driver initial settings
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2

Use the face up stacker to output sheets in the order of the pages
Explanation of Functions��

The paper is output with the printed surface facing up.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using a Windows PS printer driver

Open the rear printer side of the face up cover.①①

face up cover

②② Open the face up stacker.

face up stacker

Pull out the paper supporter.③③
Note! •	 Do not open the face up stacker during printing. This may re-

sult in a paper jam.

paper supporter

Open the file you want to print.④④
Select [Print] from the [File] menu.⑤⑤
Click on [Preferences]. ⑥⑥

U
se the face up stacker to output sheets in the order of the pages
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On [Page Order] in the [Layout] tab, select [Back to Front].⑦⑦

 Memo •	If the [Page Order] item is selected, right - click on the [OKI 
B840 (PS)] icon in the [Printers and Faxes] or [Printers] folder 
and put a check in [Enable advanced printing features] in the 
[Properties] - [Advanced] tab.

U
se the face up stacker to output sheets in the order of the pages
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Those using Windows

For Windows 7/Windows Server 2008 R2, select [Start] - [De-①①
vices and Printers].

	 For Windows Vista/Windows Server 2008, select [Start] - 
[Control Panel], and then click on [Printers]. 

	 For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes]. 

	 For Windows Server 2003, select [Start] - [Printers and Faxes].
Select the printer icon and right - click on it.②②

	 Select [See what’s printing] from the displayed menu.

③③ Click on [Documents] - [Cancel].

 Memo •	If the OKI LPR Utility is being installed, you can cancel from it. 

OKI LPR Utility (�� P 165) 

For those using Mac OS X 

Select [Apple Menu] - [System Preferences].①①

Click [Print & Scan].②②

③③ Double click on the printer name.

Click on the job you want to delete and then click [x].④④

2

Cancel a print job from the computer

C
ancel a print job from

 the com
puter



Note! •	 In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X. 

•	 The screen or procedure may vary depending on the application you use.

•	 Please refer to Online Help for detailed explanations of each setting item for utilities and printer drivers. 

•	 The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.
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3

Print after entering a password (Secure Print)

Print after entering a passw
ord (S

ecure Print) 

Explanation of Functions��

You can store print data on an SD memory card (optional) put into 
the printer, and then print from the control panel, after entering a 
password.

Memo •	 If the capacity of the memory card used to store print jobs is 
insufficient, [FILE SYSTEM FULL] will be displayed.

Operating environment��

If the printer has an SD memory card (optional), you can use it.

Memo •	 Prior to inserting an SD memory card, settings must be config-
ured on the printer driver.   For details, please refer to Options in 
Chapter 1 - Setting Up, within the Setup Instructions.

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

1	 Print from the computer.

Those using Windows 

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Click on [③③ Preferences].

Select [④④ Secure Print] from [Job Type] on the [Job Options] tab.

On the JOB PIN screen enter Job Name and Job Password and ⑤⑤
click on [OK].

Memo •	 Enter the job name at the time of printing
When you print, the screen to enter the job name appears.

	Job password••
Set a 4 digit number. 
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3

Print. ⑥⑥
Memo •	 If you put a check in the [Request Job Name for each print 

job] box, enter the Job Name on the Job Name Entry screen, 
and then click [OK].
	Job name ••
Set this as up to a maximum of 16 half - Width (English) char-
acters.

Print after entering a passw
ord (S

ecure Print) 
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3

Print secret or important documents (Encrypted Secure Print)
Explanation of Functions��

Send to the printer after encrypting print data. By doing this, the 
details of the printing can be prevented from leaking, even if print 
data is intercepted from the printer communication process or 
from an SD card.  In order to further strengthen security, print 
jobs saved on the SD memory card (optional) are automatically 
deleted after a set period of time has passed. 
You can prevent theft of printed materials by printing after enter-
ing a password in the printer control panel.

Note! •	 Cannot be used with Windows 8 (64bit version)/Windows 8.1 
(64bit version)/Windows Server 2012/Windows Server 2012 R2/
Windows 7 (64bit version)/Windows Vista (64bit version)/Win-
dows Server 2008 (64bit version)/Windows Server 2008 R2/Win-
dows XP (x64 version)/Windows Server 2003 (x64 version).

•	� If the capacity of the SD memory card is insufficient to store the 
print job, [FILE SYSTEM FULL] will be displayed.

�� Operating environment

If the printer has an SD memory card (optional), you can use it.

Memo •	 Prior to inserting an SD memory card, settings must be config-
ured on the printer driver. For details, please refer to Options 
in Chapter 1 - Setting Up, within the Setup Instructions.

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

1	 Specify encrypted authenticated printing, and then print

Those using Windows 

Open the file you want to print.①①
②② Click on [Preferences].

Click on [Advanced] in the [Job Options] tab.③③

(The Windows XP PS printer driver screen)

Confirm that there is a check in the [Job Spool] box, and click ④④
[OK].

Print secret or im
portant docum

ents (Encrypted S
ecure Print)
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Select [Encrypted Secure Print] from [Job Type] on the [Job Options] tab.⑤⑤

Enter the [Password], and click [OK].⑥⑥

(The Windows XP PS printer driver screen)

Memo • Password
Set 4 - 12 English lower - case characters.

	Request Password for each print job••
At the time of printing a password entry screen appears on 
the computer.

	Auto Erase Time-out ••
The time for which print jobs are saved to the printer SD 
memory card is set as 5 mins - 23 hours 59 mins. Print 
jobs that are passed the saving period will be automatically 
deleted from the SD memory card.

	Job Erase••
Sets the method to use at the time of deleting print jobs from 
the SD memory card.

	Delete File••
Delete a print job using the file system. There is a possibility that 
print jobs deleted from the SD memory card using this method 
may be restored, however, it is the quickest method of deleting. 

	Overwrite with Zeros••
Delete a print job after overwriting with specific data. This 
deletion method is safer than the simple delete method, 
however, there is a possibility that print jobs can be re-
stored using a special method.

Print from the computer. If you put a check in the [Request ⑦⑦
Password for each print job] box, enter the [Password] on the 
[Secure Setting] screen, and then click [OK].

2	 Enter the password on the printer control panel and then print.

Press the ①①  button several times, select [PRINT JOBS 

MENU] and press the  ENTER button.

Press the ②②  button several times, select [ENCRYPTED JOB], 

and then press the  ENTER button. 

The password entry screen will appear, so enter the password.③③
[PRINT/DELETE] is displayed in [ENCRYPTED JOB], so when ④④
printing, select [PRINT], and then press the  ENTER but-

ton. Print encrypted authenticated print jobs.
Memo •	 If you make a mistake when entering the password, press the 

 Back Button, to set it. 
	In order not to print, you can select the ••  button in Procedure 
④ , in order to cancel a job.
If [ARE YOU SURE? YES/NO] is displayed, you can check that [YES] ••
is selected, and press the  ENTER button to cancel the job. 
	After carrying out an encrypted authenticated print, you the ••
file you used to print will be deleted using the specified dele-
tion method. While the file is being deleted, a message saying 
[FILE ERASING] will be displayed.
	•• If a data transfer fails, or if it is detected that the data has been 
tampered with, a message will be displayed saying [PRESS ONLINE 
SW/INVALID SECURE DATA], and the relevant data will be deleted.

Print secret or im
portant docum

ents (Encrypted S
ecure Print)
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Explanation of Functions��

You can store print data in the printer SD Memory Card (optional), 
and you can quickly open the computer after large or complex 
jobs.

Note! •	 If the SD Memory Card capacity is too small to store the print 
job, [File System Full] will be displayed.
	Printing is completed quicker when compared with the case ••
where it is not saved.

Operating environment��

If the printer has an SD memory card (optional), you can use it. 
The SD memory card requires a COMMON partition.

Memo •	 Prior to inserting an SD memory card, settings must be config-
ured on the printer driver.   For details, please refer to Options 
in Chapter 1 - Setting Up, within the Setup Instructions.

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using Windows

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②

Click on [Preferences].③③
Click on [Advanced] in the [Job Options] tab.④④

(The Windows XP PS printer driver screen)

Put a check in the [Job Spool] box.⑤⑤

3

Quickly open the computer (buffer print)

Q
uickly open the com

puter (buffer print)
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M
anually do double sided printing (M

anual D
ouble - S

ided Printing)

Manually do double sided printing (Manual Double - Sided Printing)
Explanation of Functions��

You can manually print on both sides of the paper you are using, 
without using a double - sided printing unit. After printing on one 
side, set the paper again, and print on the other side of the paper.

The papers sizes on which you can do manual double - sided printing 
are: A3, A4, A5, A6, B4, B5, B6, letter, legal (13 inch),  
legal (13.5 inch), legal (14 inch), tabloid, executive, statement,  
8K (260 × 368 mm), 8K (270 × 390 mm), 8K (273 × 394 mm),  
16K (184 × 260 mm), 16K (195 × 270 mm), 16K (197 × 273 mm), 
and custom size.
Please refer to the following table regarding custom sizes.
When doing manual double - sided printing on A6, B6, statement, 
or tabloid paper, please use the multipurpose tray (MP tray).
The thickness of the paper that can be used for manual double sided 
printing is a basic weight of 60 - 200g/m2 (ream weight of 52 - 172kg).
Please check beforehand that the paper you are using for manual 
double sided printing does not interfere with the print quality or 
the running of the paper.

Note! • You may be not able to use this, depending on the application 
you are using.
	You cannot set multiple copies or a single multiple copies page.••
	After a certain amount of time passes following printing on one ••
side of the paper (this is initially set to 1 minute), if the online 
button is not pressed, the unprinted data will be deleted. 
	You cannot use paper printed on other printers. ••

Custom sizes with which you can carry out manual double sided printing

Tray 1, 2, 3 Width 148 - 297 mm	 Length 182 - 432 mm

Multipurpose tray 
(MP Tray) Width 76 - 297 mm	 Length 148 - 432 mm

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using a Windows PCL printer driver

If using tray 1 - 3••

After printing on one side, set the paper again, and print on the 
other side of the paper. Tray 1 is used here as an example.

Memo • You can print up to 100 pages at a time (with double sided 
printing this is 50).

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Click on [Preferences].③③
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3

④④ On [Source]in the [Setup] tab, select [Tray 1(Standard Cas-
sette)]. Select [Long Edge (Manual)] or [Short Edge (Manual)] 
from [2-Sided Printing].

If single sided printing has finished, remove the paper left in ⑤⑤
the tray.

⑥⑥ Reverse the printed paper, and set it as shown in the diagram.

Memo • Print on the reverse side of the single - sided printed paper.
	If there is no data for the reverse side, one side will be left ••
blank, so put it back in the cassette and print in the same or-
der.

P
P

Press an online button start single - sided printing again.⑦⑦

M
anually do double sided printing (M

anual D
ouble - S

ided Printing)
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If using the multipurpose tray••

①① Open the file you want to print.

Select [Print] from the [File] menu. ②②
Click on [Preferences].③③
Select [Multi Purpose Tray] from [Source] in the [Setup] tab.④④

	 Select Select [Long Edge (Manual) ]or [Short Edge (Manual)] 
from [2-Sided Printing] and print.

If single sided printing is finished, set the paper as per the dia-⑤⑤
gram and press the Set button.

set button

Press an online button to print the other side.⑥⑥

M
anually do double sided printing (M

anual D
ouble - S

ided Printing)
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3

Register a form
 and then print (Form

 overlay)

Register a form and then print (Form overlay)
Explanation of Functions��

You can register forms, logs, etc., on the printer, and print overlays.

Memo • Use the Oki storage manager.
Oki Storage Device Manager (�� P 104)

Note! •	 When using a Windows PS printer driver, computer administra-
tor rights are required.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

�� Method of operation 

Those using a Windows PS printer driver

1 	 Create a form

Make [Ports] into [FILE:]①①
Output Print Data to Files (�� P 64)

Launch the application, and create the form which you want to ②②
register on the printer.

Select [Print] from the [File] menu. ③③
Click on [Preferences].④④

Click on [Overlay] in the [Job Options] tab, and select [Create ⑤⑤
Form].

(Windows XP Screen)

Print Enter the saved file name and select the destination to ⑥⑥
save to.

Restore the [Ports].⑦⑦

2 	 Register a form with the Oki Storage Device Manager. 

Oki Storage Device Manager (�� P 104)

3 	 Register an overlay on the printer driver, and print.

For Windows 8/8.1/Server 2012/2012 R2, select [Control  ①①
Panel] - [Devices and Printers].

	 For Windows 7/Windows Server 2008 R2, select [Start] -  
[Devices and Printers].

	 For Windows Vista/Windows Server 2008, select [Start] -  
[Control Panel], and then click on [Printers].

	 For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

	 For Windows Server 2003, select [Start] - [Printers & Faxes].
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�Right click the [OKI B840(PS)] icon with your mouse, and se-②②
lect [Printing Preferences].

Set it to use an overlay. ③③
Click on [Overlay] on the [Job Options] tab, and select [Use Over-
lay].

Click [New].④④

Enter the form name you registered in Oki Storage Manager ⑤⑤
into [Form Name], and click [Add].

Enter the [Overlay Name] and on [Print on Pages] select the ⑥⑥
page to which the overlay is to be applied. To set the page 
and then apply it, select [Custom] and then enter the page to 
which you want to apply it in [Custom Pages].

Memo •	 An overlay is a form group. You can register 3 forms on one 
overlay. The forms and overlays are overlayed on top of one 
another in the order they are registered.

Click on [OK].⑦⑦
Select the overlay to use from the defined overlay, and click on ⑧⑧
[Add].

Start a print job.⑨⑨

Register a form
 and then print (Form

 overlay)
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Those using a Windows PCL printer driver

1 	 Create a form.

Make [Ports] into [FILE:]①①
Output Print Data to File (�� P 64) 

Launch an application, and create the form which you want to ②②
register on the printer.

Start a print job. Enter the saved file name and select the des-③③
tination to save to.

Restore the [Ports].④④

2 	 Register a form with the Oki Storage Device Manager.

Oki Storage Device Manager (�� P 104) 

3 	 Register an overlay on the printer driver, and print.

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
Click on [Preferences].③③
Click on [Vector] in [Print Mode] within the [Job Options] tab.④④
Click on [Overlay] in the [Job Options] tab.⑤⑤

Put a check in [Print Using Active Overlays] in the Overlay ⑥⑥
screen, and click on [Define Overlays].

Enter [Overlay Name], and in [ID Value(s)] enter the ID of the ⑦⑦
form that you registered in Oki Storage Device Manager.

 Memo • An overlay is a form group. You can register 3 IDs(form files) 
in one overlay. The forms and overlays are overlayed on top of 
one another in the order they are registered.

Select the page you want to apply the overlay to in [Print on ⑧⑧
Pages]. To set the page and then apply it, select [Custom] and 
then enter the page to which you want to apply it in [Custom 
Pages].

Register a form
 and then print (Form

 overlay)
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Click [Add].⑨⑨
Click [Close].⑩⑩
Select the overlay to use for printing from the defined overlays, ⑪⑪
and click [Add].

Start a print job.⑫⑫

Register a form
 and then print (Form

 overlay)
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3

Output print data to files

O
utput print data to files

Explanation of Functions��

You can write print data to files and save it.
The saved data can be printed from OKI LPR Utility (if you are us-
ing Windows) (P 165).

Note! • When using Windows, computer administrator rights are required.
	••When outputting print data to a file with Windows 7/Windows Vista/
Windows Server 2008, you may not be able to access the file set as 
the output target due to security restrictions.  In such a case, you 
need to set the output target to a folder and file that the printing 
user can access, such as C:\Users\(Logon User Name)\Documents.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using Windows

For Windows 8/8.1/Server 2012/2012 R2, select [Control ①①
Panel] - [Devices and Printers].

	 	For Windows 7/Windows Server 2008 R2, select [Start] -  
[Devices and Printers].

	 	For Windows Vista/Windows Server 2008, select [Start] - 
[Control Panel], and then click on [Printers].

	 	For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

	 	For Windows Server 2003, select [Start] - [Printers & Faxes].

Right click the icon of the printer you are using. ②②
Select [Printer properties].

Select FILE: in [Ports] on the [Port] tab, and click [OK].③③
Start a print job. Enter [Output Target File Name] within [Print ④④
to File], and then click [OK].

For those using a Mac OS X

Open the file you want to print.①①
Select [Print] from the [File] menu. ②②
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Click on [PDF], and select the destination to save to. ③③

Enter the file name you want to save with in [Name], select ④④
the destination to save to and click [Save]. O

utput print data to files
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Printing PostScript Errors

Printing PostS
cript Errors 

Explanation of Functions��

If a PostScript error occurs, you can print the details of the error.

Operating environment��

The model you are 
using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer driver PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation ��

Those using a Windows PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③
Click [Advanced] in the [Layout] tab.④④

On [PostScript Options] - [Send PostScript Error Handler], ⑤⑤
select [Yes].

3



Note! •	 In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X.

• The screen or procedure may vary depending on the applicaiton you use.

• Please refer to Online Help for detailed explainations of each setting item for printer drivers and utilities. 

• The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.

Chapter 4  Printing neatly

Changing the resolution and then printing����������������  68
Change the print density��������������������������� 70
Changing the finish of the printed image����������������� 72
Preventing cracks in fine lines������������������������ 74
Replace with the printer font and print������������������  75
Print using the computer font������������������������ 77
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C
hanging the resolution and then printing

Changing the resolution and then printing
Explaination of Functions��

You can change the resolution and then print.

Note! • If you specify [High Quality] then you may not be able to print 
complex files. In such a case print it with [Normal]
This printer carries out print processing on the computer side. ••
If you use a computer with a high processing speed, you can 
shorten the printing time.

�� Operating environment

The model you are 
using

B840dn B820n

The environment you 
are using the machine in

Windows Mac OS X Windows Mac OS X

The type of printer 
driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use

Method of operation��

Those using a Windows printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③

④④Select the resolution on [Quality] in the [Job Options] tab.

(The Windows PCL printer driver screen)

For those using a Mac OS X PS printer driver

①①Open the file you want to print.

Select [Print] from the [File] menu.②②
�Select the resolution from the [Quality] on the [Job Option] ③③
function set on the [Print Features] panel.
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 Memo •	If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	  •	If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

For those using a Mac OS X PCL printer driver
Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Select the resolution from the [Print Quality] on the [Job Op-③③
tions] panel.

Memo • �If setting details are not displayed in the print dialog box for 	
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	 • �If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

C
hanging the resolution and then printing
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4

C
hange the print density

Change the print density
Explanation of Functions��

You can change the print density to five different levels. If small 
characters may get smudged or if the image data is dense, then set 
it in the "Light (Minus)" direction. If fine lines may get broken, set it 
in the "Dense (Plus)" direction.

 Memo • �For Windows, if you put a check in [Adjuster Printer Printing 
Density] the printer driver settings will be prioritized.

Operating environment��

The model you 
are using B840dn B820n

The environment 
you are using  
the machine in

Windows Mac OS X Windows Mac OS X

The type of  
printer driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use × ×

Method of operation ��

Use the control panel to change.

Press the ①①  or  button several times. The [MAINTE-

NANCE MENU] will be displayed, and press the  ENTER but-

ton.

Press the ②②  or  button several times. [DARKNESS/0] 

will be displayed, and press the  ENTER button.

Press the ③③  or the  button to display the target value.

Press the ④④  ENTER button, and a [*] will appear on the 

right side of the set value. 

Press the ⑤⑤  Online button, and [ONLINE] will be displayed.

Those using a Windows PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
�Click on [Preferences]. ③③
Click on [Advanced] in the [Job Options] tab.④④
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Put a check in [Printer Darkness] and select the appropri⑤⑤ ate 
value.

For those using a Mac OS X PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
�Select [Job Options] from the panel menu.③③
Click [Advanced].④④

C
hange the print density

Select the appropriate value from [Density].⑤⑤

 Memo • �If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

	  • �If the print option is not displayed in the print dialog box for 
Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.
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Changing the finish of the printed image
�Change the settings for [Dithering Pattern], [Dithering Tex-④④
ture], and [Manual Adjustment] in the [Image] tab.

Click on [Quality] in the [Job Options] tab.⑤⑤
Click on [Advanced].⑥⑥

�� Explanation of Functions

The overall print result of the image is determined by the print 
driver settings. Try out various settings until you get the result 
you want.

Operating environment��

The model you 
are using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer 
driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use × ×

Method of operation ��

Those using a Windows PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
�Click on [Preferences]. ③③

C
hanging the finish of the printed im

age
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Change the [Increase brush density].⑦⑦

For those using a Mac OS X PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Change the [Dithering Pattern], [Dithering Texture], [Bright-③③
ness] and [Contrast] settings in the [Image] panel.

C
hanging the finish of the printed im

age

 Memo • If setting details are not displayed in the print dialog box for 
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of 
the dialog box.

 	  • If the print option is not displayed in the print dialog box 
for Mac OS X 10.6.8, click the disclosure triangle next to the 
[Printer] drop-down list.

Change the [Print Quality] in the [Job Options] panel. ④④
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Preventing cracks in fine lines

Preventing cracks in fine lines

Explanation of Functions��

If you set extra - fine lines from the application, this will prevent 
the lines from breaking. This function is set to ON as standard.

 Memo • �Depending on the application, the spaces in bar codes, etc., 
may become more narrow. In such a case, turn this function 
to OFF.

Operating environment��

The model you 
are using B840dn B820n

The environment 
you are using 
the machine in

Windows Mac OS X Windows Mac OS X

The type of printer 
driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use × × × ×

Method of operation ��

Those using a Windows PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③
Click on [Advanced] in the [Job Options] tab.④④

Put a check in [Adjuster ultra fine lines].⑤⑤

(The Windows XP PS printer driver screen)

For those using a Mac OS X PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Put a check in [Adjust ultra fine lines] in the [Job Option] ③③
function set within the [Printer Features] panel.

 Memo • If setting details are not displayed in the print dialog box for Mac OS 
X 10.7 to 10.9, click [Show Details] at the bottom of the dialog box.

	  • If the print option is not displayed in the print dialog box for Mac OS X 
10.6.8, click the disclosure triangle next to the [Printer] drop-down list.

4
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Explanation of Functions��

You can replace the TrueType font with the printer internal font 
and print.

Note! • The font replacement function preserves the appearance of the 
document, but it does not reproduce the design of the font. If 
you need to correctly print the design of the font, disable the 
font replacement function.

Operating environment��

The model you 
are using B840dn B820n

The environment 
you are using the 

machine in
Windows Mac OS X Windows Mac OS X

The type of printer 
driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use × × ×

Method of operation ��

Those using a Windows PS printer driver

For Windows 8.1/Windows 8/Windows Server 2012 R2/Windows ①①
Server 2012, select [Control Panel] - [Hardware and Sound] - [De-
vices and Printers].

	 For Windows 7/Windows Server 2008 R2, select [Start] -[Devices 
and Printers].

	 For Windows Vista/Windows Server 2008, select [Start] - [Control 
Panel, and then click on [Printers].

	 For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

	 For Windows Server 2003, select [Start] - [Printers & Faxes]

Replace with the printer font and print
Right - click on the (OKI B840(PS)) icon, and select [Properties].②②

③③Replace the TrueType font with the printer font in [Font Substitu-
tion Table] within the [Device Settings] tab, and then click [OK].

Open the file you want to print.④④
Select [Print] from the application [File] menu.⑤⑤
Click [Advanced] in the [Layout] tab.⑥⑥
Select [Substitute with Device Font] in [TrueType Font].⑦⑦
Start a print job.⑧⑧

Those using a Windows PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③
Select [Vector] in [Print Mode] within the [Job Options] tab.④④

Replace w
ith the printer font and print
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Click on [Font].⑤⑤

Check [Font Substitution].⑥⑥
Select which printer font to replace the TrueType font with in ⑦⑦
[Font Substitution Table].

Start a print job.⑧⑧

Replace w
ith the printer font and print
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Explanation of Functions��

You can output a TrueType font exactly the same as you see it on 
the screen.

Note! • This will make the printing time longer.

Operating environment��

The model you 
are using B840dn B820n

The environment 
you are using 
the machine in

Windows Mac OS X Windows Mac OS X

The type of printer 
driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PS Printer  
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

PCL Printer 
Driver 

Can use × × ×

Method of operation ��

Those using a Windows PS printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences]. ③③
Click [Advanced] in the [Layout] tab.④④

Print using the computer font
Select [Substitute with Device Font] in [TrueType Font].⑤⑤

Print. ⑥⑥
Those using a Windows PCL printer driver

Open the file you want to print.①①
Select [Print] from the [File] menu.②②
Click on [Preferences].③③
Select [Vector] in [Print Mode] within the [Job Options] tab.④④

Print using the com
puter font
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Click on [Font].⑤⑤

Un-click on [Font Substitution].⑥⑥
 Memo • Download as outline font  

   Create a font image on the printer.
	Download as bitmap font. ••
   Create a font image with the printer driver.

Start a print job.⑦⑦

Print using the com
puter font
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Configure the IP Address
Set the printer's IP address, subnet mask, and gateway address from 
the printer control panel.

Note! • �If there is a mistake entered in the IP address, subnet mask, or 
gateway address, the network may go down or a major fault may 
arise. Please set your IP address after consulting with your net-
work administrator.

Turn the printer power ON.①①
Check that [ONLINE] is displayed on the control panel.②②

�Press the ③③  or the  button several times, and the 

[NETWORK MENU] will be displayed.

NETWORK MENU

Press the ④④  ENTER button. If [TCP/IP] is set to [DISABLE], 

change it to [ENABLE].

TCP/ I P
ENABLE

Press the ⑤⑤  button several times, select [IP ADDRESS], 

and press the  ENTER button.

IP ADDRESS
0 .       0 .        0 .       0  

⑥⑥ One digit of the IP address will be flashing, and press the  

or the  button, and the value you want to set will be dis-
played. 

If you press and hold the button for 2 seconds or longer, it will 
be sent quickly.

IP ADDRESS
192.        0.        0.        0   

Press the ⑦⑦  ENTER button. Two digits of the IP address will 
be flashing.  
	 Repeat steps  -  and set all the digits.

IP ADDRESS
192 .   168.        0.        2＊ 

Press the ⑧⑧  Back button.

Press the ⑨⑨  button several times, and set the [SUBNET 
MASK] and [GATEWAY ADDRESS] using the same procedure.

If you have finished configuring the settings, press the ⑩⑩  
Online button. The values set in the printer are saved and the 
network function is restarted.

	 If [ONLINE] is displayed in the control panel, then the proce-
dure is complete.

C
onfigure the IP A

ddress
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C
hange the tim

e it takes to go into pow
er save m

ode

Change the time it takes to go into power save mode
Set the time it takes to go into power save mode.
The time until print starts may be shorter with longer times to go 
into power save mode.
After a set period, if data is not received, then the machine goes into 
power save mode.

Note! • �Setting [POWER SAVE] to [DISABLE] and using the machine for 
long periods of time increases the likelihood of an effect on the 
life of the components of the machine (such as the fan).

Press the ①①  button several times, select [SYS CONFIG 

MENU], and then press the  ENTER button.

As [②② POW SAVE TIME] is selected, presse the  ENTER but-

ton.

Press the ③③  or the  button several times, select the 

time to set, and then press the  ENTER button.

Press the ④④  Online button, and [ONLINE] will be displayed.

 Memo • �If you set [POWER SAVE] in the [MAINTENANCE MENU] to 
[DISABLE], the machine will not go into power save mode.  
However, in order to maintain a temperature at which the 
fuser unit can print, power will still be used. Please turn the 
printer power OFF when you are not using it.
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Change the time it takes to go into sleep mode
Set the time it takes to go into sleep mode.
If the machine goes into power save mode and does not receive any 
data within a set time, it will go into sleep mode.
This is the explaination of the procedure to change the time on the 
control panel.

Press the ①①  button several times, select [SYS CONFIG 

MENU], and press the  ENTER button.

Press the ②②  button, select [SLEEP TIME], and press the  

ENTER button.

Press the ③③  or the  button several times, select the 

time to set, and then press the  ENTER button.

Press the ④④  Online button, and [ONLINE] will be displayed.

Memo • If you set [SLEEP] in [MAINTENANCE MENU] to [DISABLE], the 
machine will not go into sleep mode.

How to get out of sleep mode��

In order to get out of sleep mode, either press the  Online 

button or send some print data to the printer through a computer 

connected via a network or through the USB.

�� Restrictions When in Sleep Mode

When the machine goes into sleep mode, the following limits apply 
to the printer driver and utility functions.

If the printer goes into sleep mode, press the  Online button 

on the control panel, and check that [ONLINE] is displayed.

If [ONLINE] is displayed, the following restriction itmes apply.

Note! • If [PARALLEL] in the [PARALLEL MENU] is set to [ENABLE], the 
printer cannot go into sleep mode. 

Those using Windows

Software Name Restrictions When in Sleep Mode

Methods of dealing 
with it other than 

pressing the Online 
button

Network Extension Cannot connect to the machine. –

Network Card Setup Cannot search the machine or adjust-
er settings.

–

PrintSuperVision Cannot monitor consumables or the 
number of pages printed, etc.

–

Oki Storage 
Device Manager 

If the printer is connected via a paral-
lel interface, printer searching and 
setting configuration cannot be done.

Connect to a 
network or a USB 
printer.

Web Driver Installer • When installing a driver, you can-
not automatically get printer option 
information.

• You cannot manually register the 
printer on a WDI server.

–

C
hange the tim

e it takes to go into sleep m
ode
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Software Name Restrictions When in Sleep Mode

Methods of dealing 
with it other than 

pressing the Online 
button

Driver Installer • If there is a connection with the 
network, you cannot get printer op-
tion information automatically when 
the driver is being installed.

–

Those using Macintosh

Software Name Restrictions When in Sleep Mode

Methods of dealing 
with it other than 

pressing the Online 
button

Printer Drivers You cannot print if connected with 
AppleTalk.

Connect to a printer 
with TCP/IP or USB.

Network Card 
Setup

Cannot search the machine or adjust-
er settings.

–

MicrolinePS 
Utilities

You cannot print if connected with 
AppleTalk.

–

Sleep mode network function restriction items ��

In sleep mode, the following constraints apply to network functions.

• Cannot go into sleep mode.

1) If IPSec is activated.
2) If NetBEUI is activated.
3) If NetWare is activated.
4) If EtherTalk is activated.
5) If a TCP connection is being established.

E.g.: If establishing a connection with telnet or ftp.
In Power Save Mode, after some time passes and it goes to 
sleep, if the connection is broken it will go into sleep mode.

If you want to activate sleep mode, please deactivate IPSec/
NetBEUI/NetWare/EtherTalk.

• Cannot Print

In sleep mode, you cannot print with the following protocols.
1)	NetBEUI 
2)	NBT
3)	NetWare 
4)	EtherTalk *1
5)	Bonjour *1

*1 When using Mac OS X, you can print while in sleep mode 
with an IP Print connection.

• Cannot Search/Change Settings

In sleep mode, you cannot search or change settings with the 
following functions/protocols.
1) PnP - X
2)	UPnP
3)	Bonjour
4)	LLTD
5)	FLDP
6)	ODNSP
7)	JCP
8)	MIB *2
*2 You can refer to part of MIB while in sleep mode (Get 

Comment).

C
hange the tim

e it takes to go into sleep m
ode
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• Protocols with the client function do not work

1) Email alert *3
2) SNMP Trap
3)	WINS*4
4)	SNTP

*3 �This does not include intervals between times of regular 
notifications when some time has passed in sleep mode.

*4 �This does not include intervals between WINS updates when 
some time has passed in sleep mode.

	 In order to carry out regular WINS updates in sleep mode, 
the names registered on the WINS server may be deleted.

• Protocols that need to have sleep mode deactivated to be used

When using the following protocols, deactivate sleep mode.
1)	IPv6
2)	NetBEUI
3)	NetWare
4)	EtherTalk

C
hange the tim

e it takes to go into sleep m
ode



85

5

Cancel a print job
You can cancel data that is being processed by the printer.

Note! • You cannot cancel jobs that have started to print.

Press the Cancel button on the printer's operating panel to ①①
cancel a print job.

[Cancel] Button

 Memo •	If the printer is connected to a computer using a USB, and if 
you cannot print normally after having  cancelled a print job 
from the computer,  remove and reinsert the USB cable, or 
turn the printer power OFF ( )/ON( l ).

C
ancel a print job / C

heck printer internal fonts

Check printer internal fonts
The printer will print its internal font name as standard.

Note! • If you are printing on paper other than A4, it may be that not 
all of the contents will be printed out. 
You cannot print if [Local Print] in Print Control Server is set to ••
[Cannot Print] or [Cannot Print in Color].

Set A4 paper in the tray.①①
Press the ②②  button several times, select [INFORMATION 

MENU], and press the  ENTER button.

Press the ③③  button several times, select [PRINT PSE FONT/

EXECUTE], [PRINT PCL FONT/EXECUTE], or [PRINT PPR FONT/

EXECUTE], [PRINT FX FONT/EXECUTE] and press the  EN-

TER button. 
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Initializing an SD memory card (optional)
You can return SD cards to their initialized state. 
An SD memory card on B840dn is divided into three partitions ([PS], 
[PCL], and [Common]), and into two partitions on B820n ([PCL] and 
[Common]).

Memo  • [PS] (B840dn only)
  This is a PostScript mode form storage area.

 • [PCL]
  This is a PCL mode form storage area.

 • [Common]
  This is an area that stores jobs registered to Encrypted Authen-

ticated Print, Authenticated Print, Save to Printer and errors.

Note! • If you initialize an SD memory card, the following contents will 
be deleted. 
Please carefully check whether it is ok to initialize the card.
	 Data registered in Encrypted Authenticated Print, Authenti-

cated Print, Save to Printer 
	Registered forms

	 Error Logs

Memo  • You can also format just a particular partition.
• If a printer has already been added in print control server, it is 

necessary to delete all print control server related information 
from the printer SD memory card in print control server prior 
to initializing the SD memory card. In order to do this, finish 
log acquisition, and delete the printer in print control server.

SD memory card initialization can also be carried out on the Oki 
Storage Device Manager (Windows).

Initializing an SD memory card��

Set [PRINT STATISTICS]−[USAGE REPORT] on the aggregation ①①
result menu to [DISABLE].

�Setup Instructions, Chapter 2: Basic Operation - List of the ��
PRINT STATISTICS

Turn off the power to the printer.②②
�Setup Instructions, Chapter 1: Setting Up - Turning Off the Printer��

Hold the ③③  ENTER button down on the printer control panel 

in order to turn the power on.

Note! • Press and hold the  ENTER button.

When [ADMIN MENU] is displayed in the control panel, release ④④
the  ENTER button.

Press the ⑤⑤  ENTER button and [ENTER PASSWORD] will be 

displayed.  Press the  or  button several times to dis-

play the first digit of the password, and press the  ENTER 

button. 

Use the same procedure to enter characters 6 - 12 of the 
password.

 Memo • The default password is "aaaaaa".

Press the ⑥⑥ or  button several times, select [FILE SYS 

MAINTE2], and press the  ENTER button. 

Initializing an S
D

 m
em

ory card (optional)
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Press the ⑦⑦ or the  button several times, select [INITIAL 

LOCK], and press the  ENTER button.

Press the⑧⑧  or the  button several times, select [NO], 

and press the  ENTER button. 

Press the⑨⑨   Back button, and [FILE SYS MAINTE2] will be 

displayed.

Press the ⑩⑩  button once, select [FILE SYS MAINTE1], and 

press the  ENTER button.

[SD INITIALIZE] will be displayed, and press the ⑪⑪  ENTER 

button.

[ARE YOU SURE? YES/NO] will be displayed. Pres the ⑫⑫  button 

several times and select [YES], then press the  ENTER button.

[EXECUTE NOW? YES/NO] will be displayed. Press the ⑬⑬  but-

ton several times, and select [YES], then press the  ENTER 

button.

    Start initialization of the SD memory card. The printer will au-
tomatically restart. 
Initialization will be complete when [ONLINE] is displayed in 
the control panel.

�� Formatting a particular partition

Set [PRINT STATISTICS]−[USAGE REPORT] on the aggregation ①①
result menu to [DISABLE].

�Setup Instructions, Chapter 2: Basic Operation - List of the ��
PRINT STATISTICS

Turn off the power to the printer.②②
�Setup Instructions, Chapter 1: Setting Up - Turning Off the ��
Printer

Hold the ③③  ENTER button down on the printer control panel 
in order to turn the power on.

Note! • Press and hold the  ENTER button.

When [ADMIN MENU] is displayed in the control panel, release ④④
the  ENTER button. 

Press the ⑤⑤  ENTER button and [ENTER PASSWORD] will be 

displayed. Press the  or  button several times to display 

the first digit of the password, and press the  ENTER button. 

Use the same procedure to enter characters 6 - 12 of the 
password.

 Memo • The default password is "aaaaaa".

Press the ⑥⑥ or  button several times, select [FILE SYS 

MAINTE2], and press the  ENTER button. 

Press the ⑦⑦ or the button several times, select [INITIAL 

LOCK], and press the  ENTER button.

Initializing an S
D

 m
em

ory card (optional)
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Press the⑧⑧  or the  button several times, select [NO], 

and press the  ENTER button. 

Press the ⑨⑨  Back button, and [FILE SYS MAINTE2] will be displayed.

Press the ⑩⑩  button once, select [FILE SYS MAINTE1], and 

press the  ENTER button.

Press the ⑪⑪  button once, select [SD FORMATING], and 

press the  ENTER button.

Press the ⑫⑫  button several times, select the partition you 

want to format (PCL/COMMON/PS (B840dn only)), and press 

the  ENTER button.

[ARE YOU SURE? YES⑬⑬ /NO] will be displayed. Pres the  button 

several times and select [YES], then press the  ENTER button.

[⑭⑭ EXECUTE NOW? YES/NO] will be displayed. Press the  

button several times, then press the  ENTER button.

	 Start the partition formating. The printer will automatically restart.

	 Initialization will be complete when [ONLINE] is displayed in 
the control panel.

Initializing an S
D

 m
em

ory card (optional)
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Check the Free Space in an SD Memory Card (Optional) or Flash Memory
There are several ways to check the free space in an SD memory 
cards (optional) or flash memory.

�� For SD memory cards

• Delete Unwanted Data from an SD Memory Card 

Delete data left in the [Common] partition of an SD memory card. 
Print data specifying authenticaed print jobs and encrypted au-
thenticated print jobs is left behind in the [Common] partition.

 Print after entering a password (Secure Print)   (�� P 52)
 �Print secret or important documents (Encrypted Secure Print) ��
(P 54)

 Memo • This does not change the free space in thePS (B840dn only) 
and PC partitions.

• Change the size of SD memory card partitions

By reducing the size of partitions that you do not use, you can free 
up space in your target partition.

Note! • Changing the size of a partition will delete the following. Please 
check if it is ok to delete these.
Data registered with Encrypted Secure Print and Secure Print  
Registered forms
Error Logs

Memo • If the printer has already been added to print control server, 
prior to changing the size of the partition, it is necessary to 
delete all print control server related information. In order to 
do this, finish log acquisition, and delete the printer from print 
control server.

• �You can use the Oki Storage Device Manager (Windows) to free 
up space. 
Oki Storage Device Manager (�� P 104)

�Set [PRINT STATISTICS]−[USAGE REPORT] on the aggregation ①①
result menu to [DISABLE].

�Setup Instructions, Chapter 2: Basic Operation - List of the ��
PRINT STATISTICS

Turn off the power to the printer.②②
�Setup Instructions, Chapter 1: Setting Up - Turning Off the ��
Printer

�Hold the ③③  ENTER button down on the printer control panel 

in order to turn the power on.

Note! • Press and hold the  ENTER button.

When [ADMIN MENU] is displayed in the control panel, release ④④
the  ENTER button.

�Press the ⑤⑤  ENTER button and [ENTER PASSWORD] will be 

displayed.  Press the  or  button several times to dis-

play the first digit of the password, and press the  ENTER 

button. 

Use the same procedure to enter characters 6 - 12 of the 

password.

 Memo • The default password is "aaaaaa".

Check the Free Space in an SD Mem
ory Card (Optional) or Flash Mem

ory
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�Press the ⑥⑥ or the  button several times, select [FILE 

SYS MAINTE2], and press the  ENTER button. 

�Press the ⑦⑦ or the button several times, select [INITIAL 

LOCK], and press the  ENTER button.

�Press the⑧⑧  or the  button several times, select [NO], 

and press the  ENTER button. 

�⑨⑨ Press the  Back button, and [FILE SYS MAINTE2] will be displayed.

�Press the ⑩⑩  button once, select [FILE SYS MAINTE1], and 

press the  ENTER button.

�Press the ⑪⑪  button several times, and [PARTITION SIZE] 
will be displayed.

�⑫⑫ Press the  or the  button several times, select the partition 

which you want to change the size of, and press the  ENTER button.

�Press the ⑬⑬  or the  button several times to display the 

item you want to set, and press the  ENTER button.

 Memo • �If you change the size of the PCL partition, the size of the 
Common partition will also change. Changing the Common and 
PS partition sizes is the same.

�[ARE YOU SURE? / YES] will be displayed.  Press the ⑭⑭  

button several times and select [YES], and then press the  

ENTER button. 

The printer will restart automatically. 

Initialization will be complete when [ONLINE] is displayed in 

the control panel.

For flash memory��

• Initializing flash memory 

You can return SD cards to their initialized state. 

Note! • If you initialize a flash memory card, the following contents will 
be deleted. Please check if it is ok to delete these. 

�Set [PRINT STATISTICS]−[USAGE REPORT] on the aggregation ①①
result menu to [DISABLE].

�Setup Instructions, Chapter 2: Basic Operation - List of the ��
PRINT STATISTICS

Turn off the power to the printer.②②
�Setup Instructions, Chapter 1: Setting Up - Turning Off the ��
Printer

�Hold the ③③  ENTER button down on the printer control panel 

in order to turn the power on.

Note! • Press and hold the  ENTER button.

Check the Free Space in an SD Mem
ory Card (Optional) or Flash Mem

ory
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�When [ADMIN MENU] is displayed in the control panel, release ④④
the  ENTER button.

�Press the ⑤⑤  ENTER button and [ENTER PASSWORD] will be 

displayed.  Press the  or  button several times to display 

the first digit of the password, and press the  ENTER button. 

Use the same procedure to enter characters 6 - 12 of the pass-

word.

 Memo • The default password is "aaaaaa".

�Press the ⑥⑥ or  button several times, select [FILE SYS 

MAINTE2], and press the  ENTER button. 

�Press the ⑦⑦ or the button several times, select [INITIAL 

LOCK], and press the  ENTER button.

�Press the ⑧⑧  or  button several times, select [NO],  

and press the  ENTER button.

�Press the⑨⑨   Back button, and [FILE SYS MAINTE2] will be 

displayed.

�Press the ⑩⑩  button once, select [FILE SYS MAINTE1], and 

press the  ENTER button.

�Press the ⑪⑪  button several times, select [FLASH INITIAL-

IZE / EXECUTE], and press the  ENTER button.

�[ARE YOU SURE? / YES] will be displayed.  Press the ⑫⑫  

button several times and select [YES], and then press the  

ENTER button.

 	 Start initialization of the flash memory card. The printer will 
automatically restart.

	 Initialization will be complete when [ONLINE] is displayed in 
the control panel.

Check the Free Space in an SD Mem
ory Card (Optional) or Flash Mem

ory
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Enabling parallel interfaces
The default setting for parallel interfaces is disabled. If printing using 
a parallel interface, enable it on the control panel.

Note! • �If parallel interfaces are enabled the printer cannot go into sleep 
mode. In such a case, the power used will be higher than interna-
tional ENERGY STAR Program standards.

�Press the ①①  or  button several times. The [PARALLEL 

MENU] will be displayed, and press the  ENTER button.

�Press the ②②  or  button several times. [PARALLEL] will be dis-

played, and press the  ENTER button.

�Press the ③③  or the  button, and [ENABLE] will be dis-

played.

�Press the ④④  ENTER button, and a [*] will appear on the right 

side of the set value. 

�Press the ⑤⑤  Online button, and [ONLINE] will be displayed.

Turn the printer power OFF (⑥⑥ ) /ON ( l ).

�Setup Instructions, Chapter 1: Setting Up - Turning Off the ��
Printer

Enabling parallel interfaces
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Change parallel interface forwarding mode 
You can change it if the computer and forwarding mode are aligned. 

Disable Bi - Directional Centro��

�Press the ①①  or  button several times. The [PARALLEL 

MENU] will be displayed, and press the  ENTER button.

�Press the ②②  or  button several times. The [PARALLEL/

ENABLE] will be displayed, and press the  ENTER button.

�Press the ③③  or the  button several times, and [DIS-

ABLE] will be displayed.

�Press the ④④  ENTER button, and a [*] will appear on the 

right side of the set value. 

�Press the ⑤⑤  Online button, and [ONLINE] will be displayed.

�Turn the printer power ⑥⑥ OFF ( ) /ON ( l ).

�Setup Instructions, Chapter 1: Setting Up - Turning Off the ��
Printer

Disable ECP ��

�Press the ①①  or  button several times. The [PARALLEL 

MENU] will be displayed, and press the  ENTER button.

�Press the ②②  or  button several times. [ECP/ENABLE] 

will be displayed, and press the  ENTER button.

�Press the ③③  or the  button several times, and [DIS-

ABLE] will be displayed.

�Press the ④④  ENTER button, and a [*] will appear on the 

right side of the set value. 

�Press the ⑤⑤  Online button, and [ONLINE] will be displayed.

Turn the printer power OFF (⑥⑥ ) /ON ( l ).
�Setup Instructions, Chapter 1: Setting Up - Turning Off the ��
Printer

C
hange parallel interface forw

arding m
ode
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Explanation of Utilities
We explain here utilities that make the Windows environment you 
are using more convenient.

Utility Name Function Model 
supported

Storage 
location

Reference 
page

Configuration Tool You can check the printer 
network settings and status. 
IP you can change the IP ad-
dress.

B840
B820

Software  
DVD - ROM

97

Oki Storage 
Device Manager 

This is a utility for configuring 
printer flash memory settings, 
and registering and deleting 
form data.

B840
B820

Software 
DVD - ROM 

104

PS Gamma 
Adjuster

You can adjuster the printer 
half - tone density and the 
print density of photos.

B840 Software 
DVD - ROM

109

Web browser You can configure the printer 
menu or network settings re-
motely on the web screen.

B840
B820 121

OKI LPR Utility You can print, manage print 
jobs, and check the printer 
status through a network con-
nection.

B840
B820

Software 
DVD - ROM

165

Network Exten-
sion

You can check setting items 
from the printer driver and set 
the composition of printer op-
tions.

B840
B820

Software 
DVD - ROM

173

Network Card 
Setup

You can check the printer 
network settings and status. 
IP you can change the IP ad-
dress.

B840
B820

Software 
DVD - ROM

176

Utility Name Function Model 
supported

Storage 
location

Reference 
page

TELNET You can use TELNET to set 
printer network settings.

B840
B820 184

PrintSuperVision This is a web - based applica-
tion which manages printers 
connected to the network. You 
can use this to check setting 
information and information 
on consumables for multiple 
printers.

B840
B820

You can 
download this 
from the Oki 
Data web-
page.

Web Driver
Installer

This is a web application that 
is installed on the client com-
puter, and which can be used 
to view printers connected to 
the network and download 
printer driver installed mod-
ules.

B840
B820

You can 
download this 
from the Oki 
Data web-
page.

Print Job 
Accounting

Different restrictions on printing 
can be set depending on the 
print jobs from computer by 
users, and print information 
can be captured as records.

B840
B820

You can 
download this 
from the Oki 
Data web-
page. 

Print Job 
Accounting Client

To use Print Control Server to 
recognize users, Job Account 
ID can be configured on the 
printer driver.

B840
B820

You can 
download this 
from the Oki 
Data web-
page. 
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Configuration Tool
Configuration Tool is a utility that can be used to display printer 
information, change printer settings, and manage printers.

�� Operating environment

Windows 8.1/Windows 8/Windows Server 2012/Windows Server 
2012 R2/Windows 7/Windows Vista/Windows Server 2008/ 
Windows Server 2008 R2/Windows XP/Windows Server 2003 and 
with Internet Explorer 6.0 or higher installed

Note! • For setup, computer administrator rights are required.
• �You may not be able to use a part of the functions, depending 

on your user settings. In such a case, log in as the computer 
administrator. 

How to install��

①①Set the Software DVD - ROM in the drive.

Click [Optional Software] - [Configuration Tool].②②
Select the plugin to install.③③

 Memo • Network Setting Plugin
Configure IP settings or reset the printer and display the 
webpage.

• Install and add on the Plug - in menu.
• You can install additional plugins later.

Set the folder you wish to save to.④④
Click on [Install].⑤⑤
If [Installation is completed.] is displayed, click [Close].⑥⑥
If the restart screen is displayed, follow the instructions on the 
screen to restart the computer.

Main methods of use��

• When first launching/ when first adding a printer

When using the Configuration Tool for the first time or when intro-
ducing a printer for the first time, register the printer in Configura-
tion Tool.

�Select [Start] - [All Programs] - [Okidata] - [Configuration ①①
Tool] - [Configuration Tool].

�②②Select [Register Device] in the [Tools] menu, and search for 
printers that can be registered.
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 Memo • �In order to change the range in which you are searching for 
the printer you are using, select [Environment Settings] in the 
[Tools] menu.
 Enter the range you want to search and click [OK].

Put a check in the printers you want to configure settings for ③③
or to manage, and click on [Register].

Either click on the ④④  on the upper right or click on [Cancel] to 
close the [Register Device] screen.

• Reference printer information

Click on the printer from [Registered Device Table] for which ①①
you want to see information.

The printer status and printer information are displayed.②②
 Memo • �If you want to update information, click on [Update Device 

Information].
�The device status is displayed if the printer is connected to a ••
network.

• Network Setting Menu
This is displayed if the Network Setting Plugin is displayed. You 
can set the IP address for the printer you are using, enable/dis-
able device settings (Web), and set the website display settings.

①①Click [Network Setting] within [Plug-ins] in the menu. 
The Network Setting main screen is displayed.
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You can start searching for printers on the network with [Dis-③③
cover Devices].

 Memo • If at the time of searching on Windows 7/Windows Vista/
Windows Server 2008/Windows Server 2008 R2/Windows XP/
Windows Server 2003 there is a message displayed saying 
[Windows Security Alert], click [Allow access].

Printers connected to the network are found, and select the ④④
printer you want to configure from the list.

• Search for the machine on the network

Click on [Environment Settings].①①

Enter the search conditions and click [OK].②②

 Memo • You can enter up to 16 IP addresses.
• �You can search for devices on the same segment by putting a 

check in [Search Local Subnets].
• �If searching for individual printers you can add the IP address 

of the printer you are searching for.
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• Configure printer network settings

Refer to the IP address or the MAC address from the list, and ①①
select the printer you would like to configure.

 Memo • The MAC address will be displayed in Network Information. 
(Setup Instructions)

• For initial configuration, the method of obtaining IP addresses 
is [DHCP/BOOTP] . If there is a DHCP/BOOTP server on the 
network, the IP address obtained from the network will be 
displayed.

Click the ②②  [Device Settings] icon.

Enter the required items and click on [OK].③③

Enter the password in [Password] and then click [OK].④④

 Memo • On the first time the password is the last 6 digits of the refer-
enced MAC Address. In this example, it is 62F8D8.

• When entering the password, [●●●●●●] will be displayed on the 
screen.

• When entering the password, please make sure that you enter 
upper and lower - case letters correctly.

Configure the details you entered in ⑤⑤ ③ on the printer, and reg-
ister them on the Configuration Tool.

• �When registration on the Configuration Tool is finished, the fol-
lowing message will be displayed.

• �If the configured printer has already been registered in Config-
uration Tool, the following message will be displayed, and just 
update Configuration Tool information.
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Click on [OK] to initiate restarting of the printer, and the ⑥⑥
configured printer status will turn  (Red) (it is normally  
(Green)).

When restarting of the printer has finished, the configured ⑦⑦
printer status will turn  (Green).

• Configure web settings

Refer to the IP address or the MAC address from the list, and ①①
select the printer you would like to configure.

 Memo • The MAC address will be displayed in Network Information. 
(Setup Instructions)

 • For initial configuration, the method of obtaining IP addresses 
is [DHCP/BOOTP] . If there is a DHCP/BOOTP server on the 
network, the IP address obtained from the network will be dis-
played.

Click the ②②  [Device Settings] icon.

Put a check in [Device Settings(Web)-Enable] and click on [OK].③③

Enter the password in [Password] and then click [OK].④④

 Memo • On the first time the password is the last 6 digits of the refer-
enced MAC Address. In this example, it is 62F8D8.

• When entering the password [●●●●●●] will be displayed on the 
screen.

• When entering the password, please make sure that you enter 
upper and lower - case letters correctly.

If you configured the settings correctly, the following screen ⑤⑤
will be displayed.
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Click on [OK] to initiate restarting of the printer, and the ⑥⑥
configured printer status will turn  (Red) (it is normally  
(Green)).

When restarting of the printer has finished, the configured ⑦⑦
printer status will turn  (Green).

• Display the webpage

You can display the webpage for the selected printer by click-①①
ing the  [Display Web Page].

• Change network password

Refer to the IP address or the MAC address from the list, and ①①
select the printer you would like to configure.

 Memo • �The MAC address will be displayed in Network Information. 
(Setup Instructions) 
�For initial configuration, the method of obtaining IP addresses ••
is [DHCP/BOOTP] . If there is a DHCP/BOOTP server on the 
network, the IP address obtained from the network will be 
displayed.

Click the ②②  [Change Password] icon.
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Enter the current password and new password and click [OK].③③

 Memo • On the first time the password is the last 6 digits of the refer-
enced MAC Address. In this example, it is 62F8D8.

• When entering the password, [●●●●●●] will be displayed on 
the screen.

• When entering the password, please make sure that you enter 
upper and lower - case letters correctly.

If you configured the settings correctly, the following screen ④④
will be displayed.

• Change the order in which printer information is displayed

By clicking on the following fields, the information will be reor-
dered based on the values in each of the fields you click: Status, 
Device Name, IP Acquisition Method, IP Address, MAC Address, 
Subnet Mask, Defaut Gateway, Network Card Setup Model Name, 
Network Card Setup Program Version, Device Web Page Enable/
Disable.
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Oki Storage Device Manager
This is a utility for configuring printer flash memory settings, and 
registering and deleting form data.

Note! • OKI Storage Device Manager is stored on the Software DVD - 
ROM.

Operating environment��

Computers running Windows 8.1/Windows 8/Windows Server 
2012/Windows Server 2012 R2/Windows 7/Windows Vista/ 
Windows Server 2008/Windows Server 2008 R2/Windows XP/ 
Windows Server 2003 
Having InternetExplorer 6.0 or higher installed

Install��

	Set the Software DVD - ROM in the drive.①①

Main methods of use��

• Launching the Utility

Select [Start] - [All Programs] - [Okidata] - [Oki Storage De-①①
vice Manager] - [Oki Storage Device Manager].

• Registering Form

Make [Ports] into [FILE:].①①
Output Print Data to File (�� P 64)

Launch the application, and create the form which you want to ②②
register on the printer.

Select [Print] from the [File] menu.③③
	 If you are using a PCL print driver, move to ⑦ .

Click on [Preferences]. ④④
Click ⑤⑤ [Overlay] in the [Job Options] tab, and select [Create 
Form].

Click [OK] twice and click [Print].⑥⑥
Enter the file save name and select the destination to save to.⑦⑦
Restore the [Ports].⑧⑧
Launch the Oki Storage Device Manager.⑨⑨
�⑩⑩Select a connected port on the [SDM - Printer Discovery] 
screen, and click [Start].

Click [Exit].⑪⑪
Select [New Project] from the [Projects] menu.⑫⑫
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�⑬⑬Select [Add File to Project] from the [Projects] menu, and se-
lect select the created form.

	 	The form file is added to the project.

Double click on the form file added to the project, enter a ⑭⑭
number of your choice into [ID], and then click [OK].

Memo • When using the Windows PS printer driver, enter [Name].

Note! • When using a PS printer driver and if an SD memory card is 
inserted, change the volume from "%disk0%" to "%flash0%". 
In other cases do not change the volume name or password.

�⑮⑮Select the lower window, and select [Send Project Files to 
Printer] from the [Projects] menu. The form file is registered 
on the printer.

On the completion screen, click on [OK].⑯⑯
Close the Oki Storage Device Manager.⑰⑰

• Check the Free Space in SD Memory Cards (Optional) or or Flash Memory

Launch the Oki Storage Device Manager.①①
Launching (�� P 104)

On the [SDM - Printer Discovery] screen, select the port con-②②
nected to the printer and click [Start].

Click [Exit].③③
Select the printer in the lower window and select [Show Re-④④
source] from the [Printers] menu.

⑤⑤In the case of using an SD memory card select [SD0] and in 
the cash of flash memory, select [FLASH0].

 Memo • If there is no SD memory card inserted, [SD0] will not be dis-
played.

Select [Details] from the [View] menu.⑥⑥
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The partition type will be displayed in the Usage filed, and the ⑦⑦
partition free space will be displayed in the Free Space field, in 
units of Bytes.

 Memo • [PS] and [MIX] are displayed separately, however they indi-
cate the same partition.

• Free up space in an SD memory card or flash drive

Launch the Oki Storage Device Manager.①①
Launching (�� P 104)

On the [SDM - Printer Discovery] screen, select the port con-②②
nected to the printer and click [Start].

Click [Exit].③③
Select the printer from the lower window. Select [Administrator ④④
Functions] from the [Printers] menu.

Enter the administrator password in [Enter Password].⑤⑤
 Memo • The default administrator password is "PASSWORD".

Click on [Initialise Flie System [FORMAT Volume(s)]].⑥⑥

Select the flash partition from the list, and click [Entire Flash ⑦⑦
Memory].

Click [Yes] on the initialization confirmation screen.⑧⑧
On the shutdown confirmation screen, click on [OK].⑨⑨
On the completion screen, click on [OK].⑩⑩
Turn the printer power OFF (⑪⑪ ◯ ) /ON ( l ).

Turning Off the Power (Setup Instructions)��
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• Initializing Flash Memory
Launch the Oki Storage Device Manager.①①

Launching (�� P 104)

②②On the [SDM - Printer Discovery] screen, select the port con-
nected to the printer and click [Start].

Click [Exit].③③
④④Select the printer in the lower window and select [Administrator 

Functions] from the [Printers] menu.

Enter the administrator password in [Enter Password].⑤⑤
 Memo • The default administrator password is "PASSWORD".

Click on [Initialise Flie System [FORMAT Volume(s)]].⑥⑥

�⑦⑦If initializing, click on [Entire Flash Memory]. 
If formatting a particular partition, select the partition you 
want to format from the list, and click [Format Partition].

Click [Yes] on the initialization confirmation screen.⑧⑧
On the shutdown confirmation screen, click on [Yes].⑨⑨
On the completion screen, click on [OK].⑩⑩
Turn the printer power OFF (⑪⑪ ◯ ) /ON ( l ).

Turning Off the Power (Setup Instructions)��
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• Initializing an SD memory card
Launch the Oki Storage Device Manager.①①

Launching (�� P 104)

On the [SDM - Printer Discovery] screen, select the port con-②②
nected to the printer and click [Start].

Click [Exit].③③
④④Select the printer in the lower window and select [Administrator 

Functions] from the [Printers] menu.

Enter the administrator password in [Enter Password].⑤⑤
 Memo • The default administrator password is "PASSWORD".

Click on [Initialise Flie System [FORMAT Volume(s)]].⑥⑥

If initializing, click on [Entire HDD/SD].⑦⑦
	 If formatting a particular partition, select the partition you 

want to format from the list, and click [Format Partition].

	 If you want to change the purpose of use of a partition, select 
the partition you want to format, select the partition type from 
[Volume Type] and click [Format Partition].

Click [Yes] on the initialization confirmation screen.⑧⑧
On the shutdown confirmation screen, click on [Yes].⑨⑨
On the completion screen, click on [OK].⑩⑩
Turn the printer power OFF (⑪⑪ ◯ ) /ON ( l ).

Turning Off the Power (Setup Instructions)��
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PS Gamma Adjuster
You can adjuster the printer half - tone density and the print density 
of photos.

Note! • The printing speed may be slow if halftone adjustment is used.  If 
you want to prioritize the speed, select [Not Specified ] from [Half - 
Tone Adjustment].

• Depending on the application, the Dot Gain Correction or Half 
- Tone Adjustment may be set at the time of printing, or those 
functions may be included in the EPS file. If using this kind of 
function on the application side, select [Not Specified] in [Half 
- Tone Adjustment].

Operating environment��

Computers running Windows 8.1/Windows 8/Windows 7/Windows 
Vista/Windows XP/Windows Server 2012/Windows Server 2012 R2/
Windows Server 2008/Windows Server 2008 R2/Windows Server 
2003

Note! • For setup, computer administrator rights are required.

Install��

Turn the printer power ON ( ①① l ).

Check that Windows is launching and set the Software DVD - ②②
ROM in the drive.

	 	The setup program will launch.

Select [OKI B840], and click [Next].③③

Read the [Software License Agreement], and click [I Agree].④④
Click [Optional Software].⑤⑤

Click [PS Gamma Adjuster].⑥⑥
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Click [Next].⑦⑦
Check the destination to install to and click [Next].⑧⑧
Check the program folder name and click [Next].⑨⑨
Click [Finish].⑩⑩

Main methods of use��

• Launching the Utility

Select [Start] - [All Programs] - [Okidata] - [PS Gamma  ①①
Adjuster].

• Adjuster the printing density of photographs

Launch the PS Gamma Adjuster.①①
Select the machine from [Select Printer].②②

 Memo •	Depending on the application (such as Adobe PageMaker), 
there may be an independently prepared PPD file used at the 
time of printing. In such a case, click [Select PPD for Applica-
tion], click [Browse] and select the PPD file used by the appli-
cation.

Click on③③  [New].

Adjuster the half - tone with any of the following methods, enter ④④
the name into [Gamma Curve Name], and then click [OK].

 Memo • Directly carry out operations to graph lines.
You can drag and click on lines.Perform an adjustment by 
moving the control point.

Enter the gamma value.••
Enter the gamma value and click on [Gamma Setting]. A 
smooth curve is automatically created with 13 points and 
half - tones are adjusted. You can set a value between 0.01 
and 99.99. Values greater than 1.0 are weaker half - tones, 
smaller values are stronger.

Enter values into each density textbox.••

Click [Add⑤⑤ ]. 
The half - tone adjustment name is displayed in [Printer’s 
Gamma Curve:] within [Printer].

 Memo • The model name will be displayed in the [Select Printer] list. 
If there are multiple printers of the same type in the [Printers 
and Faxes] folder, the registered [Gamma Curve Name] will be 
enabled for all printers of the same model.
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Click on [Apply].⑥⑥
 Memo • A maximum of 6 [Printer’s Gamma Curves:] can be registered 

in one PPD file.

Click on [OK] on the PPD registration completion screen.⑦⑦
Click on [Exit] to close the PS Gamma Adjuster.⑧⑧

Note! • After registering the [Gamma Curve Name], the [Custom Gamma 
Adjustment] menu or its contents may not be displayed within 
the [Paper/ Quality] tab. In this case, restart your computer.

• Before printing, restart applications that were launched prior to 
having registered a [Gamma Curve Name].

Open the file you want to print.⑨⑨
Select [Print] on the [File] menu.⑩⑩
�⑪⑪Click on [Preferences]. 

Select the [Custom Gamma Adjustment] check box in the [Job ⑫⑫
Options].

Select the [Gamma Curve Name] created in ⑬⑬  from within [Cus-
tom Gamma Adjustment], and then print.
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Deleting Utilities
• If you are using Windows 7/Windows Vista/Windows Server 2008

Select [Start] - [Control Panel], and click on [Uninstall a pro-①①
gram].

Select the utility to delete and click on [Uninstall].②②
If [User Account Controls] is displayed, click [Continue].③③
Delete them on the screen.④④

• If you are using Windows XP/Windows Server 2003

Select [Start] - [Control Panel], and click on [Add or Remove ①①
Programs].

Select the utility you want to remove and click [Remove].②②
Delete them by following the screen.③③
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Explanation of Utilities
We explain here utilities that make the Macintosh environment you 
are using more convenient.

Utility Name Function
Model

supported
Operating 

environment
Storage 
location 

Reference
 page

Web browser You can configure the 
printer network settings 
and menu settings.

B840
B820

Mac OS X

121

PS Gamma 
Adjuster

You can adjuster the 
printer half - tone density 
and the print density of 
photos.

B840 Mac OS X Software  
DVD-ROM

115

Network Card 
Setup

You can configure printer 
network settings or display 
the web browser.

B840
B820

Mac OS X Software 
DVD-ROM 181

TELNET You can use TELNET to set 
printer network settings.

B840
B820

Mac OS X
184

Print Job 
Accounting 
Client

Set user name and user 
ID on printer driver.

B840 Mac OS X Software 
DVD-ROM

Explanation of U
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PS Gamma Adjuster
You can adjuster the printer half - tone density and the print density 
of photos.

Note! • The printing speed may be slow if halftone adjustment is used. If 
you want to prioritize the speed, select [None] from [Adjuster Half-
tone].

• Depending on the application, the Dot Gain Correction or Half 
- Tone Adjustment may be set at the time of printing, or those 
functions may be included in the EPS file. If using this kind 
of function on the application side, select [None] in [Adjuster 
Halftone].

Operating environment��

Running of the Mac OS X 10.6.8  10.9 of Macintosh

Main methods of use��

• Adjuster the printing density of photographs

Set the Software DVD - ROM in the drive.①①
Click on the [Utility] - [Halftone] - [②② PS Gamma Adjuster] tab.

Click on [③③ New].

Adjuster the half - tone with any of the following methods, enter ④④
the name into [Gamma Curve Name], and then click [Save].

Memo • Directly carry out operations to graph lines.
You can drag and click on lines. Perform an adjustment by 
moving the control point.

• Enter the gamma value.
Enter the gamma value and click on [Gamma Setting]. A 
smooth curve is automatically created with 13 points and 
half - tones are adjusted. You can set a value between 0.01 
and 99.99. Values greater than 1.0 are weaker half - tones, 
smaller values are stronger.

• Enter values into each density textbox.

Confirm that the PPD file with the half - tone adjustment regis-⑤⑤
tered is selected.

	 	If a different PPD file is selected, click [Select PPD], and select 
the target PPD file.

Click [Add⑥⑥ ]. 
The new half - tone adjustment name is displayed in the regis-
tration list on the right.
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Click on [Save]. If the Authentication screen is displayed, enter ⑦⑦
the username and password of the administrator.

	 	Register the Half - Tone Adjustment name displayed in the 
registered list, into the PPD file.

Exit the PS Gamma Adjuster utility.⑧⑧
Delete and reregister the printer on which to carry out the half ⑨⑨
- tone adjustment registered in [Printer Setting Utility].

Memo 	• Do not click the [Configure] button when adding a printer. 

	 • If a dialogue to select printer options appears when adding a	
	 printer, click [Cancel], and re-add the printer. 

Open the file you want to print.⑩⑩
Select [Print] from the [File] menu.⑪⑪
Select the [Gamma Curve Name], created in procedure ⑫⑫ ③ from 
[Custom gamma] in the [Job Option] function set within the 
[Printer Features] panel.
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Note! •	 In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X.

•	 The screen or procedure may vary depending on the applicaiton you use.

•	 Please refer to Online Help for detailed explainations of each setting item for printer drivers and utilities.

•	 The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.

Initializing Network Settings…………………………………………………………118
Using SNMP……………………………………………………………………………………118
Using IPv6… …………………………………………………………………………………119
Web browser (Common to Windows/ Macintosh)… ……………………121
OKI LPR Utility (only for Windows)………………………………………………165
Network Extension (only for Windows) ………………………………………173
Network Card Setup (only for Windows) ……………………………………176
Network Card Setup (only for Macintosh) … ………………………………181
TELNET (Common to Windows/ Mac OS X) … ……………………………184
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Initializing Network Settings
Changes all network setting items to initial values.

Check that [Online] is displayed on the control panel.①①

�Press the ②②  or  button several times. [Network Menu] 

will be displayed, and press the  ENTER button.

�Press the③③  or  button several times. [Default Settings/ 

Enable] will be displayed, and press the  ENTER button.

Using SNMP
The SNMP agent is available. You can refer to/ change the printer set 
value with a commercially-available SNMP manager.
The setting items that can be referred to/ changed with an SNMP 
manager are called MIB, and B820n/B840dn support MIB-II as 
well as Oki Data Private MIB. Regarding the Oki Data Private MIB, 
please refer to "Readme-j.txt" within the [MISC]-[Mib] folder on the 
Software DVD-ROM.
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Using IPv6
Protocol Application Conditions of Use

FTP Windows 7
Windows Vista
Windows XP
Command 
prompt FTP 

(1) �For hosts file editing, or accessing through 
the DNS server, you can set the host name.

(2) �However, if setting by only enabling IPv6 
through Telnet, you will not be able to set 
a host name through using a DNS server.

(3) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

Mac OS X
FTP from a 
terminal 

(1) �For hosts file editing, or accessing through 
the DNS server, you can set the host name.

(2) �However, if setting by only enabling IPv6 
through Telnet, you will not be able to set 
a host name through using a DNS server.

(3) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

HTTP Windows XP
Internet Exploler 
6.0

(1) �For hosts file editing, or accessing through 
the DNS server, you can set the host name.

(2) �However, if setting by only enabling IPv6 
through Telnet, you will not be able to set 
a host name through using a DNS server.

(3) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

Windows 7
Windows Vista
Windows XP
Mozilla Firefox
(Ver.2.0)

(1) �IPv6 addresses need to be entered within “[]”.
(2) �For hosts file editing, or accessing through 

the DNS server, you can set the host 
name.

(3) �However, if setting by only enabling IPv6 
through Telnet, you will not be able to set 
a host name through using a DNS server.

(4) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

The IPv6 function is available. 
The IPv6 adress is automatically acquired, and it is not required to 
set it manually.
The following protocols are supported with IPv6.

Printing: LPD, Port9100, IPP, FTP

Setting: HTTP, Telnet, SNMPv1/v3

Sending SMTP, IP filtering, WINS registration, and SNMP Trap, etc. 
only support IPv4.
The applications that have been changed to work normally are as 
shown in the following table.

Note! • If using IPv6 with Windows XP, IPv6 will need to be installed 
separately.

Protocol Application Conditions of Use

LPD Windows 7
Windows Vista
Windows XP
Command 
Prompt LPR 

(1) �For hosts file editing, or accessing through 
the DNS server, you can set the host name.

(2) �However, if setting by only enabling IPv6 
through Telnet, you will not be able to set 
a host name through using a DNS server.

(3) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

Port9100 Windows 7
Windows Vista
Redhat Linux 9.0
LPRng

(1) �For hosts file editing, or accessing through 
the DNS server, you can set the host name.

(2) �However, if setting by only enabling IPv6 
through Telnet, you will not be able to set 
a host name through using a DNS server.

(3) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

U
sing IPv6
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Protocol Application Conditions of Use

HTTP Mac OS X
Safari 
(1.2.3-v125.9)

(1) �For hosts file editing, or accessing through 
the DNS server, you can set the host name.

(2) �However, if setting by only enabling IPv6 
through Telnet, you will not be able to set 
a host name through using a DNS server.

(3) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

Mac OS X
Safari 
(2.0-v412.2)

(1) �IPv6 addresses need to be entered within “[]”.
(2) �For hosts file editing, or accessing through 

the DNS server, you can set the host name.
(3) �However, if setting by only enabling IPv6 

through Telnet, you will not be able to set 
a host name through using a DNS server.

(4) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

Telnet Windows 7
Windows Vista
Windows XP
Command 
Protocol Telnet

(1) �For hosts file editing, or accessing through 
the DNS server, you can set the host name.

(2) �However, if setting by only enabling IPv6 
through Telnet, you will not be able to set 
a host name through using a DNS server.

(3) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

Mac OS X
Telnet from a 
Terminal

(1) �For hosts file editing, or accessing through 
the DNS server, you can set the host name.

(2) �However, if setting by only enabling IPv6 
through Telnet, you will not be able to set 
a host name through using a DNS server.

(3) �Also, you cannot specify the host name for 
connections specified with the link local 
address (addresses starting with "fe80").

U
sing IPv6
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Web browser (Common to Windows/ Macintosh)

You can configure the printer network settings and menu settings.

 Operating environment

For those using Windows

Computers with Microsoft Internet Explorer Ver6.0 or higher, or 
FireFox Ver3.0 or higher installed computer.
A computer operating with TCP/IP

Memo • Check whether your browser settings are as shown below.
Set [Internet Options] - [Privacy] - [Settings] within the [Tools] ••
menu to [Medium].

For those using a Mac OS X

Computers with Safari Ver2.0 or higher, or FireFox Ver3.0 or 
higher installed Computer
A computer operating with TCP/IP

 Main methods of use 

This explaination uses the following environment as an example.
Printer	 : B840dn
Printer IP address : 192.168.0.2
MAC address	: 00:80:87:62:CA:B3
Web browser	: Microsoft Internet Explorer Ver.6.0

Memo • You can display your MAC address by launching your web 
browser and clicking [Print Information].

Launch/ Check print status••

Launch a web browser.①①
�Enter "http://(printer's IP address)" in the address bar and ②②
press the Enter key.

Note! • �If the IP address includes a 1- or 2-digit number value, please 
enter "0" at the front of the number value. It may be not 
possible to carry out communication. 
(E.g.) Correctly-entered value: http://192.168.0.2/ 
         Incorrectly-entered value: http://192.168.000.002/

	  Display the printer status.
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Log in as the administrator••

Launch a web browser.①①
Launching (P 121)

Click [Administrator Login].②②

�Enter [root] into [User] and enter [The Current Password] into ③③
[Password], and click [OK].

Memo • The default password is "aaaaaa".

�Configure the printer information that can be checked on the ④④
network, and click [OK] or [SKIP].

Memo • �If you click [SKIP], the configuration of settings is shorter. 
Put a check into [Do not show this page again.], and click [OK] 
or [SKIP], to not display it from next time.

The following screen will be displayed.⑤⑤
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Changing the Password••

You can change the password used at the time of logging in as the 
administrator.

Log in as the administrator.①①
   Logging in as the Administrator (P 122)

Click the [Security] tab.②②

Click [Change Admin Password].③③

�Enter a new password into [New Admin Password], and reenter ④④
it into [Verity Admin Password].

Note! • When entering the password [●●●●●●] will be displayed on the 
screen.
Enter 6-12 alphanumeric characters for the password.••
When entering the password, please make sure that you enter ••
upper and lower-case letters correctly.

Click on [Submit].⑤⑤

�The values set in the printer are saved and the network ⑥⑥
function is restarted. 
The new password will be enabled from the next time you 
change settings. You do not need to turn the printer power OFF 
( )/ON (  ).

Note!  • �This password will differ to TELNET and [Network Setting] for 
Configuration Tool.
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Changing Printer Settings••

Log in as the administrator.①①
       Logging in as the Administrator (P 122)

Click the [Printer] tab.②②

�Click on the items you want to change. ③③
The item details are displayed in the right frame. Click on the 
item you want to change.

�Click on [Submit] when you have finished changing the ④④
settings.

•• Encrypting communication (SSL/TLS)

This encrypts settings configured through a website and 
communication between the computer (client) and the printer at 
the time of IPP printing (encryption of communicaiton through 
HTTPS).

Method of Configuration
 The encryption setting tools are as shown below.
	 1) Website
	 2) �Only TELNET (Stength of encryption (weak/ standard/ 

strong) and turning SSL/TLS (Encryption) ON/OFF 
(enabling/ disabling) can be changed).

The configuration process	
If using the web, the procedure for creating a certificate with 
the printer is displayed.
The following two types of certificates can be created.

1) Self-signed certificate
2) Certificate signed by a certification authority (create CSR)

Note! • �If the printer's IP address is changed from the time of creating 
the certificate, the certificate will be invalidated. Please do not 
change the printer's IP address after creating the certificate.
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Procedure for creating the certificate

Log in as the administrator.①①
       Logging in as the Administra  tor (P 122)

Click the [Security] tab.②②

Click on [SSL/TLS].③③

Set [SSL/TLS] in [STEP 1] to [Enable].④④

Memo • �Please set the encryption strength to [Standard] in normal 
situations. If you want to change the strength of the 
encryption, click on [Clpher Level Setting] and change the [SSL/
TLS] value.
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�Enter items such as Common Name and Organization In normal ⑤⑤
situations, please use the Key Exchange Method and Key Size 
as the are initially, without changing them (RSA, 1024bit). If 
you want to change it, lick [Change these settings].

Memo • �If you selected [Using a Certificate which a Certification 
Authority signed], please follow the certification procedure 
of the certification authority for the method of issuing the 
certificate for the input details, etc.

Click [OK].⑥⑥

�⑦⑦The input details will be displayed.  Check the details and click [OK]. 
Creates a certificate.

With this the creation of a self-signed certificate is completed.

For a certificate issued by a certificating authority, you need to 
then follow the procedure below.

�Remove the CSR and send to the certificating authority. ⑧⑧
Copy the contents of the text box from "----- BEGIN 
CERTIFICATE REQUEST -----" to "----- END CERTIFICATE 
REQUEST -----". The CSR may use the following methods to 
send it include: pasting onto a website, sendnig as a file, or 
attaching to a email file.
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Click on [OK].⑨⑨

�Use the web to install the certificate issued by the certificating ⑩⑩
authority.

�Follow 1-4 to display the encryption (SSL/TLS) setting screen. ⑪⑪
Paste from "----- BEGIN CERTIFICATE -----" to "----- END 
CERTIFICATE -----" into the textbox, and click [Send]. 
With this the creation of the certification authority issued 
certificate is completed.

Methods of Use
�Launch a web browser and enter "https://Printer IP Address" in ①①
the address bar, to connect.

Printing (IPP Print)••

Environment
	  Usable OS 	 Windows 8.1, Windows Server 2012 R2,
 			   Windows 8, Windows Server 2012, 
			   Windows 7, Windows Server 2008,
			   Windows Server 2008 R2, 
			   Windows Vista, Windows XP,
			   Windows Server 2003 

①①Turn the computer power ON and launch Windows.

Launch your web browser and log in as the administrator.②②
	 Set the [IPP] network tab to [Enable].

       Logging in as the Administrator (P 122)
Add a printer.③③
<For Windows 8.1/Windows Server 2012 R2>
Select [Control Panel] - [Hardware and Sound] - [Devices and 
Printers].
<For Windows 8/Windows Server 2012>
Select [Control Panel] - [Hardware and Sound] - [Devices and 
Printers].
<For Windows 7 /Windows Server 2008 R2>
Select [Start] - [Devices and Printers]. Click [Add a Printer].
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<For Windows Vista /Windows Server 2008>
Click [Start]-[Control Panel]-[Printer]. Click [Install Printer].
<For Windows XP>
Select [Start] - [Control Panel], and click on [Printers and Other 
Hardware].
Click [Printers and Faxes] in [or pick a Control Panel icon].
Click [Printer Tasks] - [Install a Printer].
<For Windows Server 2003>
Click [Start] - [Printers & Faxes].
Double click on [Add a Printer].

Click on [Next] on the [Printer Addition Wizard] screen.④④
�Select [Add a Network, Wireless or Bluetooth Printer], and click ⑤⑤
on [Next].

Click on [⑥⑥  The printer that i want isn't listed].

�Select [Select a shared printer by name], enter [http://⑦⑦
Printer's IP Address/ipp] or [http://Printer's IP Address/ipp/lp], 
and click on [Next].

Click [Have Disk].⑧⑧
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Set the Software DVD-ROM in the drive.⑨⑨
�Enter the following into [Source to Copy Manufacturer Source ⑩⑩
File] and click [OK].

If installing a PS printer driver.

D:\Drivers\ENU\PS

If installing a PCL printer driver.

D:\Drivers\ENU\PCL

Memo • �If printing from a PostScript-compatible application (such as 
Adobe Illustrator), select a PS driver.
If printing from another application, you can select either.••

Select the printer name and click [Next].⑪⑪

Click on [Next].⑫⑫

�If setting the printer that you normally use, put a check in it ⑬⑬
and click [Finish].

�Select the printer icon and right-click on [Printer Properties] to ⑭⑭
open it.
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•• Encrypting communication (IPSec)

You can encrypt communication between the computer and printer 
and prevent tampering on the network layer leve.

Memo •	 The IKE protocol supported by this printer is [IKEv1].
•	 The communication mode supported for this printer is 

[Transport Mode]. [Tunnel Mode] does not work.
•	 If IPSec is enabled, the response of the equipment may be 

slow depending on the network communication status.
•	 If IPSec is enabled, it is recommended to not run multiple 

operations such as network printing from multiple computers.

Method of Configuration

Configure the settings for the computer after configuring the 
printer.

Device settings

Displays the procedure for enabling IPSec by using the web.

Log in as the administrator.①①
       Logging in as the Administrator (P 122)

Click on [Print Test Page].⑮⑮

If the Menu map was printed, setup is complete.

Open the file you want to print.⑯⑯

�Select [File] – [Print], set the created IPP printer and print.⑰⑰
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Click the [Security] tab.②②

Click the [IPSec] tab.③③

Enable [IPSec] in [STEP1].④④

Note! •	 If you set IPSec to [Enable], access will not be possible from 
any computer other than that with the IP address set in [Step 
2].
	If IPSec setting fails due to reasons such as the set value ••
not matching the cmoputer, you will not be able to open the 
website. In such a case, disable IPSec by disabling the [IPSec] 
wetwork setting item on the control pannel, or by initializing 
the network.
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Enter the host IP address in [STEP2].⑤⑤

Note! • Using the IP address, set a host for which printing/setting 
configurations is permitted.
	Please use half-byte numerical characters separated by "." for ••
the IPv4 address.
	Please use half-byte numerical characters separated by ":" for ••
the IPv6 address.
IPv6 link local addresses are not supported.••
	If you enter 0.0.0.0 for the IP address, it will be disabled.••

�Set each Phase1 Proposal in [STEP3]. ⑥⑥
Select from between 3DES-CBC and DES-CBC in [IKE 
Encryption Algorithm] to set it. 
Select from between SHA-1 and MD5 in [IKE Hash Algorithm]. 
Select between Group2 and Group1in [Diffie-Hellman Group]. 
Enter between 600 (Secs) - 86400 (Secs) in [LifeTime] to set it.
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�Set the pre-shared key in [STEP4]. ⑦⑦
Enter between 1 and a maximum of 64 half-sized assets in 
[Pre-Shared Key]. Here we use the example of entering [ipsec] 
in the character string.

�Set the Key PFS in [STEP5]. ⑧⑧
Select between KEYPFS and NOPFS in [Key PFS] to set it.

If you select [Key PFS], set the following items.

Select between Group2 and Group1 for [Key PFS Diffie-Hellman 
Group] to set it.
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Set Phase 2 Proposal in [STEP6].⑨⑨
Select between Enable and Disable for [ESP] to set it.

Set the following items if [ESP] is set to enabled.

Select from between 3DES-CBC and DES-CBC in [ESP Encryption 
Algorithm] to set it.

Select from between SHA-1, MD5, and OFF in [ESP Authentication 
Algorithm]. If you select OFF, the ESP authentication algorithm will 
not be applied.

Select between Enable and Disable for [AH] to set it.

Set the following items if [AH] is set to enabled.

Select from between SHA-1 and MD5 in [AH Authentication 
Algorithm].

Enter between 600 (Secs) - 86400 (Secs) in [Life Time] to set 
it.

Note! •	  Set either or both of [ESP] and [AH] to enabled.

Click [Submit].⑩⑩

�The values set in the printer are saved and the network ⑪⑪
function is restarted.

Computer settings••

The following explaination uses Windows 7 as an example.

Click on [Administrative Tools] in [Control Panel].①①
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Double-click on [Local Security Policy].②②

Click on [IP Security Policies on Local Computer].③③

Select [Create IP Security Policy] from the [Action] menu.④④

Click on [Next].⑤⑤

�Enter the name as well as the explaination of this IP security ⑥⑥
policy created in [Description], and then click [Next].

�Remove the check from [Activate the default response rule], ⑦⑦
and click on [Next].

Select [Edit Properties] and then click [Finish].⑧⑧
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Click the [General] tab.⑨⑨

Click [Settings].⑩⑩

�Enter the same time as for the lifetime of Phase1 Proposal ⑪⑪
in [Equipment Settings],  (P 134), in units of minutes in 
[Authenticate and generate a new key after every:] (units of 
minutes).

Memo •	 [Life time] in Phase1 Proposal is in units of seconds, but here 
units are in minutes.

Click [Methods].⑫⑫

Click [Add].⑬⑬

�Add details to Phase1 Proposal in [Securty method preference ⑭⑭
order], and click [OK].
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�On the [Key Exchange Security Methods] screen, click [OK].⑮⑮
Memo •	You can delete the security methods other than those you 

added.

�On the [Key Exchange Settings] screen, click [OK].⑯⑯

�On the [New IP Security Policy Properties] screen click the ⑰⑰
[Rules] tab.

�Click [Add].⑱⑱

�Click on [Next].⑲⑲

�Check that [This rule does not specify a tunnel] is selected on ⑳⑳
the [tunnel endpoint] screen, and click [Next].
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㉑	 �Check that [All network connections] is selected on the [Select 
the network type] screen, and click [Next].

㉒	 �Click on [Add].

㉓	 �Click on [Add].

㉔	 �Click on [Next].

㉕	 �Enter the IP folder name or explaination, and click [Next].

�	 �Select [Source address], and click [Next].
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㉗	 �Click [Next].

㉘	 �Click [Next].

㉙	 �Click [Finish].

㉚	 �Click [OK].

㉛	 �Select the created IP filter, and click [Next].

㉜	 �Click [Add].
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㉝	 �Click on [Next].

㉞	 �Click on [Next].

㉟	 �Click on [Next].

㊱	 �Click on [Next].

㊲	 �Select [Custom] on the [IP Traffic Security] screen and click 
[Settings].

㊳	 �Match the [Equipment Settings]details set in . (P 134) 
Phase2 Proposal and click [OK].
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㊴	 �Click on [Next].

㊵	 �Remove the check from [Edit Properties], and click on [Finish].

㊶	 �If Key PFS is enabled, remove the check from [Use session key 
perfect forward secrecy (PFS)], and click [OK].

Note! •	 You must put a check in [Accept unsecured communication, 
but always respond using IPsec], if you perform IPSec 
communication using the IPv6 global address.

㊷	 �Select the created filter, and click [Next].

㊸	 �Select [Use this string to protect the key exchange(preshared 
key)], enter the character string, and then click [Next].

㊹	 �Click [Finish].
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㊺	 �Click [OK] on the [New IP Security Policy Properties] screen.

㊻	 �Select the created new IP security policy, and select [Assign] 
from the [Action] menu.

㊼	 �Check that the created new IP security policy's [Policy 
Assigned] is set to [Yes].

㊽	 �Click on  on the top right of the screen, and close the screen.

•• Use restricted access function (IP filter)

Use an IP address to manage printer access.
Memo •	 In the initial printer settings, [IP filter] is set to [Disable].

Note! •	 If there is a mistake in entering the IP address, it will not 
be possible to access printers using IP protocol. Please pay 
sufficient attention to this.

Method of Configuration

Log in as the administrator.①①
   Logging in as the Administrator (P 122)

Click the [Security] tab.②②
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Click on [IP Filtering].③③

In [STEP1], set [IP Filtering] to [Enable].④④

Note! •	 If IP filtering is set to [Enable], all access from hosts with IP 
addresses outside the range set in [STEP2] will not be possible.

Set the IP address in [STEP2].⑤⑤
Note! •	 If you enter 0.0.0.0 for the IP address, it will be disabled.

Memo •	 Using the IP address, enter a range of hosts for which printing/
setting configurations is permitted.
	Please use half-byte numerical characters separated by "." for ••
the IP address.
	If there are overlapping IP address ranges, the adress range ••
set to have a high [Priority Level] will be prioritized.
	Regardless of that set in step 2, administrator addresses for ••
which printing/configuring of settings is possible are set in 
Step 3.

Click the [Address Range Bar Display/Refresh] button.⑥⑥

If you want to correct the IP address range, reenter the 
relevant IP address and then click on [Address Range Bar 
Display/Refresh].
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�Set the value in [Administrator's IP Address setting] in [STEP 3].⑦⑦

	 	By entering the administrator's IP address in [Administrator's 
IP Address setting], in the unlikely case that incorrect settings 
were entered in [STEP2], the administrator can reset them 
from the host with the IP address set in [Administrator's IP 
Address setting].

Note! •	 If accessing the printer through a proxy, etc., the address of the 
machine through which the connection is made will be displayed 
as [Your Current Local Host/Proxy IP Address ]. Therefore, 
your host address may differ from the address shown in [Your 
Current Local Host/Proxy IP Address].
	 If nothing is registered for [Administrator's IP Address ••
setting], based on Step 2, it will be completely impossible to 
access the printer.
	If you do not want to access the administrator IP address, ••
leave the [Administrator's IP Address setting] field blank.

Click [Submit].⑧⑧

�The values set in the printer are saved and the network function ⑨⑨
is restarted.

W
eb brow

ser (C
om

m
on to W

indow
s/ M

acintosh)



145

8

Control access with the MAC address••

Use an MAC address to manage printer access.

Note! •	 If there is a mistake with the MAC address, it will be impossible 
to access the printer using the network. Please sufficient care 
with this.

Method of Configuration

Log in as the administrator.①①
   Logging in as the Administrator (P 122)

Click [Security] tab.②②

③③Click on [MAC Address Filtering].

In [STEP1], set [Select MAC Address Filtering Settings] to [Enable].④④
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�Select whether to [Accept (Deny)] communication from the ⑤⑤
MAC address specified in [STEP2].

Memo •	 Using the MAC address, enter a host MAC address for which 
communication is permitted (rejected).
	Please use half-byte numerical characters separated by ":" for ••
the MAC address.
	Regardless of that set in STEP2, administrator addresses for ••
which communication is possible are set in STEP3.

Set the value in [Administrator's MAC Address setting] in [STEP3].⑥⑥

	 By entering the administrator's MAC address in [Administrator's 
MAC Address setting], in the unlikely case that incorrect 
settings were entered in [STEP2], the administrator can 
reset them from the host with the MAC address set in 
[Administrator's MAC Address setting].

Note! •	 If accessing the printer through a proxy, etc., [Your Current 
Local Host / Proxy MAC Address] will appear as the machine 
through which the MAC address. Therefore, your host address 
may differ from the address shown in [Your Current Local Host 
/ Proxy MAC Address].
	 If nothing is registered for [Administrator's MAC Address ••
setting], based on Step 2, it will be completely impossible to 
access the printer.
If you do not want to access the administrator MAC address, ••
enter 00:00:00:00:00:00 in the [Administrator's MAC Address 
setting] field.
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Click [Submit].⑦⑦

�The values set in the printer are saved and the network function is ⑧⑧
restarted.

•• Use the mail sending funtion (SMTP)

The mail sending funtion (SMTP) is available. You can have a mail 
sent when errors occur with the printer. You can select setting to 
have regular messages sent saying whether errors are occuring, 
or to have a mail sent at the time when an error occurs.

Setting emails to be sent

Log in as the administrator.①①
   Logging in as the Administrator (P 122)
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Click on [Email]-[Send Settings].③③

In [STEP1], set [SMTP Send] to [Enable].④④

Set the address required to send to in [STEP2].⑤⑤
	 (1) Set the email server domain name or IP address [SMTP Server].

	 (2) �Set the email address given to the printer in [Printer Email 
Address].

	 (3) �Set the email address used for sending emails from the 
printer in [Reply-To-Address]. 
In normal situations, please set the printer administrator 
email address.

Note! •	 If [SMTP Server] is set to the domain name, the DNS server 
must be set within [TCP/IP] settings.
	Sending of mails from the printer must be permitted on ••
the mail server. For mail server settings, please consult the 
network administrator.

�After this, if you want to configure more detailed settings, click ⑥⑥
[Set detail of the SMTP Protocol] in [STEP3]. 
If you will not configure these settings, please proceedure to .
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Click [SMTP Security Settings].⑦⑦

Set [SMTP-Auth] to [Enable].⑧⑧
Enter [SMTP Server UserID].⑨⑨
Enter [SMTP Server Password].⑩⑩

Note! •	 If there is a mistake in [SMTP Server UserID] and [SMTP 
Server Password] the mail sending function will not work 
properly. Please pay attention to this.

Click on [OK].⑪⑪
Click on [Configure attached information].⑫⑫

�Select or enter the information you would like to add to the end ⑬⑬
of messages sent by Email.

Click on [OK].⑭⑭
Click on [Others].⑮⑮

�Set the reply email address for emails sent from the printer in ⑯⑯
[Reply-To Address]. In normal situations, please set the printer 
administrator email address.

�Click on [OK].⑰⑰
�Click [Submit].⑱⑱
�The values set in the printer are saved and the network function ⑲⑲
is restarted.

The method for authentication will be automatically selected from 
authentication methods supported by the mail server.

Faults occuring will be regularly reported

Click on [Email] - [Alert Settings].①①
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Enter the destination email address for fault notifications.②②

Click the [Setting] button for the set email address.③③

Memo •	 By clicking the [Copy] button you can copy the fault 
notification conditions to another addressee. This is useful 
when setting the same kind of fault notification settings for 
multiple addressees.

Put a check in [Periodically] and click on [To STEP2].④④

�You can send the interval between sending of emails in [Setting ⑤⑤
Email Alert Interval].

Memo •	 If no fault occured in the period for the target notification, no 
email will be sent.

�Put a check in the fault type in [Setting Events Used for Sending ⑥⑥
E-mall Alerts] for the notification target.
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Click on [OK].⑦⑦
Check the details of the set fault notification conditions.⑧⑧

	 (1) If you want to display a list

	 		 a. �Click the [View a Summary of Current Configuration] 
button.

	 		 b. Check the details of the settings and close the window.

	 (2) If you want to compare two addressee setting conditions

	 		 a. �Select each addressee you want to compare in the list box.
	 		 b. Check the set details displayed.
	 	Click in the set conditions comparison table and change the 

notification conditions.

Click [Submit].⑨⑨
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�The values set in the printer are saved and the network function ⑩⑩
is restarted.

Notify when faults occur
Click [Email] - [Alert Settings].	①①

Enter the fault notification destination email address.②②

Click the [Setting] button for the set email address.③③
	 �By clicking the [Copy] button you can copy the fault 

notification conditions to another addressee. This is useful 
when setting the same kind of fault notification settings for 
multiple addressees.

�Put a check in [Upon occurrence of an event] and click on [To ④④
STEP2].

�Put a check in the fault type in [Setting upon occurrence of an ⑤⑤
event] for the notification target.
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Set a delay from when an error occurs to when an email is sent.⑥⑥

Memo •	 Depending on the delay time set, you can have only errors 
continually occuring over a long time notified.
	If you set the delay time to [0 Hours 0 Minutes], an email will ••
be sent as soon as an error occurs.

Click on [OK].⑦⑦
Check the details of the set fault notification conditions.⑧⑧

	 (1) If you want to display a list

	 		 a. �Click the [View a Summary of Current Configuration] 
button.

	 		 b. Check the details of the settings and close the window.

	 (2) If you want to compare two addressee setting conditions

	 		 a. �Select each addressee you want to compare in the list 
box.

	 		 b. Check the set details displayed.

	 You can change the notification conditions by clicking in the set 
conditions comparison table.
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•• Using SNMPv3

The SNMPv3 agent is available.
You can encrypt printer management with SNMP and carry it out 
safely by using an SNMP manager that supports SNMPv3.

Configuring SNMPv3

Log in as the administrator.①①
   Logging in as the Administrator (P 122)

Click [Network].②②

Click on [SNMP] - [Settings].③③

Click [Submit].⑨⑨

�The values set in the printer are saved and the network ⑩⑩
function is restarted.
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�Put a check in the SNMP version you are using in [STEP1]. ④④
Click [To STEP2].

Memo •	 If you selected [SNMPv3] it will not be possible to refer to/ set 
SNMPv1. If you selected [SNMPv3+v1], you can refer to both 
SNMPv1 and SNMPv3, however, you can only configure setting 
for SNMPv3.

Enter the SNMPv3 username into [User Name] in [STEP2].⑤⑤

�Enter the passphrase for authentication use in [Passphrase] ⑥⑥
within [Authentication Settings].

Select [Algorithm].⑦⑦

�Enter the passphrase for encryption use in [Passphrase] within ⑧⑧
[Privacy (Encription) Settings].

Memo •	 You can only select [DES] for the encryption algorythm.
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Click [Submit].⑨⑨

�The values set in the printer are saved and the network ⑩⑩
function is restarted.

Memo •	 Set context name of the SNMP manager you are using to 
[v3context].

•• Using IEEE802.1X

The authentication function using IEEE802.1X is supported.

Note! •	 You may not be able to use this correctly depending on the 
network environment you are using.

The IEEE802.1X setup process

At first, use a connection for setup through the hub normally used 
by the printer and computer. Thereafter, connect ther printer to 
the authenitication switch.
1. Connect the printer and the computer.

2. Set the IP address for setup use on the computer.

3. �Set the IP address for setup use on the printer. 
For the connection between the printer and computer and the 
method of setting the printer IP address, please refer to the 
Setup Instructions.

4. Set IEEE802.1X on the printer.

5. Connect the printer to the authentication switch (P 160).

The following explaination uses the environment shown below as 
an example.
Printer	 :B840dn
IP Address	 :192.168.0.3 (The address used for computer setup) 
		  :192.168.0.2 (the address used for printer setup)
Subnet mask	: 255.255.255.0
Web browser	:Microsoft Internet Explorer Ver.6.0

Configuration for IEEE802.1X

Log in as the administrator.①①
   Logging in as the Administrator (P 122)
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Click [Network].②②

Click the [IEEE802.1X] menu.③③

If Using PEAP

Memo •	 If using EAP-TLS, please proceed to P 158.

Select [Enable] for [IEEE802.1X].④④

Select [PEAP] for [EAP Type].⑤⑤

Enter a user name in [EAP User].⑥⑥
Enter a password in [EAP Password].⑦⑦
Put a check in [Authenticate Server].⑧⑧
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Click [Import of CA Certificate].⑨⑨
 Memo •	 If [Not authenticate Server] is checked, it is not necessary to 

import a CA certificate.
	If [Not authenticate Server] is checked, you will not be ••
able to check whether there is a correct connection to the 
authentication server.

	 The "Import of CA Certificate" screen will be displayed.

Enter the file name of the CA certificate and then click [OK].⑩⑩
Memo •	 The imported CA authentication certificate is an authentification 

certificate of the RADIUS server server authentication 
certificate issuing authority.
The file formats that can be imported are PEM, DER, and PKCS#7.••

	 The CA authentication certificate is imported to the printer.

Click [Submit].⑪⑪
�The values set in the printer are saved and the network ⑫⑫
function is restarted.

If [ONLINE] is displayed in the operating panel, turn the 
printer power off.

   Setup Instructions (Turning Off the Printer)

�Proceed to Connecting to the Printer Authentication Switch (⑬⑬ P 160).

If Using EAP-TLS

Select [Enable] for [IEEE802.1X].④④
Select [EAPTLS] for [EAP Type].⑤⑤

Enter a user name in [EAP User].⑥⑥
�Put a check in [Not use SSl/TLS Cartificate for EAP ⑦⑦
authentication].

Note! •	 Normally, please do not put a check in [Use SSL/TLS Certificate 
for EAP authentication].
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Click [Import of Client Certificate].⑧⑧

The "Import of Client Certificate" screen will be displayed.

Enter the file name of the client authentication certificate.⑨⑨
Memo •	 Authentication certificate files that can be imported are in the 

PKCS#12 format.

�Enter the password of the client authentication certificate and ⑩⑩
then click [OK].

	 The client authentication certificate is imported to the printer.

�Put a check in [Authenticate Server].⑪⑪

�Click [Import of CA Certificate].⑫⑫
If [Not authenticate Server] is checked, it is not necessary to 
import a CA certificate.

Memo •	 If [Not authenticate Server] is checked, you will not be 
able to check whether there is a correct connection to the 
authentication server.

	 The Import of CA Certificate screen will be displayed.

�Enter the file name of the CA certificate and then click [OK].⑬⑬

Memo •	 The imported CA authentication certificate is an authentification 
certificate of the RADIUS server server authentication 
certificate issuing authority.
	The file formats that can be imported are PEM, DER, and ••
PKCS#7.

	 The CA authentication certificate is imported to the printer.
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Click [Submit].⑭⑭

�The values set in the printer are saved and the network ⑮⑮
function is restarted.

If [ONLINE] is displayed in the operating panel, turn the 
printer power off.

   Setup Instructions (Turning Off the Printer)

�Proceed to Connecting to the Printer Authentication Switch.⑯⑯

Connecting Your Printer to Authentication Switch

Make sure that the printer is turned off.①①
Plug the Ethernet cable into the printer network interface ②②
connector.

Plug the Ethernet cable into the authentication port of the ③③
authentication switch.

Turn the printer power ON ( | ).④④
Check that [ONLINE] is displayed on the control panel.⑤⑤
Set the printer IP address, etc., as per the environment you ⑥⑥
are using. Set Item List

 List of Setting Items

Status Tab••

Item Description

Printer Status You can check the printer status. Other than the 
same information as displayed on the operating 
panel, all warnings and erros occuring on the 
printer as Fault Information are displayed.
Also, each network service operation status and 
printer information list and IP addresses set on the 
printer can be checked.
You can click on [Status Window] to check the 
printer status in the web browser.

Printer Information You can check printer system information.

Network 
Information 

You can check network setting information.
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Printer Tab••

This will be displayed if you are logged in as the printer administrator.

Item Description

General printer 
settings

You can set the information for printers that can be 
checked on the network.

Print Menu You can set the number of copies, automatic tray 
switching, print quality, and print position. If using 
a printer driver, the settings in the printer driver 
will have priority over the settings configured here.

Media Menu You can set the paper size for each tray and 
custom paper, etc. If using a printer driver, the 
settings in the printer driver will have priority over 
the settings configured here.

Printer Config Menu You can configure settings for when moving into 
powersave, operations at the time of the alarm 
going off, during time-out, etc.

Emulation You can set teh supported emulation.

Interface You can set interfaces outside of the network.

Memory Menu You can set the buffer size, etc., for received email.

Time Setup You can set the time on the printer.

System Setup You can set the LED control method at the time 
when the near-life warning occurs.

Save/Restore You can save current menu settings, or change 
saved menu settings.
This targets the printer tab menu settings.

Hex Dump All received print data is displayed in hexadecimals. 
This mode is exited when the printer is restarted.

Item Description

Information Print Print network setting information (Network 
Information), demo pages, etc.

Network Tab••

This will be displayed if you are logged in as the printer 
administrator.

Item Description

General Network 
Settings

You can stop network protocols that you are not 
using.

TCP/IP You can set information related to TCP/IP.

NetWare NYou can set information related to NetWare.

EtherTalk You can set information related to EtherTalk.

NBT/NetBEUI You can set information related to NetBEUI.

Email You can configure settings for a function for email 
notification of events occuring on the printer.

SNMP You can set information related to SNMP.

IPP You can configure settings for the IPP print 
function.

SNTP You can set the time on the printer.

IEEE802.1X You can set information related to IEEE802.1X/EAP.

(Printer Tab Continued)
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Job List Tab••

Item Description

Settings Display a list of print jobs sent to the printer. If 
there are unnecesary jobs, you can delete them.

Print Tab••

Item Description

Web Printing You can set any PDF file you want and print it.

Email Printing If a PDF file is attached to an email sent to the 
printer, it can be printed.

Security Tab••

This will be displayed if you are logged in as the printer 
administrator.

Item Description

Protocol ON/OFF You can stop network protocols and network 
services that you are not using.

Panel Lockout Set the control panel so that operating it is 
prohibited.

IP Filtering You can restrict access with TCP/IP. Access 
from outside the company is also supported. 
However, sufficient knowledge regarding 
IP addresses is required for this function. 
Depending on the settings, serious problems 
could occur, such as not being able to access 
the printer from the network.

MAC Address 
Filtering

You can restrict access based on MAC 
addresses. Access from outside the company 
is also supported. However, sufficient 
knowledge regarding MAC addresses is 
required for this function. Depending on the 
settings, serious problems could occur, such 
as not being able to access the printer from 
the network.
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Item Description

SSL/TLS You can encrypt configuration of settings 
from the webpage as well as communication 
between the computer (client) and printer at 
the time of IPP printing.

IPSec You can configure settings to encrypt 
communication between the computer (client) 
and printer and prevent tampering.

Change Admin 
Password

You can change the administrator password. 
The default password is "aaaaaa".

Change Network 
Password

Change the [Network Setting] administrator 
password for TELNET and Configuration 
Tool.The default password is the last 6 
alphanumerical digits of the MAC address.

(Security Tab Continued) Maintenance Tab••

This will be displayed if you are logged in as the printer administrator.

Item Description

Reset / 
Restore

Reset Printer Restart the printer. As the network 
function is also restarted at the same 
time, the website will not be displayed 
until restarting is complete, even if 
you access from a web browser.

Reset 
Network Card

Restart the network function only. 
If accessing the printer through 
the network, this connection will 
be broken. The website will not be 
displayed until restarting is completed, 
even if accessed from a web browser.

Restore 
Printer to 
Factory 
Defaults

Initialize the printer. If you initialize 
the printer, you will be able to operate 
the printer, however, you will loose 
manually-set information.

Restore 
Network Card 
to Factory 
Defaults

Initialize the network. If you initialize the 
printer, you will be able to operate the 
printer, however, you will loose manually-
set information. Also, as the IP address 
will return to its initial condition, it may 
not be possible to display the website.
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Item Description

Network Scale Setting Settings used to further improve 
efficiency of operations on the 
network. If using a hub with a 
spanning tree function, effects are 
produced if one computer is connected 
to one printer with a cross cable.

Time Settings You can set the time on the printer.

Link Tab••

Item Description

Links Links set by the manufacturer or by the administrator 
are displayed.

Edit Links The administrator can freely set the URL. 5 support 
links and 5 other links can be set. Enter the URL so 
that it includes http://.

(Maintenance Tab Continued)
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OKI LPR Utility (only for Windows)

You can print, manage print jobs, and check the printer status 
through a network connection. 

 Operating environment

Computers running Windows 8.1/Windows 8/Windows 7/Windows 
Vista/Windows XP/Windows Server 2012 R2/Windows Server 2012/
Windows Server 2008/Windows Server 2008 R2/Windows Server 
2003
A computer operating with TCP/IP.

Note! 	• The OKI LPR Utility cannot be used for shared printers. To connect 
with a network and then print, use a Standard TCP/IP port. 
For setup, computer administrator rights are required.••
	The printing method function cannot be used.••

The following explanation uses Windows 7 Ultimate Edition as an 
example.

 Install

Turn the printer power ON ( l ).①①
�Check that the computer is launching and set the Software  ②②
DVD - ROM that comes with the printer in the drive. 

The setup program will launch.
Select the printer you are using, and click on [Next].③③

Read the [Software License Agreement], and click on [I Agree].④④
Click on [Optional Software].⑤⑤

Click on [LPR Utility].⑥⑥

�If launching an OKI LPR Utility that has already been installed, ⑦⑦
the completion screen will come up, so click on [Yes].

The setup program will start, so click on [Next].⑧⑧
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�Check the destination to install to and spool destination, and ⑨⑨
click on [Next].

�Confirm that there is a check placed in [Register at Startup], ⑩⑩
and click on [Next].
Check the program folder name and click on [Next].⑪⑪

Click on [Finish].⑫⑫

 Main methods of use 

• Launching the Utility

�Select [Start] - [All Programs] - [Okidata] - [OKI LPR Utility] - ①①
[OKI LPR Utility]. 
The following kind of screen will be displayed. 

• Add a Printer

You can change the printing destination port to the OKI LPR port. 

Note! • You cannot set settings for already registered in OKI LPR Utility. 
If you want to change the port, select [Set Printer Again].
	You cannot add or delete printers if other users are also using ••
it by using the easy user switchover function.
	Computer administrator rights are required.••
	If you wish to add a printer in Windows 7 /Windows Vista /••
Windows Server 2008 /Windows Server 2008 R2, close the 
OKI LPR Utility once, right click on [Start] - [All Programs] - [Oki 
data] - [OKI LPR Utility] - [OKI LPR Utility], and select [Run as 
administrator] in order to launch.
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Select [Add Printer] from the [Remote Print] menu. ①①

�Enter the printer name in [Printer Name] and the printer IP ad-②②
dress in [IP Address], and click on [OK].

Memo •	 It will only be displayed if the printer driver in [Printers and 
Faxes] folder has been added in [Printer Name]. If a network 
printer is set it will not be displayed.
	You can search for Oki Data printers on the network by clicking ••
on [Discover].

• Check the Status of the Printer

Select a printer.①①
Select [Printer Status] from the [Remote Print] menu.②②

The status of the machine is displayed.

Memo • You can also select [Status] in the job display dialog.

• Print Simultaneously with Multiple Printers

You can print from multiple printers with a single print command.

Note! • You must set printers from which you print simultaneously to 
be the same printer model.
Computer administrator rights are required.••

Select a printer.①①
�Select [Confirm Connections] from the [Remote Print] menu.②②

Click on [Details].③③
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�Put a check in [Print to more than one printer at a time] and ④④
click on [Options].

�Click on [Add] to set the IP address of printers to print simul-⑤⑤
taneously from.

Memo • You can also add comments to printers from which you print 
simultaneously. (P 172)

�Repeat the operation in step ⑥⑥ ⑤ for the number of printers you 
want to add. 

Memo • You can save added printer information by clicking on [Save 
list].
	You can import or delete saved printer information by clicking ••
on [Load list].

Click on [OK].⑦⑦

• Automatically Transfer Printer Data

You can have print data automatically forwarded to other printers 
when printing cannot be done due to a printer being in - use, offline, 
or out of paper.

Note! • �You cannot forward to printers made by other manufacturers. 
You must forward to the printers with the same model name. 
Computer administrator rights are required.••

Select a printer.①①
�Select [Confirm Connections] from the [Remote Print] menu.②②
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Click on [Details].③③

�Put a check in [④④ Automatic Job Redirect Used]. 
If you want to only forward if an error occurs, such as if the 
printer is [Offline] or [Out of Paper], put a check in [Redirect 
only at the time of an error].
Click on [Add].⑤⑤

Set the IP address of the forwarding destination. ⑥⑥

Memo • You can search for Oki Data printers on the network by clicking 
on [Discover].

�Repeat the operation in step ⑦⑦  to  for the number of candi-
date forwarding destinations. 

Memo • To change the order of priority of forwarding destinations, se-
lect the printer for which you want to change the priority from 
[IP addresses of printers to which job is automatically redi-
rected], and click the vertical [ ] or [ ] button. (Click the [ ] to 
raise the level of priority, and click the [ ] button to lower the 
level of priority).

Click on [OK].⑧⑧
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• Manually Transfer Printer Data

You can have print data manually forwarded to other printers reg-
istered on the OKI LPR Utility when printing cannot be done due to 
a printer being in - use, offline, or out of paper.

Note! • You cannot forward to printers made by other manufacturers.
	Please forward to the printers with the same model name. ••

Select a printer.①①
Select [Job Status] from the [Remote Print] menu.②②

�Select the print job you want to transfer and select the for-③③
warding destination printer in [Redirect] within the [Job] menu.

	 The job will be sent to the destination printer.

• Download the file to the  printer

You can download the file to the printer and print it.

Select a printer.①①

Select [Download] from the [Remote Print] menu.②②

Select the file to download and click on [Open].③③

	 Start the file download. 

• Launch a web browser

You can launch a web browser, set the printer network and config-
ure menu settings from the OKI LPR Utility.

☞☞    Web browser (P 121) 

Select a printer.①①
Select [Web Setting] from the [Remote Print] menu.②②
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Memo • If the web port number has been changed, change the OKI LPR 
Utility port number settings using the following procedure.
 ① Select a printer.
 ② �Select [Confirm Connections] from the [Remote Print] 

menu.

 ③ Click on [Details].

 ④ Enter the web port number into [Port Numbers].

 ⑤ Click on [OK].

• Delete Print Data

Select a printer.①①
Select [Job Status] from the [Remote Print] menu.②②

�Select the print job you want to delete and select [Delete Job] ③③
within the [Job] menu.

• Automatically Configuring the IP Address

If the IP address of a printer connected to the DHCP server chang-
es when turning on the power to it, you can automatically search 
for the changed IP address and reconfigure it.

Note! • The search target is as per the OKI LPR Utility search range. 
Computer administrator rights are required.••

Select [Setup] from the [Option] menu.①①
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Put a check in [Auto Reconnect]. ②②

Click on [OK].③③

• Change printer settings (add comments.) 

You can add a comment to a printer you have added to the OKI 
LPR Utility. 
This is useful for entering items such as the printer installation 
location and the printer optional equipment.

Select a printer.①①
�Select [Confirm Connections] from the [Remote Print] menu.②②

Enter a comment in [Comment] and then click on [OK].③③

Select [Show comments] from the [Option] menu.④④
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Network Extension (only for Windows) 

You can check setting items from the printer driver and easily set the 
composition of printer options.

 Operating environment

Computers running Windows 8.1/Windows 8/Windows 7/Windows 
Vista/Windows XP/Windows Server 2012/Windows Server 2012 
R2/Windows Server 2008/Windows Server 2008 R2/Windows 
Server 2003
A computer operating with TCP/IP

Note! • The printer driver must been installed in order to carry out 
operations related to the printer driver.
	If you install a printer driver with a TCP/IP network connection, ••
Network Extension will be automatically installed.
	Connection to the printer driver is only carried out in the fol-••
lowing situations.
	 OKI LPR Port
	 Standard TCP/IP Port

	If the operating environment does not match, the [Option] tab ••
will not be displayed, even if Network Extension is installed.
For setup, computer administrator rights are required.••

 Install

Here Windows 7 Ultimate Edition is used as an example.

Turn the printer power ON ( l ).①①
�Check that Windows is launching and set the Software DVD - ②②
ROM, that comes with the printer, in the drive.  
The setup program will launch.

Memo • If [Run Automatically] is displayed, click [Run setup.exe].
	If [User Account Restrictions] is displayed, click [Yes] (in  ••
Windows Vista/Windows Server 2008, this is [Continue] ).

Select the printer you are using, and click on [Next].③③

Read the [Software License Agreement], and click [I Agree].④④
Click [Optional Software].⑤⑤

Click [Network Extension].⑥⑥
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Click [Next].⑦⑦
Click [Finish].⑧⑧

 Main methods of use 

• Check Printer Settings

You can check the details of the connected printer settings.

�For Windows 7/Windows Server 2008 R2, select [Start] - [De-①①
vices and Printers].

For Windows Vista/Windows Server 2008, select [Start] - [Con-
trol Panel], and then click on [Printers].

For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

For Windows Server 2003, select [Start] - [Printers & Faxes].
�With your mouse, right click on the printer driver for which you ②②
want to check the settings, and select [Printer Properties] or 
[Properties].
Click the [Status] tab.③③

Click [Update].④④

 (The Windows PCL printer driver screen) 

	 The details of the printer settings are displayed in [Device Set-
tings].

Click on [OK].⑤⑤

• Set Options Automatically

You can get the composition of options of the connected printer 
and automatically configure the printer driver settings.

�For Windows 7/Windows Server 2008 R2, select [Start] - [De-①①
vices and Printers].

For Windows Vista/Windows Server 2008, select [Start] - [Con-
trol Panel], and then click on [Printers].

For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

For Windows Server 2003, select [Start] - [Printers & Faxes].
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�With your mouse, right click on the printer driver icon for which ②②
you want to configure the settings, and select [Printer Proper-
ties] or [Properties].
�Click the [Device Options] tab (for B840PS drivers, this is [De-③③
vice Settings] ).
�Click on [Get Printer Settings]. (For B840 PS drivers, click on ④④
[Get Printer Information] and then click on [Setup].) 

 (The Windows PCL driver screen) 

Click on [OK].⑤⑤

• Launch a web browser

�For Windows 7/Windows Server 2008 R2, select [Start] - [De-①①
vices and Printers].

For Windows Vista/Windows Server 2008, select [Start] - [Con-
trol Panel], and then click on [Printers].

For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

For Windows Server 2003, select [Start] - [Printers & Faxes].

�With your mouse, right click on the printer driver for which you ②②
want to check the settings, and select [Printer Properties] or 
[Properties].
Click the [Status] tab.③③
Click on [Web Setting]. Launch a web browser. ④④

☞☞    Web browser (P 121)

 (The Windows PCL driver screen) 
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Network Card Setup (only for Windows) 

You can configure printer network settings or display the web brows-
er.

 Operating environment

Windows 8.1/Windows 8/Windows Server 2012/Windows Server 
2012 R2/Windows 7/Windows Vista/Windows Server 2008/Win-
dows Server 2008 R2/Windows XP/Windows Server 2003
A computer operating with TCP/IP

Note! • For Windows 7/Windows Vista/Windows Server 2008/Windows 
Server 2008 R2/Windows XP/Windows Server 2003  
administrator rights are required for setup.

Here Windows XP Home Edition is used as an example. 

 Main methods of use 

• Launching the Utility

Turn the printer power ON ( l ).①①
�Check that Windows is launching and set the Software DVD - ②②
ROM in the drive. 

The setup program will launch.

Select the printer you are using, and click on [Next].③③
Read the [Software License Agreement], and click [I Agree].④④

⑤⑤Click on [Device Configuration] and click on [Network Card Setup].

Launch Network card setup.

Memo • If at the time of launching the NIC Setting Tool on Windows 7/
Windows Vista/Windows Server 2008/Windows Server 2008 
R2/Windows XP/Windows Server 2003 there is a message dis-
played saying [Windows Security Alert], click [Allow access].

• Configure printer network settings

NIC Settings Tool will launch.①①

�Refer to the IP address or the MAC address from the list, and ②②
select the printer you would like to configure.

Memo • The MAC address will be displayed in Network Information. 
(Setup Instructions) 
For initial configuration, the method of obtaining IP addresses ••
is [DHCP/BOOTP]. If there is a DHCP/BOOTP server on the 
network, the IP address obtained from the network will be dis-
played.

Select [Setting Printer] from the [Setting] menu.③③
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Enter the required items and click on [OK].④④

�Enter the password in [Admin Password Required] and then ⑤⑤
click [OK].

Note! • On the first time the password is the last 6 digits of the refer-
enced MAC Address. In this example, it is 62F8D8.
	When entering the password, [******] will be displayed on ••
the screen. 
	When entering the password, please make sure that you enter ••
upper and lower - case letters correctly.

�If [Setup Completed] is displayed, click [OK]. Printer restarting ⑥⑥
will commence. 

�When restarting the printer has finished, the set printer status ⑦⑦
will turn  (Green).

Close Network card setup.⑧⑧

• Display the website

Launch Network card setup.①①
☞☞    Launching (P 176) 

�Refer to the IP address or the MAC address from the list, and ②②
select the printer you would like to configure.

Note! • The MAC address will be displayed in Network Information. 
(Setup Instructions) 
For initial configuration, the method of obtaining IP addresses ••
is [DHCP/BOOTP]. If there is a DHCP/BOOTP server on the 
network, the IP address obtained from the network will be dis-
played.

Select [Setting Printer] from the [Setting] menu.③③

N
etw

ork C
ard S

etup (only for W
indow

s)



178

Chapter 8  Regarding Networks

8

�Select [Printer Web Page - Enable] in the [Printer Web Page] ④④
tab, and click on [OK].

�Enter the password in [Admin Password Required] and then ⑤⑤
click [OK].

Memo • On the first time the password is the last 6 digits of the refer-
enced MAC Address. In this example, it is 62F8D8.
	When entering the password, [******] will be displayed on ••
the screen. 
	When entering the password, please make sure that you enter ••
upper and lower - case letters correctly.

�If [Setup Completed] is displayed, click [OK]. Printer restarting ⑥⑥
will commence. 

�When restarting the printer has finished, the set printer status ⑦⑦
will turn  (Green).

Select [View Web Page] from the [Setting] menu.⑧⑧

The website will be displayed.

• Change the network password

Launch Network card setup.①①
☞☞    Launching (P 176) 

�Refer to the IP address or the MAC address from the list, and ②②
select the printer you would like to configure.

Memo • If the webpage is displayed, the MAC address is displayed in 
[Printer Information]. (P 195) 
For initial configuration, the method of obtaining IP addresses ••
is [DHCP/BOOTP]. If there is a DHCP/BOOTP server on the 
network, the IP address obtained from the network will be dis-
played.
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Select [Change Password] from the [Setting] menu.③③

Enter the current password and new password and click [OK].④④

Memo • On the first time the password is the last 6 digits of the refer-
enced MAC Address. In this example, it is 62F8D8.
	When entering the password, [******] will be displayed on ••
the screen. 
	When entering the password, please make sure that you enter ••
upper and lower - case letters correctly.

If the [Setting Complete] screen is displayed, click [OK].⑤⑤

• Setting the Environment

Launch Network card setup.①①
☞☞    Launching (P 176) 

Select [Environment Settings] from the [Option] menu.②②

[Printer Discovery] tab

You can set the search conditions for the printer you are looking 
for.
You can search for printers on the same segment by enabling 
[Search Local Subnets].
If searching for individual printers you can add the IP address of 
the printer you are searching for. N
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[Time Out] Tab

You can set the amount of time until timeout.

[Display Item] tab

You can set the items displayed in a list.
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Network Card Setup (only for Macintosh) 

• Configure the IP Address

Memo • �For initial configuration, the method of obtaining IP addresses 
is [DHCP/BOOTP]. If there is a DHCP/BOOTP server on the 
network, the IP address obtained from the network will be dis-
played.

Launch Network Card Setup.①①
Select [IP Address Settings] from the [Operations] menu.②②
Enter the required items and click on [Save].③③

Enter the password in [Password] and then click [OK].④④
Memo • �In the default settings, the password is the last 6 digits of the 

MAC address.
The MAC address will be displayed in Network Information. ••
(Setup Instructions) 

You can configure network settings or view the web browser.

 Operating environment

Mac OS X 10.6.8 - 10.9

 Main methods of use 

• Launching the Utility

Set the Software DVD - ROM in the computer.①①
�Click on [Network Card Setup] in [Utility] - [Network Card ②②
Setup] folder.

• Search for a Printer

Launch Network Card Setup.①①

�Select [Search Devices] from the [Operations] menu. ②②
The printer information is displayed in a list.

Memo • If you want to change the search conditions, please refer to Set 
Printer Search Conditions.  (P 183) 
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�If [Settings updated successfully.] is displayed, click [OK].⑤⑤ ①
Restart the printer.

• Display the website

Launch Network Card Setup.①①
☞☞    Launching (P 181) 

Select [Web Settings] from the [Operations] menu.②②
Check [Device web settings will be enabled] and click on [Save].③③

Enter the password in [Password] and then click [OK].④④
Memo • In the default settings, the password is the last 6 digits of the 

MAC address.
The MAC address will be displayed in Network Information. ••
(Setup Instructions) 

�If [Settings updated successfully.] is displayed, click [OK]. The ⑤⑤
printer will launch.

�If the printer starts up, select the printer which you want to ⑥⑥
change the settings for from the printers displayed in Network 
Card Setup, and select [Show Device Webpage] in the [Opera-
tions] menu. The printer website will be displayed.

• Changing the Password

You can change the password used to configure the printer settings.

Memo • In the default settings, the password is the last 6 digits of the 
MAC address.
If the webpage is displayed, the MAC address is displayed in ••
[Printer Information]. (P 177) 

Launch Network Card Setup.①①
☞☞    Launching (P 181) 

�Select the printer you want to change the settings for and se-②②
lect [Change Password] on the [Operations] menu.
Enter the current password.③③
Enter a new password.④④
For confirmation purposes, reenter the new password.⑤⑤
Click [Save].⑥⑥

�If [Settings updated successfully.] is displayed, click [OK]. The ⑦⑦
printer will restart. 
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• Set the search conditions for the printer you are looking for

The settings will be saved until the next time you launch Network 
Card Setup.
If searching for individual printers you can add the IP address of 
the printer you are searching for.

Launch Network Card Setup.①①
☞☞    Launching (P 181) 

Select [Preferences...] from the [Network Card Setup] menu.②②
Click [+] and enter IP address you want to register.③③
�If you want to delete the registered IP address, select the ad-④④
dress you want to delete from the list and click [-].
�If you want to search for a printer in the same segment, put a ⑤⑤
check in [Search Local Subnets].

• Set timeout conditions

You can set the reboot monitor timeout.

Launch Network Card Setup.①①
☞☞    Launching (P 181) 

Select [Preferences...] from the [Network Card Setup] menu.②②
�Enter required items.③③
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TELNET (Common to Windows/ Mac OS X) 

Enter a login name and password.④④
Memo • The login name is [root] and the initial password value is the 

[Last 6 Digits of the MAC Address].

B840dn TELNET Server (Ver 01.00).

login: root

'root' user needs password to login.

password:

User 'root' logged in.

• Configure each type of settings

Launch TELNET.①①

 No. MENU (level.1)
 - - - - - - - - - - - - - - - - - - - - - -
  1 : Status / Information
  2 : Printer Config
  3 : Network Config
  4 : Security Config
  5 : Maintenance
 99 : Exit Setup
Please select (1 - 99) ?

�Enter the number for the item to change and press the Enter ②②
key.
Set each item. ③③
�Log out from the printer. ④④

The values set in the printer are saved and the network 
function is restarted.

You can set each network protocol for the printer.

 Main methods of use 

The following explanation uses the environment shown below as an 
example.

Windows	   : Windows XP Professional
Printer	   : B840dn
IP Address	   : 192.168.0.2
MAC Address  : 00:80:87:84:9C:9B

Memo • If you launch the web browser, the MAC address will be dis-
played in [Printer Information]. (P 121) 

• Launching the Utility

①	If you are using Windows

	 		 Start the command prompt.

If you are using Mac OS X

	 		 Start the terminal.

Check the connection using a ping command.②②
		 	 ping 192.168.0.2

Connect to the printer using telnet.③③
	 		 telnet 192.168.0.2
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Cannot print from Windows
Note! • For questions related to applications, please enquire at each appli-

cation vendor.

• Initial checks

Occurrence

 �Check the LINK 100M lamp (Green) /LINK 10M lamp (Green). ••
If connected to 100BASE - TX/10BASE - T, either will be lit. If 
it is not lit, the network is not functioning correctly.
 �Check the STATUS lamp (Orange). This flashes when data is ••
being received. If it is flashing at regularly intervals (1 or 0.1 
seconds), always flashing, or always off, the network is not 
functioning correctly.
 The hub LINK lamp is not flashing.••
 There is no response to a ping.••
 Printing was not complete, and printing was cancelled.••

• If the network connection is the cause

 Check that the printer power is ON ( l ).••
 Check that the cable is properly connected to the printer.••
 �Check that it is connected with the correct cable. There are ••
two types of cable, straight cable and cross cable. Straight 
cables are used to connect to hubs.
 �Turn the printer power ON ( l ), after connecting the cable. ••
If you turn the printer power ON ( l ) before connecting the 
cable, you may not be able to connect to the network.

• If the compatibility of the hub is the reason

�Communication may be unstable due to compatibility of the hub.
�Set the printer's [HUB LINK SETTING] to [10BASE - T HALF]. 
Please refer to the below for the method of configuring settings.

��Press the ①①  or the  button several times, and the 

[NETWORK MENU] will be displayed.

Press the ②②  ENTER button.

��Press the ③③  or the  button, and [HUB LINK SETTING/

AUTO NEGOTIATE] will be displayed.

Press the ④④  ENTER button.

�Press the ⑤⑤  or the  button several times, and the 

[10BASE - T HALF] will be displayed.

Press the ⑥⑥  ENTER button, and a [*] will appear on the 

right side of the value.

 Press the ⑦⑦  Online button, and [ONLINE] will be displayed.

Change the hub operation mode (100BASE - TX/10BASE - T, Full 
double redundancy/ Half redundancy) from Automatic Toggle  to 
10BASE - T HALF. (Please refer to the hub manual for the method 
of configuring settings.)

C
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	If this has still not solved the problem••

Windows Vista
Select [Start] - [Control Panel] - [Display Network Status and ••
Tasks] - [Network Connection Management]. Click the [Local 
Area Connection] tab, and click on [Properties] on the [Local 
Area Connection] screen. If the [User Account Controls] screen 
is displayed, click [Continue]. Check that [Internet Protocol Ver-
sion 4 (TCP/IPv4)] is displayed.
Click on [Properties] in [•• Internet Protocol Version 4 (TCP/IPv4)] 
and check that the [IP Address], [Subnet Mask, and [Default 
Gateway] are correct.
If you set the printer by IP address at the time of setting up, ••
make the first part of each octect not [0]. E.g. set it such as 
[192.169.1.2]. You cannot print correctly with it set to some-
thing like [192.169.001.002]. This is based on the Windows 
Vista specifications.
Right click on the icon of the printer you are using in the [Print-••
ers] folder, select [Properties], click on [Port Build] in the [Ports] 
tab, and check that [Printer Name or IP Address] matches the 
printer's IP address.
For small networks, configure the following settings.••

 [IP Address] 	 Windows	 192.168.0.3
		  Printer	 192.168.0.2
 [Subnet Mask] 	 Windows	 255.255.255.0
		  Printer	 255.255.255.0
 [Gateway] 	 Windows	 Do not use
 		  Printer	 0.0.0.0

Windows XP/Windows Server 2003
Select [Start] - [Control Panel] - [Networks & Internet Con-••
nections] - [Network Connections]. (For Windows Server 2003, 
select [Start] - [Control Panel] - [Network Connections]. 
	Double - click on [Local Connection], and check that [Internet 
Protocol (TCP/IP)] is displayed in [Properties].

Click on [Properties] in [Internet Protocol (TCP/IP)], and check ••
that the [IP address], [Subnet Mask], and [Default Gateway]  
are correct.
If you set the printer by IP address at the time of setting up, ••
make the first part of each octect not [0]. E.g. set it such as 
[192.169.1.2]. You cannot print correctly with it set to some-
thing like [192.169.001.002]. This is based on Windows XP/
Windows Server 2003 specifications.
Right - click on the icon of the printer you are using within the ••
[Printers & Faxes] folder, click on [Port Build] within the [Port] 
tab, and check that [Printer Name or IP Address] matches the 
printer's IP address.
On the main screen of OKI LPR Utility, select the printer you ••
are using, select [Remote Print] - [Confirm Connections], and 
check that the [IP Address] matches the printer IP address.
You can get the latest OKI LPR Utility from the Okidata website ••
(http://www.okiprintingsolutions.com/). When updating the 
OKI LPR Utility, you can delete the old version and then install 
the latest one.
Check the printer status in the OKI LPR Utility. If it goes into ••
[Pause], select the printer that has been stopped, and remove 
the check from [Remote Print] - [Pause].
For small networks, configure the following settings.••

 [IP Address] 	 Windows	 192.168.0.3
 		  Printer	 192.168.0.2
 [Subnet Mask] 	 Windows	 255.255.255.0
		  Printer	 255.255.255.0
 [Gateway] 	 Windows	 Do not use
 		  Printer	 0.0.0.0
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There is insufficient memory.
Lauch multiple applica-
tions simultaneously.

Close applications you are not us-

ing.

Printing is slow.
Print processing is car-
ried out on the print 
processing side.

Use a computer with a fast process-
ing speed.

Select [High Definition] 
in [Print Quality] or 
[Resolution].

Set the printer driver's [Print Qual-
ity] to [Normal] or [Fast].

The print data is com-
plicated.

Make the print data more simple.

Set up with a network connection. Cannot Print.
There is a problem with 
the setup or method of 
printing.

Refer to Cannot Print Through the 

Network (P 191).

Dealing with cases with other causes ●●

Cannot Print.
The printer power is OFF 
( O ).

Turn the printer power ON ( l ).

The interface is disabled. Change the [PARALLEL] or [USB] in 
the printer's menu settings to [EN-
ABLE].

The printer cable has 
come out.

Plug the printer cable in.

It goes [OFFLINE]. Press the Online button to make it 
go [ONLINE].

There is a problem with 
the printer cable.

If you have a spare cable, replace 
the other one with it.

Using a switch, buffer, 
extension cable and 
USB hub.

Connect the printer directly to the 
computer.

The printer driver out-
put port is incorrect.

Set the output port to the one to 
which the printer cable is connected 
to.

Dealing with printing 
from other interfaces.

Please wait until print processing is 
complete.

The printer driver does 
not show [Commonly - 
Used Printers].

Make it into a [Commonly - Used 
Printer].

Another bidirectional 
parallel or USB oper-
ated printer driver is 
installed.

Delete the other printer drivers.

The I - PRIME settings 
do not match the com-
puter. 

Make the [I - PRIME] in the printer 
menu  into [3 MICRO SEC] or [50 
MICRO SEC].

C
annot print from

 W
indow

s



189

9

Cannot print from Macintosh
Note! • For questions related to applications, please enquire at each appli-

cation vendor.

• Initial checks

Occurrence
Check the LINK 100M lamp (Green) /LINK 10M lamp (Green).••
If connected to 100BASE - TX/10BASE - T, either will be lit. If it ••
is not lit, the network is not functioning correctly.
Check the STATUS lamp (Orange). This flashes when data is ••
being received. If it is flashing at regularly intervals (1 or 0.1 
seconds), always flashing, or always off, the network is not 
functioning correctly.
The hub LINK lamp is not flashing.••
There is no response to a ping.••
Printing was not complete, and printing was cancelled.••

• If the network connection is the cause

Check that the printer power is ON ( l ).••
Check that the cable is properly connected to the printer.••
Check that it is connected with the correct cable. There are two ••
types of cable, straight cable and cross cable. Straight cables 
are used to connect to hubs.
Turn the printer power ON ( l ), after connecting the cable. If ••
you turn the printer power ON ( l ) before connecting the cable, 
you may not be able to connect to the network.

�If the compatibility of the hub is the reason••

Communication may be unstable due to compatibility of the hub.
Set the printer's [HUB LINK SETTING] to [10BASE - T HALF]. 
Please refer to the below for the method of configuring settings.

�Press the ①①  or the  button several times, and the 

[NETWORK MENU] will be displayed.

 Press the ②②  ENTER button.

 Press the ③③  or the  button, and [HUB LINK SETTING/

AUTO NEGOTIATE] will be displayed.

 Press the ④④  ENTER button.

 �Press the ⑤⑤  or the  button several times, and the 

[10BASE - T HALF] will be displayed.

 ⑥⑥ �Press the  ENTER button, and a [*] will appear on the 

right side of the value.

 Press the ⑦⑦  Online button, and [ONLINE] will be displayed.

Change the hub operating mode (100BASE - TX/10BASE - T, full 
redundancy/half redundancy) to 10BASE - T HALF. (Please refer to 
the hub manual for the method of configuring settings.)

C
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If this has still not solved the problem●●

Confirm that their is a check in [Internal Ethernet] within [Ap-••
ple Menu] - [System Preferences] - [Internet and Networks] - 
[Network] - [Display] - [Network Port Settings].

Dealing with cases with other causes.●●

Printing is slow.
Print processing is car-
ried out on the print 
processing side.

Use a computer with a fast process-
ing speed.

Select [High Resolu-
tion] for [Printer Qual-
ity].

Set the printer driver's [Print Qual-
ity] or [Resolution] to [Normal] or 
[Fast].

The print data is com-
plicated.

Make the print data more simple.

EPS files cannot be printed neatly.
EPS type files are print-
ed with screen resolu-
tion 72dpi, because 
they cannot be recog-
nized by QuickDraw 
(the MacOS drawing 
system).

Change the file to a PICT, TIFF, or 
other graphic format. Use a PS print-
er driver for B840dn.

The network connection cannot be set up.  Cannot Print.
There is a problem with 
the setup or method of 
printing.

Refer to Cannot Print Through the 

Network (P 191).
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Cannot print through the network
●● UNIX

Check that the printer's [IP Address] and [Host Name] is regis-••
tered in "/etc/hosts file".
If using an lp protocol, check that the remote printer's logical ••
printer name (e.g.: rp=lp) is registered in "/etc/printcap file". 
With B840dn, logical printer names are "lp", "sjis", and "euc", 
and "lp" is used for non - convertible output settings, "sjis" 
is used for shift JIS PostScript Japanese character conversion 
output, and "euc" is used for EUC PostScript Japanese charac-
ter conversion output. All others are disabled. With B820n, the 
only enabled logical printer name is "lp".
If using an ftp protocol, check whether an output destination (an ••
internet port logical device name) is set. With B840dn, output 
destinations are "lp", "sjis", and "euc", and "lp" is used for non 
- convertible output settings, "sjis" is used for shift JIS Post-
Script Japanese character conversion output, and "euc" is used 
for EUC PostScript Japanese character conversion output. All 
others are disabled. With B820n, the only enabled output des-
tination is "lp".

Utilities●●

Check that printer detection can be done in Configuration Tool ••
or in Network Card Setup (Windows).
Check that the printer can be detected in Network Card Setup ••
(Macintosh).
Check that you can connect to the printer with the web brows-••
er. (P 121).
Check that you can connect to the printer with telnet.••
Check that you can connect to the printer with a ping. Enter ••
[ping xxx.xxx.xxx.xxx] (xxx.xxx.xxx.xxx is the printer's IP ad-
dress) on the Windows command prompt (MS - DOS prompt) 
and press the Enter key.

C
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Deleting a Printer Driver
If you are using Windows 8/8.1/Windows Server 2012/Server 	��

	 2012 R2/Windows 7/Windows Server 2008 R2

Note! • Computer administrator rights are required.
If Windows is launching,  restart it.••

Select [Start] - [Devices and Printers].①①
Select the printer name you want to delete, right click and se-②②
lect [Delete device].

Select any printer icon from the [Devices and Printers] folder.③③

Click on [Print Server Properties] from the menu.④④

Select the [Drivers] tab in [Print Server Properties].⑤⑤
Click [Change Driver Settings].⑥⑥

Select the printer name you want to delete, and click [Remove].⑦⑦

D
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If Remove Driver And Package is displayed, select [Remove ⑧⑧
driver and driver package] and click [OK].

If [Print Server Properties] appears, click [Yes].⑨⑨
Note! • �If a message appears saying [The specified printer driver 

is currently in use.], restart Windows and carry out dele-
tion of the printer driver again.

If deletion is complete, click [OK].⑩⑩
If you return to [Print Server Properties], click [Close].⑪⑪
Restart Windows.⑫⑫

If you are using Windows Vista/Windows Server 2008��

Note! • Computer administrator rights are required.
If Windows is launching,  please restart it.••

Select [Start] - [Control Panel], and click on [Printers].①①

Right - click on the icon of the printer you want to delete, and ②②
select [Delete].

If a confirmation message is displayed, click [Yes].③③
�Without the printer icon selected, right - click on it, and select ④④
[Run as administrator] - [Server Properties].

If [User Account Control] is displayed, click [Continue].⑤⑤
Select the [Drivers] tab in [Print Server Properties].⑥⑥
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Select the printer name you want to delete, and click [Remove].⑦⑦

Note! • If a message appears saying [The specified printer 
driver is currently in use.], restart Windows and carry 
out deletion of the printer driver again.

�If [Remove Driver And Package] is displayed, click [Remove ⑧⑧
driver and driver package.] and click [OK].

If a confirmation message is displayed, click [Yes].⑨⑨
If [Remove driver and driver package.] is displayed, click on ⑩⑩
[Delete].

If deletion is complete, click [OK].⑪⑪
If you return to [Print Server Properties], click [Close].⑫⑫
Restart Windows.⑬⑬

If you are using Windows XP/Windows Server 2003��

Note! • Computer administrator rights are required.
If Windows is launching,  please restart it.••

For Windows XP, select [Start] - [Control Panel] - [Printers and ①①
Other Hardware] - [Printers and Faxes].

	 In Windows Server 2003, select [Start] - [Printers & Faxes].

Right - click on the icon of the printer you want to delete, and ②②
select [Remove device].

Thereafter, follow the instructions on the screen.③③
Select [File] - [Server Properties] in the [Printers and Faxes] ④④
folder.
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For those using a Mac OS X��

1	 Delete the printer name from a printer list.

Select [Apple Menu] - [System Preferences].①①
Click [Print & Scan].②②
Select the printer name and click [ - ].③③

Click [Delete Printer] on the confirmation screen.④④

2	 Delete with the installer (uninstall).

Set the Software DVD - ROM in the drive.①①
Open the [Driver] folder of the printer driver you want to ②②
delete.

In the [Drivers] tab, select the appropriate model name and ⑤⑤
click on [Remove].

Note! • The Network Extension installed together with the print-
er driver is not deleted even if you delete the driver.

	 • For deleting Network Extension, please refer to Deleting 
Utilities (P 112).
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Double - click the [Uninstaller] tab.③③

Check the model name on the uninstaller confirmation screen, ④④
and click [OK].

Enter the administrator's name and password and click [OK].⑤⑤
If uninstalling is complete, click [OK].⑥⑥D
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Updating a Printer Driver
If you are using Windows 8/8.1/Windows Server 2012/Server 	��

	 2012 R2/Windows 7/Windows Server 2008 R2

Note! • You must have administrator rights.
 If Windows is launching,  please restart it.••

Click [Start] - [Devices and Printers].①①
Right - click the icon of the printer to update, and select [Print-②②
ing Preferences]. Click on [About] in the [Job Options] tab.

 (The Windows PS printer driver screen) 

 �For PCL drivers, right - click the icon of the printer to update, and 
select [Printer Properties]. Click on [About] in the [Device Op-
tions] tab.

 (The Windows PCL printer driver screen) 

If the version information screen is displayed before the ver-③③
sion, click [OK].

Follow "If you are using Windows 7/Windows Server 2008 R2" ④④
(P 192), within "Delete a Printer Driver", to delete a printer 
driver.
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�Set up a new printer driver.⑤⑤
�For the method of setting up, refer to the Users' Manual Setup 
Version.

Note! • You must check that the printer power is ON ( l ).

�Display the version information screen using procedures ⑥⑥  - , 
and check that the printer driver version has been updated.

If you are using Windows Vista/Windows Server 2008��

Note! • Computer administrator rights are required.
 If Windows is launching,  please restart it.••

Select [Start] - [Control Panel], and click on [Printers].①①
For PS drivers, right - click the [Printer to Update] icon, and se-②②
lect [Printing Preferences].

	 Click on [About] in the [Job Options] tab.

 (The Windows PS printer driver screen)

For PCL drivers, right - click the [Printer to Update] icon and select 
[Properties]. Click on [About] in the [Device Options] tab.

 (The Windows PCL printer driver screen) 

If the version information screen is displayed, before the ver-③③
sion click [OK].

�Follow "If you are using Windows Vista/Windows Server 2008" ④④ ①
(P 193), within "Delete a Printer Driver", to delete a printer driver.9
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Set up a new printer driver.⑤⑤
	 For the method of setting up, refer to the Users' Manual Setup 

Version.

Note! • You must check that the power is ON ( l ).

Display the version information screen using procedures ⑥⑥  - , 
and check that the printer driver version has been updated.

If you are using Windows XP/Windows Server 2003��

Note! • Computer administrator rights are required.
• If Windows is launching, please restart it.

�For Windows XP, select [Start] - [Control Panel] - [Printers and ①①
Other Hardware] - [Printers and Faxes].

	 In Windows Server 2003, select [Start] - [Printers & Faxes].

For PS drivers, right - click the [Printer to Update] icon, and se-②②
lect [Printing Preferences].

	 Click on [About] in the [Job Options] tab.

 (The Windows PS printer driver screen) 

For PCL drivers, right - click the [OKI B840 (PCL)] icon and se-
lect [Properties]. Click on [About] in the [Device Options] tab.

 (The Windows PCL printer driver screen) 

If the version information screen is displayed, click [OK] before ③③
the version.
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For those using a Mac OS X��

Delete the printer driver.①①
	 For details, please refer to Delete a Printer Driver (P 195).

 �Reinstall the printer software. For details, refer to the Users' ②②
Manual Setup Version.

�Right - click on the icon of the printer you want to update, and ④④
select [Remove device].

	� In order to correctly update the printer driver, delete all printer 
drivers of the same type as the one you are updating.

Thereafter, follow the instructions on the screen.⑤⑤
Select [File] - [Server Properties] in the [Printers and Faxes] ⑥⑥
folder.

In the [Drivers] tab, select the appropriate model name and ⑦⑦
click on [Remove].

Restart Windows.⑧⑧
Set up a new printer driver.⑨⑨

	 For the method of setting up, refer to the Users' Manual Setup 
Version.

Note! •	You must check that the printer power is ON ( l ).
For Windows XP/Windows Server 2003, set up when in-••
stalling the printer.

Display the version information using procedures ⑩⑩  - , and 
check that the new printer driver version has been updated.

9

U
pdating a Printer D

river



201

If you cannot setup with a USB connection (Windows)��

If a printer icon is not created in the [Printers] folder●●

The printer driver cannot be correctly set up. Carry out the printer 
setup again.
For details, refer to the Users' Manual Setup Version.

If a printer icon is created in the [Printers] folder, but you cannot print●●

The printer driver print destination port is not correctly set up. 
Check the settings using the following procedure.

For Windows 8.1/Windows Server 2012 R2, select [Control ①①
Panel] - [Hardware and Sound] - [Devices and Printers].

	 For Windows 8/Windows Server 2012, select [Control Panel] - 
[Hardware and Sound] - [Devices and Printers].

	 For Windows 7/Windows Server 2008 R2, select [Start] - [De-
vices and Printers].

	 �For Windows Vista/Windows Server 2008, select [Start] - 
[Control Panel], and then click on [Printers].

	� For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers and Faxes].

	 For Windows Server 2003, select [Start] - [Printers & Faxes].

In Windows 7, select [Printer Properties].②②
	 �If not using Windows 7, right - click on the printer icon and 

select [Properties].

Set [Printer Port] in the [Ports] tab to [③③  [USBxxx].

Note! • If [USBxxx] is not displayed in [Printer Port], check that 
the printer power is ON ( l ), fix the USB cable connec-
tion, and carry out steps  -  again.

If you cannot set up the printer driver
�●● If [An error occurred with installing the printer driver] in the setup program

you need to set up with plug and play. Check whether setup was 
carried out using the following procedure.

Check that the printer and computer power is turned OFF ( O ).①①
Connect the USB cable.②②
Turn the printer power ON ( ③③ l ).

Launch Windows.④④
If the [Add New Hardware Window] is displayed, after this fol-⑤⑤
low the instructions on the screen to set up.

For details, please refer to README.TXT on the Software DVD - 
ROM.

9
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If you cannot setup with a USB connection (Macintosh)��

Occurrence Method of dealing with it

The interface is disabled. Set [USB] in the printer user menu to  

[ENABLE]. For the detailed procedure, 

refer to "User Menu" in "Chapter 2 - 

Basic Operation" in the Setup Instruc-

tions.

The USB cable may not 
meet the standards.

Please use a USB2.0 specification USB 
cable.

The set up procedure was 
incorrect.

Set up again from the beginning.

The USB cable is pulled 
out after a short time.

Increase the interval between pulling 
out the USB cable to over 5 minutes.

The USB cable has come 
out.

Plug the USB cable in.

There is a problem with 
the USB cable.

If you have a spare USB cable, replace 
the other one with it.

Using a USB hub. Connect the printer directly to the 
computer.

Setup was aborted. Set up again from the beginning.

The printer power switch 
is OFF ( O ).

Turn the printer power ON ( l ). 

The printer driver cannot 
be correctly installed.

Install the printer driver again.

It goes [OFFLINE]. Press the Online button to make it go 
[ONLINE].

For other cases●●

Occurrence Method of dealing with it

The computer does not 
respond to the USB in-
terface.

Check that the USB controller is dis-
played using the device manager.

The USB cable may not 
meet the standards.

Please use a USB2.0 specification USB 
cable.

The interface is disabled. Set [USB] in the printer user menu to  

[Enable]. For the detailed procedure, re-

fer to "User Menu" in "Chapter 2 - Basic 

Operation" in the Setup Instructions.

The set up procedure 
was incorrect.

Follow the procedure in the Setup In-
structions and set up again from the 
beginning.

The USB cable has come 
out.

Plug the USB cable in.

There is a problem with 
the USB cable.

If you have a spare USB cable, replace 
the other one with it.

Using a USB hub. Connect the printer directly to the 
computer.

 [Set Location to Search] 
or [Set Location] is dis-
played during setup.

Set it to the printer driver folder in the 

Software DVD - ROM.

E.g.: "E:\Drivers\ENU\PCL"

(In this example the DVD - ROM 

drive is E:, and the printer driver 

is PCL.)

Setup was aborted. Follow the procedure in the Setup In-
structions and set up again from the 
beginning.

9
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Appendix
S
pecifications

Specifications
 �� Network interface specifications

Basic specifications

   Network protocol
   TCP/IP - related
   NetWare - related
   EtherTalk - related
   NetBEUI - related
Connectors
   �100 BASE - TX / 10 BASE - T (Automatic toggle, cannot be used 

simultaneously)
Cable
   �Non - shield twisted pair cable with RJ - 45 connector (Category 5 recommend-

ed)
Connector pin arrangement

	 		

1 8

Interface signal

Pin 
No.

Signal 
name

Direction Function

1 TXD+ FROM PRINTER Data being sent+
2 TXD - FROM PRINTER Data being sent -
3 RXD+ TO PRINTER Data being received+
4 − − Not being used.
5 − − Not being used.
6 RXD - TO PRINTER Data being received -
7 − − Not being used.
8 − − Not being used.

USB interface specifications ��

Basic specifications

   USB (Supports Hi - Speed USB) 
Connectors
   Printer side	 B receptacle (female) upstream port
   Cable side		  B plug (Male) 
Cable
   �A 5m or lower USB2.0 specification cable (2m or lower is recom-

mended) 
   (Please use a shielded cable.) 
Transmission mode
   Full speed (Maximum 12 Mbps ±0.25%) 
   High speed (Maximum 480Mbps ±0.05%) 
Power control
   Self - powered device
Connector pin arrangement

				  
2 1

3 4

Interface signal

Signal 
name

Function

1 Vbus Power (+5V) 

2 D - For data transfer 

3 D+ For data transfer 

4 GND Signal grand

Shell Shield
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�� ACC interface specifications

Basic specifications

   USB (only Oki Data checked card reader/writers)
Connectors
   A receptacle (female) downstream port
Cable
   Use the cable that belongs to the card reader.
   (You cannot use the hub.) 
Transmission mode
   Low speed (Maximum 1.5 Mbps ±1.5%) 
Supplied current
   Maximum 500mA
Connector pin arrangement

				  

Interface signal

Signal 

name

Function

1 Vbus Power (+5V) 

2 D - For data transfer 

3 D+ For data transfer 

4 GND Signal grand

Shell Shield

�� Parallel interface specifications

Note! • The parallel interface is disabled by default. If using the printer 
interface, Set [Centro] on the printer control panel to [Enabled].

Enabling a Parallel Interface (�� P 92)

Basic specifications
IEEEstd1284 - 1994 standard parallel interface
Connectors
   Printer side	 36 - pole receptacle (female) 
   Cable side		  36 - pole plug (male) 
Cable
A 1.8m or lower cable compliant with IEEEstd 1284 - 1994 or an 
equivalent product
 (use a shielded cable.) 
Transmission mode
   Compatible
   Nibble
   ECP
Interface level
   Low level	 +0.0 to+0.4V
   High level 	+2.4 to +5.0V
Connector pin arrangement

	

S
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Interface signal

Pin No. Signal name Direction Function

1 nStrobe (HostClk) TO  PRINTER This is parsing for reading data.
The data is read at the final edge.

2
3
4
5
6
7
8
9

DATA  1
DATA  2
DATA  3
DATA  4
DATA  5
DATA  6
DATA  7
DATA  8

Bi - direction This is 8 - bit parallel data. High - 
level is "1", while low - level is "0".

10 nAck (PtrClk) FROM  
PRINTER

This is a signal to display that data 
receipt is finished.

11 Busy (PtrBusy) FROM  
PRINTER

This is a signal to display whether the 
printer is in a state of receiving data. 
Data cannot be received while in high 
- level.

12 PError (AckDataReq) FROM  
PRINTER

A paper error is displayed in high - 
level.

13 Select (Xflag) FROM  
PRINTER

If parallel interface is enabled, it will 
always be high - level.

14 nAutoFd (HostBusy) TO  PRINTER Bidirectional communication is used.

15 − − Not used.

16 GND − Signal grand

17 FG − Chassis ground

18 HILEVEL FROM  
PRINTER

Within the printer it is pulled up by 
+5V at 3.3KΩ.

19-30 GND − Signal grand

31 nInit (nInit) TO  PRINTER At low - level, the printer will be 
initialized.

32 nFault (nDataAvail) FROM  
PRINTER

The printer will go into low - level if 
in an alarm state.

33 GND − Signal grand

34 − − Not used.

35 HILEVEL FROM  
PRINTER

Within the printer it is pulled up by 
+5V at 3.3KΩ.

Pin No. Signal name Direction Function

36 nSelectIn
 (IEEE1284 active) 

TO  PRINTER Used in bidirectional communication. 
It has to be in low - level when in 
compatible mode.

Note! • Inside the brackets is the nibble mode signal name.
• This only explains the compatible mode function.
• The IEEEstd1284 - 1994 nibble mode, stipulated by the US 

Institute of Electrical and Electronics Engineers, is sup-
ported. If you use a computer or cable that does not meet 
these regulations, unexpected operations may occur.

S
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Font sample (�� PostScript3 emulation) (B840dn only) 

European font 136

S
pecifications
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European font 91

Note! •The fonts that you can use may be limited depending on the OS.
	OCR - A, OCR - B, and USPS POSTNET Bar Codes cannot be ••
used in a Windows environment. 

	Bitmap fonts have a fixed size.••

	Koufi, Naskh, and Ryadh printed out with PCL Font List cannot ••
be used. 

Scalable fonts (87 font) 	
	Font No.	   Font No.

Font sample (�� PCL emulation mode) 

Note! • Cannot be used in a Macintosh environment.

	Font No.	    Font No.

Bitmap font (3 fonts) 
	Font No.

USPS POSTNET Bar Codes
	Font No.

S
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�� Print range and printing precision 

The print range of the printer driver is as follows.
The actual print range may vary depending on the application.

Note! • The printer precision is as follows: print positioning:±2mm; paper 
skew: ±1mm/100mm; image stretch: ±1mm/100mm (for basis 
weight 80g/m2 (ream weight of 70kg) ) .

• For double - sided printing the front - pack positioning precision is ±2.5mm.

A

B 6.
35

m
m

6.
35

m
m

D
C

6.35mm 6.35mm
E F

Print Coverage

Printable area

The range of print quality is 
guaranteed. We recommend 
that you print within this area 
as possible.

Printable range. Print quality 
may be reduced.

S
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Units: mm 
PostScript3 emulation mode

PCL emulation mode

Paper size Width Length Top margin Bottom margin Left margin Right margin
A B C D E F

A3 297 420 4.23 4.23 4.23 4.23
A4 210 297 4.23 4.23 4.23 4.23
A5 148 210 4.23 4.23 4.23 4.23
A6 105 148 4.23 4.23 4.23 4.23
B4 257 364 4.23 4.23 4.23 4.23
B5 182 257 4.23 4.23 4.23 4.23
B6 128 182 4.23 4.23 4.23 4.23
Tabloid 279.4 431.8 4.23 4.23 4.23 4.23
Letter 215.9 279.4 4.23 4.23 4.23 4.23
Legal (13 inch) 215.9 330.2 4.23 4.23 4.23 4.23
Legal (13.5 inch) 215.9 342.9 4.23 4.23 4.23 4.23
Legal (14 inch) 215.9 355.6 4.23 4.23 4.23 4.23
Executive 184.15  266.7 4.23 4.23 4.23 4.23
Statement 139.7 215.9 4.23 4.23 4.23 4.23
8K (260 x 368mm) 260 368 4.23 4.23 4.23 4.23
8K (270 x 390mm) 270 390 4.23 4.23 4.23 4.23
8K (273 x 394mm) 273 394 4.23 4.23 4.23 4.23
16K (184 x 260mm) 184 260 4.23 4.23 4.23 4.23
16K (195 x 270mm) 195 270 4.23 4.23 4.23 4.23
16K (197 x 273mm) 197 273 4.23 4.23 4.23 4.23
Custom *1*2 76~297 148~432 4.23 4.23 4.23 4.23
Com - 9 98.4 225.4 4.23 4.23 4.23 4.23
Com - 10 104.75 241.3 4.23 4.23 4.23 4.23
DL 110 220 4.23 4.23 4.23 4.23
C4 229 324 4.23 4.23 4.23 4.23
C5 162 229 4.23 4.23 4.23 4.23
C6 114 162 4.23 4.23 4.23 4.23
Monarch 98.4 190.5 4.23 4.23 4.23 4.23

*1: Letters 1 - 3 have width of 148 
- 297mm, and length of 182 - 
432mm.

*2: Multipurpose tray has width of 
76 - 297mm, and length of 148 
- 432mm.

*3: In PostScript3 emulation mode, 
Letter (Free) is a fixed size (width 
215.9mm and length 297mm).
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�� Character code table (PostScript3 Emulation Mode) (B840dn only) 

Note! �• �*** - 83pv - RKSJ - H is mainly used for Macintosh. ("***" is the 
font name) 

• �*** - 90ms - RKSJ - H, *** - RKSJ - H, and *** - Ext - RKSJ - H 
are mainly used for Windows. ("***" is the font name) 

• �Characters not in the printer character code table may not pro-
duce the expected results, such as not being output or becoming 
garbled.

• �If printing using application software, the application software 
may use it's own character code table.

• �The Japanese character code table is in a PDF file in a folder be-
low "Software DVD - ROM".

Windows: 	[Misc] - [KanjiCode] folder.
Macintosh: [Kanji Code Table] folder.

• The printer font shown in each PDF file is as shown below.

File name

 (Windows) 
File name (Macintosh) Printer font name

HG - 83pv.pdf HeiseiKakuGo - W5 - 83pv - 

RKSJ.pdf

HeiseiKakuGo - W5 - 83pv - 

RKSJ - H

HG - 90ms.pdf HeiseiKakuGo - W5 - 90ms - 

RKSJ.pdf

HeiseiKakuGo - W5 - 90ms - 

RKSJ - H

HGExRKSJ.pdf HeiseiKakuGo - W5 - Ext - 

RKSJ.pdf

HeiseiKakuGo - W5 - Ext - 

RKSJ - H

HG - RKSJ.pdf HeiseiKakuGo - W5 - RKSJ.pdf HeiseiKakuGo - W5 - RKSJ - H

HM - 83pv.pdf HeiseiMin - W3 - 83pv - RKSJ.

pdf

HeiseiMin - W3 - 83pv - RKSJ 

- H

HM - 90ms.pdf HeiseiMin - W3 - 90ms - RKSJ.

pdf

HeiseiMin - W3 - 90ms - RKSJ 

- H

HMExRKSJ.pdf HeiseiMin - W3 - Ext - RKSJ.

pdf

HeiseiMin - W3 - Ext - RKSJ - 

H

HM - RKSJ.pdf HeiseiMin - W3 - RKSJ.pdf HeiseiMin - W3 - RKSJ - H

European character standard
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Character code table (�� PCL emulation mode) 

Note! •	 If printing using application software, the application may use it's 
own character code table.

• �The Japanese character code table is in a PDF file in a folder below 
"Software DVD - ROM".

• Windows: [Misc] - [KanjiCode] folder

• The printer font shown in each PDF file is as shown below.

File name (Windows) Printer font name

Heisei Kaku Go.pdf Heisei Kaku Gothic 
Heisei Mincho.pdf Heisei Mincho 

Simple set

Standard European characters (PC - 8) 

PC - 8
PC - 8 Dan/Nor
PC - 8 Grk
PC - 8 TK
PC - 775
PC - 850
PC - 851 Grk
PC - 852
PC - 855
PC - 857 TK
PC - 858
PC - 862 Heb
PC - 864 L/A
PC - 866
PC - 866 Ukr
PC - 869
PC - 1004
Pi Font
Plska Mazvia
PS Math
PS Text
Roman - 8
Roman - 9
Roman Ext
Serbo Croat1

Serbo Croat2
Spanish
Ukrainian
VN Int'l
VN Math
VN US
Win 3.0
Win 3.1 Arb
Win 3.1 L/G
Win 3.1 Blt
Win 3.1 Cyr
Win 3.1 Grk
Win 3.1 Heb
Win 3.1 L1
Win 3.1 L2
Win 3.1 L5
Wingdings
Dingbats MS
Symbol
OCR - A
OCR - B
OKI - OCRB
HP ZIP
USPSFIM
USPSSTP

USPSZIP
Arabic - 8
Bulgarian
CWI Hung
DeskTop
German
Greek - 437
Greek - 437 Cy
Greek - 737
Greek - 8
Greek - 928
Hebrew NC
Hebrew OC
Hebrew - 7
Hebrew - 8
IBM - 437
IBM - 850
IBM - 860
IBM - 863
IBM - 865
ISO Dutch
ISO L1
ISO L2
ISO L4
ISO L5

ISO L6
ISO L9
ISO Swedish1
ISO Swedish2
ISO Swedish3
ISO - 2 IRV
ISO - 4 UK
ISO - 6 ASC
ISO - 10 S/F
ISO - 11 Swe
ISO - 14 JASC
ISO - 15 Ita
ISO - 16 Por
ISO - 17 Spa
ISO - 21 Ger
ISO - 25 Fre
ISO - 57 Chi
ISO - 60 Nor
ISO - 61 Nor
ISO - 69 Fre
ISO - 84 Por
ISO - 85 Spa
ISO - Cyr
ISO - Grk
ISO - Hebrew

Kamenicky
Legal
Math - 8
MC Text
MS Publish
PC Ext D/N
PC Ext US
PC Set1
PC Set2 D/N
PC Set2 US 
WIN3.1J
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Symbol Wingdings
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List of Consumables and Options
Purchase the following consumables and options from the nearest 
distributors.

Product Name Life Expectancy Order No.

Toner cartridge 6,000 sheets 44707701

Toner cartridge 
(Large)

15,000 sheets
44708001

Image drum 30,000 sheets 44707401

Tray2 *1 44676104

Duplex Unit *2 44676204

SD card (16GB) 44301003

Additional memory 
(256MB) 44302203

Additional memory 
(512MB) 44302207

*1 �B840dn can be installed with two additional tray units, using 
them as the its second/third trays.

*2 B840dn has a duplex unit installed as standard.

Note! • For the storage method of paper, see "How to Keep Paper" (Setup 
Instructions).

• �Note the following concerning the toner cartridge.

 - �Use genuine Oki Data original consumables to ensure opti-
mum performance of the product.

	 When using a non genuine Oki Data original consumable, the 
product may not deliver its optimum performance, and print 
quality may decline.

	 Warranty doesn’t apply if the troubles arise with use of a non 
genuine Oki Data original consumable. You need to pay for 
repairs even during the warranty period. (Although not all non 
genuine Oki Data original consumables cause a trouble when 
used for the product.)

 - The toner cartridge lowers its print quality 1 year or more 
after they are unpacked.

 - Do not unpack consumables (toner cartridge, image drum) 
before using them.

 - �Keep consumables under an environment with temperature 
0 to 35C and humidity 20 to 85%RH, and avoid direct sun-
light.

 - �Do not keep consumables under an environment with high 
or sharply changed temperature or humidity.

 - Keep consumables away from babies and children.

• �Consumables (image drum, toner cartridge) are not guaranteed.
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About Using Print Control Server
Note! • The details in this item may vary if you upgrade your Print Control 

Server software. 

Memo • If the printer has been added to Print Control Server, 
"JobAccounting:ON" will be printed on the printed menu map.

• �The number of user IDs that can be registered and logs that canbe 
saved with default settings
�The number of user IDs that can be registered and logs that can 
be saved with default settings are as follows. The number may 
decrease depending on the contents of logs.

SD memory cards Number of user IDs that 

can be registered

Number of logs that can 

be saved

None 5000 ID About 200 logs
Available 5000 ID About 5000 logs

A
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Setting up in Windows with a parallel connection
Note! • A printer cable is not included. A bidirectional parallel cable com-

pliant with IEEEstd1284 - 1994 is provided separately.

Operating environment��

Note! • The details may differ from those given in this manual if you up-
grade the version of printer driver you are using.

	 Windows 7/Windows 7 (64bit Version) 

	 Windows Vista/Windows Vista (64bit Version) 

	 Windows Server 2008/Windows Server 2008 (64bit Version) 

	 Windows XP/Windows XP (64bit Version) 

	 Windows Server 2003/Windows Server 2003 (x64 Version) 

Note! • �Operation cannot be done from MS - DOS and the Windows 
command prompt/DOS prompt.

Memo • �If you put the computer's BIOS setting to [ECP] mode, the data 
transfer speed may increase. For the method of installation, 
please inquire with the computer manufacturer.

• Please use a shielded parallel cable. (Maximum length 1.8m) 

Here Windows 7 will be used as an example. The screen or operating proce-
dure may differ depending on the OS you are using.

Installing a Printer Driver��

Set [parallel] on the printer control panel to [Enable].①①
Enabling �� Parallel Interface (P 92) 

Turn the printer power OFF.②②

Check that the parallel cable is removed from the computer.③③

Turn the computer power on.④④

Insert the Software DVD - ROM into the computer.⑤⑤

If [Run Automatically] is displayed, click [Run setup.exe].⑥⑥

	 If the [User Account Control] dialog box appears, click [Yes].  
(For Windows Vista, click [Continue].) 

Select the printer you are using, and click on [Next].⑦⑦

Read the [Software License Agreement] and click [I Agree].⑧⑧

S
etting up in W
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Select [Easy Installation (Local)] below [Driver Installation].⑨⑨

Memo • �With [Easy Installation (Local)], all drivers supported by the 
OS you are using are installed. If you want to manually select 
the driver to install, select [Custom Installation (Printer)], and 
follow the instructions on the screen. 

[Next] Installation will start.⑩⑩

If the [Windows Security] dialog appears, click on [Install This ⑪⑪
Driver Software].

	 For Windows XP/Windows Server 2003, if the [Install Hard-
ware] dialog is displayed, click [Continue].

Connect the machine to the computer, and if a prompt is dis-⑫⑫
played instructing you to turn the machine's power on, con-
nect the machine to the computer with a cable and turn the 
power on for the machine.

	 Follow the instructions displayed on the screen to complete 
the installation.

�If the [Installation Complete] screen is displayed, click [Close].⑬⑬

���For Windows 8.1/Windows Server 2012 R2, select [Control ⑭⑭
Panel] - [Hardware and Sound] - [Devices and Printers].

	 For Windows 8/Windows Server 2012, select [Control Panel] - 	
[Hardware and Sound] - [Devices and Printers].

	 For Windows 7/Windows Server 2008 R2, select [Start] - [De-
vices and Printers].

	 For Windows Vista/Windows Server 2008, select [Start] - [Con-
trol Panel], and then click on [Printers].

	 For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers & Faxes].

	 For Windows Server 2003, select [Start] - [Printers & Faxes].

Right - click on the OKI B840 icon, select one menu item, and ⑮⑮
check that all drivers installed are displayed in the sub - menu.

	 In Windows Vista/Windows Server 2008/Windows XP/Windows 
Server 2003, check that the icon for each driver is displayed.

Remove the software DVD - ROM from the computer.⑯⑯

		 With this, setup is complete.
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If setup is not going well��

• If the printer icon has been created but you cannot print

�The printer driver print destination port is not correctly set up. 
Check the settings using the following procedure.

For Windows 8.1/Windows Server 2012 R2, select [Control ①①
Panel] - [Hardware and Sound] - [Devices and Printers].

	 For Windows 8/Windows Server 2012, select [Control Panel] - 
[Hardware and Sound] - [Devices and Printers].

	 For Windows 7/Windows Server 2008 R2, select [Start] - [De-
vices and Printers].

	 For Windows Vista/Windows Server 2008, select [Start] - [Con-
trol Panel], and then click on [Printers].

	 For Windows XP, select [Start] - [Control Panel] - [Printers and 
Other Hardware] - [Printers & Faxes].

	 For Windows Server 2003, select [Start] - [Printers & Faxes].

Right - click the printer icon and select [Properties] (in Win-②②
dows 7 and later this is [Printer Properties]).

On the [Print Port] in the [Ports] tab, set the port to connect to ③③
as shown below.

	 If connecting with a parallel cable [LPT1]

• If you cannot setup with a parallel connection

Occurrence Method of dealing with it

The computer does not 
support bidirectional 
parallel interfaces.

Use a computer that supports 
bidirectional parallel interfaces.

The parallel cable may 
not meet the standards.

Use a bidirectional parallel cable 
compliant with IEEEstd1284 - 1994.

Occurrence Method of dealing with it

The interface is disabled.  [Centro] is disabled in the detailed 
settings. Set [Centro] in the printer 
user menu to [Enabled].
For the detailed procedure, refer to 
Enabling a Parallel Interface (P 92).

The set up procedure was 
incorrect.

Follow the procedure in this chapter 
and set up again from the beginning. 

The parallel cable has 
come out.

Plug the parallel cable in.

There is a problem with 
the parallel cable.

If you have a spare parallel cable, 
replace the other one with it.

Using a switch, buffer, 
extension cable, etc.

Connect the printer directly to the 
computer.

[Set Location to Search] 
or [Set Location] is 
displayed during setup.

Set it to the printer driver folder in 
the Software DVD - ROM.
E.g.: "E:\Drivers\ENU\PCL"
 (In this example the DVD - ROM 
drive is E:, and the printer driver is 
PCL.) 

Setup was aborted. Follow the procedure and set up 
again from the beginning.
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If you are using UNIX or Linux (B840dn) 

�� Use an LPD protocol 

This explains how to print using a TCP/IP LPD protocol (lpr or lp 
command). For details of the lpr and lp command, please refer to 
the UNIX manual.

• About LPD

LPD (Line Printer Daemon) is a protocol to print with a printer on 
the network.

• About logical printers

This printer has three logical printers.

Logical printers Function

lp If printing a PostScript or PCL format file
sjis If printing a shift JIS Japanese character code text file 
euc If printing a euc Japanese character code text file 

Note! • sjis and euc are PostScript printer functions only. 

The following explanation uses the environment shown below as an example.
Printer		  : B840dn

IP Address	 : 192.168.0.2

MAC address	 : 00:80:87:84:9C:9B

• Configure UNIX settings and print

 For Sun Solaris2.6 and 8

Note! • You must have super - user rights.
The remote printer registration method using Admintool on ••
OpenWindows cannot be used on this printer, as the output 
destination and queue name would be the same. Remote print-
ers can be registered with the following method.
If Solaris 2.x's connection with the remote printer is stuck for ••
a long time, based on its system specifications it will consider 
this to be an error, and will force disconnect. Therefore, if there 
is a waiting time due to running out of paper while printing or 
an online error, the printer will cut the connection.

Log in as the UNIX administrator (root).①①

Register the printer's IP address and host name in the /etc/②②
hosts file.

			  192.168.0.2 ML

Check the connection using a ping command.③③
			  # ping ML

Register the print server.④④
	 		� # lpadmin -p ML_lp -m netstandard -o protocol=bsd -o 

dest=ML:lp -v /dev/null

Note! • The "lp" following ":" is a logical printer.
You may need to set the printer type or file content type de-••
pending on the file format you are printing. For details, please 
refer to the manual that came with your OS.

Enable the print queue.⑤⑤

			  #/usr/sbin/accept ML_lp
			  #/usr/bin/enable ML_lp

If you are using U
N

IX
 or Linux (B
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⑥⑥Print. 
	 		 # lp -d ML_lp<File Name>

Note! • Use the following page if you do not need a banner page.

			   # lp -d ML_lp -o nobanner

Delete a print request.⑦⑦
			  # cancel ML_lp-<Job Number>

Check the print status.⑧⑧
	 # lpstat -p ML_lp

Note! • This may not be correctly displayed depending on the UNIX 
specifications.

For HP - UX9.X and 10.X 

Note! • You must have super - user rights.
HP - UX9.03 is used as an example. ••

Log in as the UNIX administrator (root) .①①
Register the printer's IP address and host name in the /etc/②②
hosts file.

			  192.168.0.2 ML

③③Check the connection using a ping command.
			  # ping ML

C④④ onfigure the following settings if the remote spooller is not set 
on the HP - UX machine you are using.

	  (1) Stop the printer spooler.
		  #/usr/lib/lpshut
	
	  (2) �Add the the following line to the /etc/inetd.conf file,  

in order to register the remote spooler.
		  printer stream tcp nowait root  
		  /usr/lib/rlpdaemon rlpdaemon -i

	  (3) Restart inetd.
		  #/etc/inetd -c

Configure the print queue settings.⑤⑤
			�  # /usr/lib/lpadmin -pML_lp -mrmodel -ormML -orplp 

-ocmrcmodel -osmrsmodel -ob3 -v/dev/null

Note! • 	Following "-p", "ML_lp" is the printer queue name; following 
"-orm", "ML" is the host name; and following "-orp", "lp" is the 
logical printer name. 

Enable the print queue.⑥⑥
			  #/usr/lib/accept ML_lp
			  #/usr/bin/enable ML_lp

If you are using U
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Launch the printer spooler.⑦⑦
			  #/usr/lib/lpsched

Start a print job.⑧⑧
			  # lp -d ML_lp<File Name>

Delete a print request.⑨⑨

	 		 # cancel ML_lp-<Job Number>

Check the print status.⑩⑩

			  # lpstat -p ML_lp

Note! • This may not be correctly displayed depending on the UNIX 
specifications.

Use an FTP protocol ��

This explains how to print using a TCP/IP FTP protocol (ftp com-
mand).
For details on the ftp command, please refer to the UNIX manual. 

About FTP ••

FTP (File Transfer Protocol) is a protocol for transferring files to the 
host on a network.

About logical directories••

This printer has three logical directories.

Logical printers Function

/lp If printing a PostScript or PCL format file
/sjis If printing a shift JIS Japanese character code text file 
/euc If printing a euc Japanese character code text file 

Note! • sjis and euc are PostScript printer functions only. 

The following explanation uses the environment shown below as an example.
	 Printer	 : B840dn

	 IP Address	 : 192.168.0.2

	 MAC address	 : 00:80:87:84:9C:9B

If you are using U
N
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• Start a print job.

Log into the printer.①①
Note! • It is possible to print with any value put into Name and Pass-

word. However, if User is "root", then the Password is required. 
The default value is the last 6 alphanumerical digits of the MAC address.

#ftp 192.168.0.2

Connected to 192.168.0.2
220 EthernetBoard OkiLAN 9300e Ver 00.06 FTP Server.
User (192.168.0.2:none) :root
331 Password required.
Password
230 user Logged in.
Remote system type is FTP.
ftp>

Move to transfer destination directory.②②

Note! • Files cannot be transfered the root directory.

ftp>cd /lp

250 Command OK.
ftp>pwd

257”/lp” is current directory.
ftp>

Set the transfer mode.③③

Note! • There are two types of transfer mode, "BINARY Mode", which 
outputs file details as they are, and "ASCII Mode", which 
changes LF codes into CR+LF codes. If transferring files cre-
ated with the printer driver, use "BINARY Mode"

ftp> type binary

200 Type set to I.
ftp> type

Using binary mode to transfer files.
ftp>

Start a print job.④④

	 E.g. 1) If transferring "test.prn" print data
			  ftp> put test.prn

	 E.g. 2) If setting the print data with the absolute path "/users/
test/test.prn", and then transferring.

			  ftp> put /users/test/test.prn

Log out.⑤⑤

			  ftp> quit

Memo • You can use the quote command's "stat" to check three states 
- the client IP address, the login user name and the transfer 
mode. Also, you can check the status of the printer by setting 
a logical directory (lp, sjis, euc) after stat.

			   ftp> quote stat

			   211 - FTP server status:
			   Connected to: 192,168,0,3,5,112

			   User logged in: root

			   Transfer type: BINARY
			   Data connection: Closed.

			   211 End of status.
			   ftp>

			   ftp> quote stat /lp
			   211 - FTP directory status:

			   Ready

			   211 End of status.

			   ftp>

If you are using U
N

IX
 or Linux (B

840dn) 
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